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‭Basic Software Operating Skills‬

‭Unit 1: Computer Fundamentals‬

‭INTRODUCTION‬

‭The‬ ‭word‬ ‭“computer”‬ ‭comes‬ ‭from‬ ‭the‬‭word‬‭“TO‬‭COMPUTE”‬‭which‬‭means‬
‭to‬ ‭calculate.‬ ‭A‬ ‭computer‬‭is‬‭normally‬‭considered‬‭to‬‭be‬‭a‬‭calculation‬‭device‬
‭which can perform the arithmetic operations very speedily.‬
‭A‬ ‭computer‬ ‭may‬ ‭be‬ ‭defined‬ ‭as‬ ‭a‬ ‭device‬ ‭which‬ ‭operates‬ ‭upon‬ ‭the‬ ‭data.‬
‭Data‬‭can‬‭be‬‭in‬‭the‬‭form‬‭of‬‭numbers,‬‭letters,‬‭symbols,‬‭size‬‭etc.‬‭And‬‭it‬‭comes‬
‭in‬ ‭various‬ ‭shapes‬ ‭&‬ ‭sizes‬ ‭depending‬ ‭upon‬ ‭the‬ ‭type‬ ‭of‬ ‭computer‬
‭application.‬
‭Charles‬ ‭Babbage‬ ‭is‬ ‭the‬ ‭"Father‬ ‭of‬ ‭the‬ ‭Computer".‬ ‭He‬ ‭was‬ ‭an‬ ‭English‬
‭mathematician,‬ ‭philosopher,‬ ‭and‬ ‭inventor‬ ‭who‬ ‭designed‬ ‭the‬ ‭first‬
‭mechanical computer called the Analytical Engine in the 1830s.‬

‭What is Computer:‬
‭A‬ ‭computer‬ ‭is‬ ‭an‬ ‭electronic‬ ‭device‬ ‭which‬ ‭takes‬ ‭input‬ ‭from‬ ‭the‬ ‭user,‬
‭processes it and gives the output as per user’s requirement.‬

‭●‬ ‭A‬ ‭computer‬ ‭first‬ ‭gets‬ ‭the‬ ‭Input,‬ ‭does‬ ‭Process‬ ‭on‬ ‭it‬ ‭and‬ ‭then‬
‭produces Output.‬
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‭Generation of Computer:‬
‭The‬ ‭history‬ ‭of‬ ‭computers‬ ‭is‬ ‭divided‬ ‭into‬ ‭five‬ ‭generations‬ ‭based‬ ‭on‬ ‭the‬
‭technology‬ ‭used.‬ ‭Each‬ ‭generation‬ ‭brought‬ ‭new‬ ‭improvements‬ ‭in‬ ‭size,‬
‭speed, cost, and functionality.‬

‭1. First Generation (1940–1956) – Vacuum Tubes:‬
‭●‬ ‭These computers used vacuum tubes for processing.‬
‭●‬ ‭They were very large and consumed a lot of electricity.‬
‭●‬ ‭They were slow and produced a lot of heat.‬
‭●‬ ‭Example: ENIAC, UNIVAC‬

‭2. Second Generation (1956–1963) – Transistors:‬
‭●‬ ‭These computers used transistors instead of vacuum tubes.‬
‭●‬ ‭They‬ ‭were‬ ‭smaller,‬ ‭faster,‬ ‭and‬ ‭more‬ ‭reliable‬ ‭than‬ ‭first-generation‬

‭computers.‬
‭●‬ ‭They produced less heat and used less power‬
‭●‬ ‭Example: IBM 1401, CDC 1604‬

‭3. Third Generation (1964–1971) – Integrated Circuits (ICs):‬
‭●‬ ‭Used small chips called Integrated Circuits‬‭.‬
‭●‬ ‭Much‬ ‭smaller,‬ ‭cheaper,‬ ‭and‬ ‭faster‬ ‭than‬ ‭second-generation‬

‭computers.‬
‭●‬ ‭Supported multiple applications at the same time.‬
‭●‬ ‭Example: IBM 360, PDP-8‬
‭4. Fourth Generation (1971–Present) – Microprocessors:‬
‭●‬ ‭Used microprocessors – a single chip that does all computing work.‬
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‭●‬ ‭These are modern computers like laptops and desktops.‬
‭●‬ ‭They are fast, small, and affordable for everyone.‬
‭●‬ ‭Example: Intel 4004, Core i7‬

‭5.Fifth‬ ‭Generation‬ ‭(Present‬ ‭&‬ ‭Future)‬ ‭–‬ ‭Artificial‬ ‭Intelligence‬
‭(AI):‬

‭●‬ ‭These computers use Artificial Intelligence and machine learning.‬
‭●‬ ‭They can understand, think, and make decisions like humans.‬
‭●‬ ‭Used in robotics, smart assistants, self-driving cars, and more.‬
‭●‬ ‭Example: Siri, Google Assistant, AI Robots‬

‭Characteristics of a computer:‬

‭Some important characteristics of the computer are as follow:‬

‭1. Speed:‬
‭●‬ ‭A computer works very fast.‬
‭●‬ ‭It can perform millions of tasks in a second.‬
‭●‬ ‭Example: It can add big numbers within a fraction of a second.‬

‭2.  Accuracy:‬
‭●‬ ‭A computer gives correct results.‬
‭●‬ ‭Mistakes‬ ‭are‬ ‭usually‬ ‭due‬ ‭to‬ ‭wrong‬ ‭input‬ ‭or‬ ‭instructions‬ ‭given‬ ‭by‬

‭humans.‬
‭3. Automation:‬
‭●‬ ‭Once‬ ‭you‬ ‭give‬ ‭the‬ ‭instructions‬ ‭(program),‬ ‭the‬ ‭computer‬ ‭works‬

‭automatically. No need to give instructions again and again.‬
‭4. Multitasking‬
‭●‬ ‭A computer can do many tasks at the same time.‬
‭●‬ ‭Example:‬ ‭You‬ ‭can‬ ‭type‬ ‭a‬ ‭document,‬ ‭listen‬ ‭to‬ ‭music,‬ ‭and‬ ‭download‬

‭files together.‬

‭5. Storage‬
‭●‬ ‭A computer can store a large amount of data.‬
‭●‬ ‭You can save text, images, videos, and much more for a long time.‬

‭Shiv Nadar Institution of Eminence‬
‭Deemed to be University‬ ‭8‬‭। page‬



‭Types of Computers:‬
‭Computers‬ ‭are‬ ‭different‬‭types‬‭based‬‭on‬‭their‬‭size,‬‭power,‬‭and‬‭usage.‬‭Here‬
‭are the main types:‬
‭1. Super computer‬
‭A‬‭supercomputer‬‭is‬‭a‬‭very‬‭fast‬‭and‬‭powerful‬‭computer.‬‭It‬‭can‬‭do‬‭millions‬‭of‬
‭tasks‬ ‭in‬ ‭one‬ ‭second.‬ ‭Supercomputers‬ ‭are‬ ‭much‬ ‭faster‬ ‭than‬ ‭normal‬
‭computers.‬

‭●‬ ‭Fastest and most powerful computers.‬
‭●‬ ‭Used for weather forecasting, space research, scientific simulations.‬

‭2. Mainframe Computer‬
‭A‬ ‭mainframe‬ ‭computer‬ ‭is‬ ‭a‬ ‭large‬ ‭and‬ ‭powerful‬ ‭computer‬ ‭used‬ ‭by‬ ‭big‬
‭companies‬ ‭and‬ ‭government‬ ‭offices.‬ ‭It‬ ‭can‬ ‭handle‬ ‭many‬ ‭users‬ ‭and‬ ‭large‬
‭amounts of data at the same time.‬

‭●‬ ‭Very big and powerful.‬
‭●‬ ‭Can support hundreds or thousands of users at the same time.‬
‭●‬ ‭Used by banks, railways, big companies.‬
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‭3. Mini Computer‬

‭A‬ ‭minicomputer‬ ‭is‬ ‭a‬ ‭medium-sized‬ ‭computer‬ ‭used‬ ‭by‬ ‭small‬ ‭businesses‬
‭and‬ ‭organizations.‬ ‭It‬ ‭can‬ ‭handle‬ ‭multiple‬ ‭users‬ ‭at‬ ‭the‬ ‭same‬ ‭time‬ ‭and‬ ‭is‬
‭used for business tasks and data processing.‬

‭●‬ ‭Smaller than mainframe computers but still powerful.‬
‭●‬ ‭Used in small companies, organizations, or departments.‬
‭●‬ ‭Supports many users but fewer than mainframes.‬

‭4. Microcomputer (Personal Computer)‬

‭A‬ ‭microcomputer‬ ‭is‬‭a‬‭small,‬‭affordable‬‭computer‬‭used‬‭by‬‭one‬‭person‬‭at‬‭a‬
‭time. It is also called a personal computer (PC).‬

‭●‬ ‭Commonly used by individuals.‬
‭●‬ ‭Also called PC (Personal Computer).‬
‭●‬ ‭Used at home, schools, offices.‬
‭●‬ ‭Types of Microcomputers:‬

‭⮚‬ ‭Desktop‬
‭⮚‬ ‭Laptop‬
‭⮚‬ ‭Tablet‬
‭⮚‬ ‭Smartphone‬
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‭Role of Computers in Modern Life:‬

‭Computers‬ ‭are‬ ‭used‬ ‭in‬ ‭almost‬ ‭every‬ ‭field‬ ‭today.‬ ‭They‬ ‭help‬ ‭us‬ ‭to‬ ‭do‬ ‭work‬
‭faster,‬ ‭more‬ ‭accurately,‬ ‭and‬ ‭with‬ ‭less‬ ‭effort.‬ ‭Let’s‬ ‭look‬ ‭at‬ ‭how‬ ‭computers‬
‭are used in different areas:‬

‭1. Education‬
‭●‬ ‭Used in schools and colleges for learning and teaching.‬
‭●‬ ‭Helps‬ ‭students‬ ‭to‬ ‭study‬ ‭through‬ ‭online‬ ‭classes,‬ ‭videos,‬ ‭and‬

‭educational software.‬
‭●‬ ‭Used for creating question papers and report cards.‬

‭2. Office Work‬
‭●‬ ‭Used for typing documents, emails, and presentations.‬
‭●‬ ‭Helps in managing data, records, and communication.‬
‭●‬ ‭Saves time and improves efficiency.‬

‭3. Hospitals and Health Care‬
‭●‬ ‭Helps doctors in checking patients and doing surgeries.‬
‭●‬ ‭Used for keeping medical records and reports.‬
‭●‬ ‭Used in scanning machines (CT scan, MRI).‬

‭4. Banking‬
‭●‬ ‭Used‬‭for‬‭money‬‭transfers,‬‭ATM‬‭machines,‬‭and‬‭maintaining‬‭customer‬

‭accounts.‬
‭●‬ ‭Helps in online banking and digital payments.‬

‭5. Business‬
‭●‬ ‭Used in billing, inventory, sales reports, and online shopping.‬
‭●‬ ‭Helps manage accounts and customer service.‬

‭Parts of computer:‬
‭A‬ ‭computer‬ ‭is‬ ‭made‬ ‭up‬ ‭of‬ ‭different‬ ‭parts‬ ‭that‬ ‭work‬ ‭together‬ ‭to‬ ‭perform‬
‭tasks.‬ ‭These‬ ‭parts‬ ‭are‬ ‭mainly‬ ‭divided‬ ‭into‬ ‭two‬ ‭categories:‬ ‭Hardware‬ ‭and‬
‭Software.‬

‭1. Hardware:‬
‭Hardware‬ ‭refers‬ ‭to‬ ‭the‬ ‭physical‬ ‭parts‬ ‭of‬ ‭a‬ ‭computer‬ ‭that‬ ‭we‬ ‭can‬ ‭see‬‭and‬
‭touch.‬
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‭Examples‬‭: Monitor, Keyboard, Mouse, CPU, Printer, Speakers, Hard Disk,etc.‬

‭2. Software:‬
‭Software‬ ‭refers‬ ‭to‬ ‭the‬ ‭set‬ ‭of‬ ‭instructions‬ ‭or‬ ‭programs‬ ‭that‬ ‭tell‬ ‭the‬
‭computer‬ ‭what‬ ‭to‬ ‭do.‬ ‭We‬ ‭cannot‬ ‭touch‬ ‭software‬ ‭it‬ ‭only‬ ‭works‬ ‭inside‬ ‭the‬
‭computer.‬
‭Examples: Windows, MS Word, Paint, Google Chrome, Games, etc.‬

‭What is Device in a computer?‬

‭A‬ ‭device‬ ‭in‬ ‭a‬ ‭computer‬ ‭refers‬ ‭to‬ ‭any‬ ‭hardware‬ ‭component‬ ‭that‬ ‭helps‬ ‭in‬
‭input,‬ ‭processing,‬ ‭output,‬ ‭or‬ ‭storage‬‭of‬‭data.‬‭These‬‭devices‬‭are‬‭connected‬
‭to the computer and work together to complete tasks.‬

‭Types of Devices in Computer:‬
‭Computer devices are mainly divided into Three types:‬

‭1. Input Devices:‬
‭These devices are used to enter data and instructions into the computer.‬
‭Examples:‬
‭●‬ ‭Keyboard – to type text‬
‭●‬ ‭Mouse – to click and move the pointer‬
‭●‬ ‭Scanner – to scan documents‬
‭●‬ ‭Microphone – to record sound‬
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‭2. Output Devices:‬

‭These devices are used to display or show results of processed data.‬
‭Examples:‬

‭●‬ ‭Monitor – to display text and images‬
‭●‬ ‭Printer – to get printed copy (hard copy)‬
‭●‬ ‭Speakers – to hear sound‬
‭●‬ ‭Projector – to display screen on a wall‬

‭3. Storage Devices:‬
‭Storage‬ ‭devices‬ ‭are‬ ‭hardware‬ ‭used‬ ‭to‬ ‭store‬ ‭data,‬ ‭files,‬ ‭and‬ ‭programs‬ ‭in‬ ‭a‬
‭computer.‬ ‭These‬ ‭devices‬ ‭help‬ ‭us‬ ‭save‬ ‭information‬ ‭permanently‬ ‭or‬
‭temporarily.‬
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‭Examples:‬

‭Type‬ ‭Examples‬ ‭Use‬
‭Primary‬
‭Storage‬

‭RAM, Cache‬ ‭Temporary‬ ‭storage‬ ‭used‬ ‭while‬
‭computer is on‬

‭Secondary‬
‭Storage‬

‭Hard Disk, SSD‬ ‭Permanent‬ ‭storage‬‭for‬‭programs‬‭and‬
‭files‬

‭Portable‬
‭Storage‬

‭PenDrive, CD/DVD‬ ‭Easy‬‭to‬‭carry‬‭and‬‭move‬‭data‬‭between‬
‭devices‬

‭Cloud Storage‬ ‭GoogleDrive,‬
‭OneDrive‬

‭Online storage using internet‬

‭Primary Memory‬

‭Primary‬‭memory‬‭is‬‭the‬‭main‬‭memory‬‭of‬‭the‬‭computer,‬‭also‬‭called‬‭internal‬
‭memory.‬

‭●‬ ‭It‬ ‭stores‬ ‭data‬ ‭and‬ ‭instructions‬ ‭temporarily‬ ‭while‬ ‭the‬ ‭computer‬ ‭is‬
‭working.‬

‭●‬ ‭It is directly accessible by the CPU.‬
‭●‬ ‭It is faster but limited in size compared to secondary storage‬

‭Parts of Primary Memory‬

‭●‬ ‭RAM (Random Access Memory)‬

‭○‬ ‭Temporary‬ ‭memory‬ ‭(volatile)‬ ‭–‬ ‭data‬ ‭is‬ ‭lost‬ ‭when‬ ‭power‬ ‭is‬
‭turned off.‬

‭○‬ ‭Used for running programs and processing data.‬

‭❖‬ ‭Two types:‬
‭■‬ ‭SRAM (Static RAM) – faster, expensive, used in cache.‬
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‭■‬ ‭DRAM‬ ‭(Dynamic‬ ‭RAM)‬ ‭–‬ ‭slower,‬ ‭cheaper,‬ ‭used‬ ‭as‬ ‭main‬
‭memory.‬

‭●‬ ‭ROM (Read Only Memory)‬

‭○‬ ‭Permanent‬ ‭memory‬ ‭(non-volatile)‬ ‭–‬ ‭data‬ ‭is‬ ‭not‬ ‭lost‬ ‭when‬
‭power is off.‬

‭○‬ ‭Stores essential programs like BIOS (for booting the computer).‬
‭❖‬ ‭Types:‬

‭■‬ ‭PROM‬ ‭(Programmable‬ ‭ROM)‬ ‭–‬ ‭can‬ ‭be‬ ‭programmed‬
‭once.‬

‭■‬ ‭EPROM‬ ‭(Erasable‬ ‭PROM)‬ ‭–‬ ‭can‬ ‭be‬ ‭erased‬ ‭with‬ ‭UV‬ ‭light‬
‭and reprogrammed.‬

‭■‬ ‭EEPROM‬ ‭(Electrically‬ ‭Erasable‬ ‭PROM)‬ ‭–‬ ‭can‬ ‭be‬ ‭erased‬
‭and rewritten electrically‬

‭●‬ ‭Cache Memory‬

‭○‬ ‭Very high-speed memory between CPU and RAM.‬
‭○‬ ‭Stores frequently used instructions for faster processing.‬

‭●‬ ‭Registers‬

‭○‬ ‭Smallest, fastest memory inside CPU.‬
‭○‬ ‭Stores temporary instructions, addresses, and data.‬

‭Activity:‬

‭●‬ ‭Identify hardware parts & classify them as Input/Output/Storage‬

‭Summary:‬

‭●‬ ‭A computer is an electronic machine that works on input, process, and output.‬
‭●‬ ‭Computers developed through five generations, improving in speed, size, and‬

‭technology.‬
‭●‬ ‭Main features of computers include speed, accuracy, multitasking, and large‬

‭storage.‬
‭●‬ ‭Different types of computers include supercomputers, mainframes,‬

‭minicomputers, and microcomputers.‬
‭●‬ ‭Basic components include hardware, software, input/output devices, and different‬

‭types of memory.‬
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‭Unit 2: MS Office‬

‭Introduction‬

‭Microsoft Office (MS Office) is a suite of productivity software developed by‬
‭Microsoft.‬
‭It contains a group of applications that help users create documents,‬
‭manage data, prepare presentations, send emails, and store information‬
‭efficiently.‬

‭History of MS Office‬

‭●‬ ‭Launched by Microsoft in 1989 for Apple Macintosh and in 1990 for‬

‭Windows.‬

‭●‬ ‭The first version included Word, Excel, and PowerPoint.‬

‭●‬ ‭Over time, Microsoft added more programs like Access, Outlook, and‬

‭OneNote.‬

‭●‬ ‭MS Office 2003 introduced a more modern interface and better file‬

‭sharing.‬

‭●‬ ‭MS Office 2007 brought the Ribbon Interface (tab-based tools).‬

‭●‬ ‭MS Office 2013 added cloud integration through OneDrive.‬

‭●‬ ‭MS Office 2016 and 2019 improved collaboration and sharing features.‬

‭Importance of MS Office‬

‭MS Office is one of the most important and widely used computer software‬
‭suites because it helps users:‬

‭●‬ ‭Create professional documents (reports, letters, resumes)‬

‭●‬ ‭Analyze data and perform calculations using Excel‬

‭●‬ ‭Design creative presentations with PowerPoint‬

‭●‬ ‭Send and organize emails with Outlook‬

‭●‬ ‭Increase productivity and accuracy in both academic and office work‬
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‭Components of MS Office Suite‬

‭Each program in MS Office serves a specific purpose:‬

‭Application‬ ‭Purpose / Use‬

‭MS Word‬ ‭Used to create and format text documents like letters, reports, and‬
‭resumes.‬

‭MS Excel‬ ‭Used for data entry, calculations, charts, and analysis through‬
‭spreadsheets.‬

‭MS PowerPoint‬ ‭Used to create slideshows and presentations with text, images, and‬
‭videos.‬

‭Summary:‬

‭●‬ ‭MS Office is a collection of software used for creating documents, presentations,‬
‭and managing data.‬

‭●‬ ‭It was first released in 1989–1990 and has improved over time with new features‬
‭and better interfaces.‬

‭●‬ ‭MS Office helps users work efficiently by creating documents, analyzing data, and‬
‭designing presentations.‬

‭●‬ ‭The main applications include MS Word for documents, MS Excel for‬

‭spreadsheets, and MS PowerPoint for presentations.‬
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‭Unit 2.1: Microsoft Word‬

‭Introduction to MS Word‬

‭Microsoft‬‭Word‬‭is‬‭a‬‭popular‬‭word‬‭processing‬‭software‬‭used‬‭worldwide.‬‭It‬‭is‬
‭part‬ ‭of‬ ‭the‬ ‭Microsoft‬ ‭Office‬ ‭suite‬ ‭and‬ ‭allows‬ ‭users‬ ‭to‬ ‭create,‬ ‭edit,‬ ‭format,‬
‭and print documents.‬

‭Key Points:‬

‭●‬ ‭MS‬ ‭Word‬ ‭is‬ ‭used‬ ‭for‬ ‭creating‬ ‭letters,‬ ‭reports,‬ ‭resumes,‬ ‭essays,‬
‭projects, and official documents‬‭.‬

‭●‬ ‭It‬ ‭helps‬ ‭in‬ ‭organizing‬ ‭content‬ ‭neatly‬ ‭with‬ ‭tools‬ ‭for‬ ‭text‬ ‭formatting,‬
‭spell check, grammar check, tables, images, charts, and SmartArt.‬

‭●‬ ‭Students‬‭should‬‭learn‬‭MS‬‭Word‬‭because‬‭it‬‭is‬‭widely‬‭used‬‭in‬‭schools,‬
‭colleges, and professional work‬‭.‬

‭●‬ ‭MS‬ ‭Word‬ ‭provides‬ ‭templates,‬ ‭styles,‬ ‭themes,‬ ‭and‬ ‭page‬ ‭layout‬
‭options‬‭to create professional-looking documents easily.‬

‭●‬ ‭It‬ ‭saves‬ ‭time‬ ‭and‬ ‭improves‬ ‭document‬ ‭presentation‬ ‭compared‬ ‭to‬
‭handwriting.‬
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‭Advance Formating‬

‭Font Styles:‬

‭●‬ ‭Font‬ ‭style‬ ‭determines‬ ‭the‬ ‭appearance‬ ‭of‬ ‭the‬ ‭text‬‭.‬ ‭Examples:‬ ‭Arial,‬
‭Times New Roman, Calibri etc.‬‭.‬

‭●‬ ‭You can highlight text using‬‭Bold, Italic, or Underline‬‭.‬
‭●‬ ‭Using‬ ‭clear‬ ‭and‬ ‭readable‬ ‭fonts‬ ‭makes‬ ‭documents‬ ‭professional‬ ‭and‬

‭easy to read.‬

‭Font Size:‬

‭●‬ ‭Font size determines the‬‭height of the text‬‭.‬
‭●‬ ‭Standard font size for body text is‬‭11 or 12 points‬‭.‬
‭●‬ ‭Headings are usually‬‭14–16 points‬‭, and subheadings‬‭12–14 points‬‭.‬

‭Tips:‬

‭●‬ ‭Avoid‬ ‭using‬ ‭too‬ ‭many‬ ‭font‬ ‭styles‬ ‭in‬ ‭one‬ ‭document‬ ‭to‬ ‭maintain‬ ‭a‬
‭clean look.‬

‭●‬ ‭Consistent fonts make assignments and projects look organized.‬

‭Line Spacing:‬

‭●‬ ‭Line spacing is the space between lines of text.‬
‭●‬ ‭Options:‬‭Single, 1.5 lines, Double‬‭.‬
‭●‬ ‭Proper‬ ‭line‬ ‭spacing‬ ‭improves‬ ‭readability‬ ‭and‬ ‭avoids‬ ‭a‬ ‭crowded‬

‭appearance.‬

‭Paragraph Spacing:‬

‭●‬ ‭Paragraph spacing is the space before and after a paragraph.‬
‭●‬ ‭It makes the document‬‭visually appealing‬‭and easier‬‭to read.‬
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‭Tips:‬

‭●‬ ‭For official documents, 1.5-line spacing is commonly used.‬
‭●‬ ‭Paragraph‬ ‭spacing‬ ‭of‬ ‭6–12‬ ‭pt‬ ‭is‬‭usually‬‭suitable‬‭for‬‭school‬‭or‬‭college‬

‭assignments.‬

‭Header:‬

‭●‬ ‭A‬ ‭section‬ ‭at‬ ‭the‬ ‭top‬ ‭of‬ ‭the‬ ‭page‬‭.‬ ‭Can‬ ‭include‬ ‭document‬ ‭title,‬
‭author name, or date‬‭.‬

‭Footer:‬

‭●‬ ‭A‬‭section‬‭at‬‭the‬‭bottom‬‭of‬‭the‬‭page‬‭.‬‭Can‬‭include‬‭page‬‭numbers‬‭or‬
‭other information‬‭.‬

‭Uses:‬

‭●‬ ‭Helps in‬‭organizing long documents‬‭.‬
‭●‬ ‭Automatically adds information to all pages for professional look.‬

‭Tips:‬

‭●‬ ‭You can insert images or logos in headers for official letters.‬
‭●‬ ‭Page‬ ‭numbers‬ ‭in‬ ‭footer‬ ‭make‬ ‭long‬ ‭assignments‬ ‭or‬ ‭reports‬ ‭easy‬ ‭to‬

‭follow.‬
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‭Styles and Templates‬

‭Styles:‬

‭●‬ ‭Styles‬ ‭are‬ ‭predefined‬ ‭formatting‬ ‭sets‬ ‭like‬ ‭Heading‬ ‭1,‬ ‭Heading‬ ‭2,‬
‭and Normal‬‭.‬

‭●‬ ‭They‬ ‭help‬ ‭maintain‬ ‭consistent‬ ‭formatting‬ ‭in‬ ‭headings,‬
‭subheadings, and body text.‬

‭Templates:‬

‭●‬ ‭Templates‬‭are‬‭pre-designed‬‭document‬‭formats‬‭for‬‭resumes,‬‭letters,‬
‭certificates, etc.‬

‭●‬ ‭Using‬ ‭templates‬ ‭saves‬ ‭time‬ ‭and‬ ‭ensures‬ ‭professional‬ ‭and‬ ‭neat‬
‭formatting.‬

‭Points:‬

‭●‬ ‭Students‬ ‭can‬ ‭customize‬ ‭templates‬ ‭to‬ ‭add‬ ‭their‬ ‭own‬ ‭details‬ ‭and‬
‭design.‬

‭●‬ ‭Styles‬ ‭can‬ ‭be‬ ‭modified‬ ‭to‬ ‭suit‬ ‭personal‬ ‭or‬ ‭institutional‬ ‭formatting‬
‭rules‬‭.‬

‭Creating and Formatting Tables‬

‭Creating Tables:‬

‭●‬ ‭Tables organize data in‬‭rows and columns‬‭.‬
‭●‬ ‭Insert → Table → Choose number of rows and columns.‬

‭Formatting Tables:‬

‭●‬ ‭Adjust‬‭borders, shading, alignment, and text direction‬‭.‬
‭●‬ ‭Change‬‭column width‬‭and‬‭row height‬‭to fit content.‬
‭●‬ ‭Use table styles for a‬‭professional look‬‭.‬
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‭Points:‬

‭●‬ ‭Tables‬ ‭are‬ ‭useful‬ ‭for‬ ‭marksheets,‬‭schedules,‬‭comparison‬‭charts,‬‭and‬
‭project data.‬

‭●‬ ‭Sorting table data can make it‬‭easier to read‬‭.‬

‭Inserting and Formatting Images‬

‭Inserting Images:‬

‭●‬ ‭Insert → Pictures → Choose image from computer/choose from online.‬

‭Resizing and Positioning Images:‬

‭●‬ ‭Resize using corner handles (maintains aspect ratio).‬
‭●‬ ‭Position‬ ‭using‬ ‭Wrap‬ ‭Text‬ ‭options‬ ‭(In‬ ‭Line,‬ ‭Square,‬ ‭Tight,‬ ‭Behind‬

‭Text).‬

‭Using SmartArt:‬

‭●‬ ‭SmartArt helps in‬‭visual representation‬‭of information.‬
‭●‬ ‭Insert → SmartArt → Select diagram type → Enter data.‬

‭Tips:‬

‭●‬ ‭Combining‬‭images‬‭and‬‭SmartArt‬‭improves‬‭visual‬‭appeal‬‭of‬‭projects‬
‭and presentations.‬

‭●‬ ‭Always‬ ‭align‬ ‭images‬ ‭properly‬ ‭with‬ ‭text‬ ‭to‬ ‭maintain‬ ‭document‬
‭neatness‬‭.‬

‭Shiv Nadar Institution of Eminence‬
‭Deemed to be University‬ ‭22‬‭। page‬



‭Page Setup and Printing Options‬

‭Margins:‬

‭●‬ ‭Margins are the empty spaces around page edges.‬
‭●‬ ‭Layout → Margins → Choose Normal / Narrow / Custom.‬

‭Orientation:‬

‭●‬ ‭Portrait (vertical) or Landscape (horizontal).‬
‭●‬ ‭Layout → Orientation → Select desired option.‬

‭Paper Size:‬

‭●‬ ‭Standard sizes: A4, Letter, Legal.‬
‭●‬ ‭Layout → Size → Choose appropriate paper size.‬

‭Page Numbers:‬

‭●‬ ‭Insert → Page Number → Select location (Top / Bottom).‬

‭Printing Options:‬

‭●‬ ‭File → Print → Select printer, pages, copies, layout.‬
‭●‬ ‭Always use‬‭Print Preview‬‭to check document before‬‭printing.‬

‭Tips for Students:‬

‭●‬ ‭Always save documents regularly.‬
‭●‬ ‭Use‬‭Undo (Ctrl+Z)‬‭and‬‭Redo (Ctrl+Y)‬‭options for easy‬‭corrections.‬
‭●‬ ‭Learn shortcuts for faster work (e.g.,‬‭Ctrl+C, Ctrl+V,‬‭Ctrl+B, Ctrl+I‬‭).‬
‭●‬ ‭Keep documents organized in‬‭folders‬‭for easy access.‬
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‭Activities‬
‭●‬ ‭Apply advanced formatting in a paragraph‬
‭●‬ ‭Create a table of student data and insert a SmartArt diagram.‬

‭Summary:‬

‭●‬ ‭MS Word is a word-processing software used to create, edit, and format‬
‭documents like letters, reports, and projects.‬

‭●‬ ‭It provides tools such as font styles, sizes, spacing, headers, footers, tables, images,‬
‭and SmartArt for better document presentation.‬

‭●‬ ‭Formatting features help make documents neat and professional through styles,‬
‭templates, and page layout options.‬

‭●‬ ‭Users can insert tables, images, and diagrams to organize information clearly.‬
‭●‬ ‭Page setup, margins, orientation, and printing options help prepare documents‬

‭correctly for print or submission.‬
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‭Unit 2.2: Microsoft Excel‬

‭Introduction to MS Excel‬

‭Microsoft‬‭Excel‬‭is‬‭a‬‭powerful‬‭spreadsheet‬‭software‬‭used‬‭to‬‭store,‬‭organize,‬
‭and‬‭analyze‬‭data‬‭.‬‭It‬‭is‬‭part‬‭of‬‭the‬‭Microsoft‬‭Office‬‭suite‬‭and‬‭is‬‭widely‬‭used‬
‭in schools, colleges, and offices.‬

‭Key Features:‬

‭●‬ ‭Excel‬ ‭allows‬‭creating‬‭tables,‬‭performing‬‭calculations,‬‭making‬‭charts,‬

‭and visualizing data.‬

‭●‬ ‭Students‬ ‭can‬ ‭use‬ ‭Excel‬ ‭to‬ ‭manage‬ ‭marksheets,‬ ‭budgets,‬

‭schedules, and projects‬‭.‬

‭●‬ ‭It saves time and makes data analysis‬‭easy and accurate‬

‭Entering Data‬

‭●‬ ‭Data‬ ‭is‬ ‭entered‬ ‭in‬ ‭cells‬‭,‬ ‭which‬ ‭are‬ ‭the‬ ‭intersections‬ ‭of‬ ‭rows‬ ‭and‬

‭columns.‬

‭●‬ ‭Each cell has a‬‭unique address‬‭(e.g., A1, B2).‬

‭●‬ ‭You can enter‬‭text, numbers, or dates‬‭.‬

‭●‬ ‭Press‬ ‭Enter‬ ‭to‬ ‭move‬ ‭to‬ ‭the‬ ‭next‬ ‭row‬ ‭and‬ ‭Tab‬ ‭to‬ ‭move‬ ‭to‬ ‭the‬ ‭next‬

‭column.‬
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‭Tips:‬

‭●‬ ‭Avoid leaving blank rows/columns in the middle of data.‬

‭●‬ ‭Use‬‭Clear All‬‭option to remove unwanted data from‬‭cells.‬

‭Formatting Cells‬

‭Formatting makes data‬‭clear and attractive‬‭.‬

‭Options include:‬

‭●‬ ‭Font Style:‬‭Change the type of text (Arial, Calibri,‬‭Times New Roman).‬

‭●‬ ‭Font Size & Color:‬‭Make headings larger and important‬‭data colored.‬

‭●‬ ‭Borders:‬‭Add borders to separate cells or create tables.‬

‭●‬ ‭Alignment:‬‭Left, Center, Right alignment for text.‬

‭●‬ ‭Number‬ ‭Formatting:‬ ‭Display‬ ‭numbers‬ ‭as‬ ‭general,‬ ‭currency,‬

‭percentage, or date.‬
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‭Adjusting Row and Column Size‬

‭●‬ ‭Row‬ ‭height‬ ‭and‬ ‭column‬ ‭width‬ ‭can‬ ‭be‬ ‭manually‬ ‭adjusted‬ ‭or‬ ‭set‬ ‭to‬

‭auto-fit‬‭based on content.‬

‭●‬ ‭Proper row and column sizing makes the data‬‭neat and‬‭readable‬‭.‬

‭Tips:‬

‭●‬ ‭Double-click the boundary between columns to auto-fit content.‬

‭●‬ ‭Avoid excessive spacing to keep the sheet compact.‬

‭Tables in Excel‬

‭●‬ ‭Tables help organize data in a‬‭structured format‬‭.‬

‭●‬ ‭Select data → Insert → Table → Choose style.‬

‭●‬ ‭Tables provide‬‭sorting and filtering options‬‭automatically.‬

‭●‬ ‭They are useful for managing‬‭large datasets‬‭efficiently.‬
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‭Sorting and Filtering Data‬

‭Sorting:‬

‭●‬ ‭Arrange‬‭data‬‭in‬‭ascending‬‭(A–Z‬‭or‬‭smallest–largest)‬‭or‬‭descending‬

‭(Z–A or largest–smallest)‬‭order.‬

‭●‬ ‭Example: Sort student marks from highest to lowest.‬

‭Filtering:‬

‭●‬ ‭Display only‬‭rows that meet specific criteria‬‭.‬

‭●‬ ‭Example: Show only students who scored above 75 marks.‬

‭Using Basic Formula‬

‭How to Use Formulas in Excel‬

‭Steps:‬

‭Step 1.‬‭Open Excel‬
‭Step2‬‭. Type numbers in two cells‬

‭Example:‬‭10 in A1, 20 in B1‬

‭Step 3‬‭. Click on another cell (like C1) for result‬
‭Step 4.‬‭Type the formula in cell or in the formula‬‭bar‬
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‭Operation‬ ‭Formula‬
‭Synta‬
‭x‬

‭Example‬ ‭Result‬

‭Addition‬ ‭=A1 + B1‬ ‭=10 + 20‬ ‭30‬

‭Subtraction‬ ‭=A1 - B1‬ ‭=50 – 30‬ ‭20‬

‭Multiplication‬ ‭=A1 * B1‬ ‭=5 * 4‬ ‭20‬

‭Division‬ ‭=A1 / B1‬ ‭=40 / 5‬ ‭8‬

‭Combine‬ ‭Numbers‬
‭and Cells‬

‭=A1 + 10‬ ‭If‬ ‭A1‬ ‭=‬ ‭20,‬ ‭then‬
‭=A1+10‬

‭30‬



‭Example: =A1 + B1‬

‭Step 5.‬‭Press Enter‬

‭Excel shows the answer: 30‬

‭Note‬‭: Formula Is Always Started with” =” equal sign.‬‭(e.g: =A1+A2)‬

‭Using Basic Function‬

‭Function‬‭allows‬‭automatic calculations‬‭in Excel.‬

‭Common Function :‬

‭●‬ ‭SUM:‬‭Adds numbers in selected cells.‬

‭○‬ ‭Example:‬‭=SUM(B2:B10)‬

‭●‬ ‭AVERAGE:‬‭Finds the average of numbers.‬

‭○‬ ‭Example:‬‭=AVERAGE(B2:B10)‬

‭●‬ ‭IF:‬‭Checks a condition and returns results.‬

‭○‬ ‭Example:‬‭=IF(B2>=50,"Pass","Fail")‬

‭Applying Function :‬

‭●‬ ‭Use‬ ‭the‬ ‭fill‬ ‭handle‬ ‭(small‬ ‭square‬ ‭at‬ ‭cell‬ ‭corner)‬ ‭to‬ ‭copy‬‭formulas‬‭to‬

‭other cells.‬

‭●‬ ‭Saves time and ensures consistency across rows or column‬
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‭Creating Charts and Graphs in MS Excel‬

‭Charts‬ ‭and‬ ‭graphs‬ ‭are‬ ‭tools‬ ‭in‬ ‭Excel‬ ‭that‬ ‭help‬ ‭to‬ ‭visually‬ ‭represent‬ ‭data,‬
‭making‬ ‭it‬ ‭easier‬ ‭to‬ ‭analyze‬ ‭trends,‬ ‭compare‬ ‭values,‬ ‭and‬ ‭understand‬
‭patterns.‬‭Using‬‭charts‬‭and‬‭graphs‬‭is‬‭important‬‭because‬‭a‬‭picture‬‭of‬‭data‬‭is‬
‭often easier to understand than raw numbers.‬

‭1. Types of Charts and Their Uses‬

‭a) Bar Chart‬

‭●‬ ‭Description: Uses horizontal bars to compare different categories.‬

‭●‬ ‭Use: Best for comparing different items or categories side by side.‬

‭●‬ ‭Example: Compare marks of students in different subjects.‬

‭b) Column Chart‬

‭●‬ ‭Description: Uses vertical bars to compare values.‬

‭●‬ ‭Use:‬ ‭Suitable‬ ‭for‬ ‭showing‬ ‭data‬ ‭changes‬ ‭over‬ ‭time‬ ‭or‬ ‭between‬

‭groups.‬

‭●‬ ‭Example: Monthly sales of a store over a year.‬

‭c) Line Chart‬

‭●‬ ‭Description: Uses points connected by a line to show trends.‬

‭●‬ ‭Use: Ideal for showing data trends or changes over time.‬
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‭●‬ ‭Example: Stock price trends over several months.‬

‭d) Pie Chart‬

‭●‬ ‭Description: Circular chart divided into slices showing percentages.‬

‭●‬ ‭Use:‬ ‭Best‬ ‭for‬ ‭showing‬ ‭proportions‬ ‭or‬ ‭percentage‬ ‭distribution‬ ‭of‬ ‭a‬

‭whole.‬

‭●‬ ‭Example:‬ ‭Percentage‬ ‭of‬ ‭students‬ ‭passing,‬ ‭failing,‬ ‭or‬ ‭excelling‬ ‭in‬ ‭a‬

‭class.‬

‭e) Other Graphs‬

‭●‬ ‭Area Graph: Shows cumulative data over time.‬

‭●‬ ‭Scatter‬ ‭Plot:‬ ‭Shows‬ ‭the‬ ‭relationship‬ ‭between‬ ‭two‬ ‭sets‬ ‭of‬ ‭numerical‬

‭data.‬

‭●‬ ‭Combo‬ ‭Graph:‬ ‭Combines‬‭two‬‭types‬‭of‬‭charts‬‭(e.g.,‬‭column‬‭+‬‭line)‬‭for‬

‭complex data.‬

‭2. Steps to Insert Charts and Graphs‬

‭1.‬ ‭Select the Data:‬

‭○‬ ‭Highlight the cells containing the data you want to visualize.‬

‭○‬ ‭Include labels for rows and columns for clear chart axes.‬

‭2.‬ ‭Go to Insert → Charts:‬

‭○‬ ‭Choose the chart type (Bar, Column, Line, Pie, or Other).‬

‭○‬ ‭Excel‬‭will‬‭create‬‭the‬‭chart‬‭automatically‬‭based‬‭on‬‭the‬‭selected‬

‭data.‬

‭3.‬ ‭Add Titles and Labels:‬

‭○‬ ‭Give your chart a meaningful title.‬

‭○‬ ‭Label the X-axis (horizontal) and Y-axis (vertical) if needed.‬

‭○‬ ‭Add a legend to explain colors or data series.‬
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‭4.‬ ‭Format the Chart:‬

‭○‬ ‭Change colors, fonts, and gridlines to make the chart clear.‬

‭○‬ ‭Adjust the size and position of the chart in the worksheet.‬

‭○‬ ‭Highlight important data using data labels.‬

‭Using Graphs for Data Visualization‬

‭●‬ ‭Graphs help simplify complex data and make it easy to interpret.‬
‭●‬ ‭They‬ ‭allow‬ ‭students‬ ‭or‬ ‭professionals‬ ‭to‬ ‭identify‬ ‭trends,‬ ‭compare‬

‭values, and make decisions quickly.‬
‭●‬ ‭Examples of data visualization in Excel:‬

‭●‬ ‭Student‬ ‭performance:‬ ‭Compare‬ ‭marks‬ ‭of‬ ‭students‬ ‭using‬ ‭bar‬ ‭or‬

‭column charts.‬

‭●‬ ‭Financial data: Show revenue trends using line charts.‬

‭●‬ ‭Market share: Represent market share of products using pie charts.‬

‭●‬ ‭Properly‬ ‭formatted‬ ‭charts‬ ‭and‬ ‭graphs‬ ‭improve‬ ‭reports,‬

‭presentations, and projects.‬

‭Tips for Students:‬

‭●‬ ‭Always include labels, units, and legends for clarity.‬
‭●‬ ‭Choose‬ ‭the‬ ‭chart‬ ‭type‬ ‭according‬ ‭to‬ ‭the‬ ‭data:‬ ‭trends‬ ‭→‬ ‭line‬ ‭chart,‬

‭comparison → bar/column, percentage → pie chart.‬
‭●‬ ‭Avoid cluttered charts; simplicity increases readability.‬
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‭Activities :‬

‭●‬ ‭Enter student data in Excel and apply advanced formatting‬
‭●‬ ‭Enter marksheet data with formatting‬

‭●‬ ‭Apply formulas on marksheet data‬

‭●‬ ‭Generate performance chart from marksheet‬

‭Summary:‬

‭●‬ ‭Excel‬ ‭is‬ ‭a‬ ‭spreadsheet‬ ‭software‬ ‭used‬ ‭to‬ ‭store,‬ ‭organize,‬ ‭calculate,‬ ‭and‬ ‭analyze‬
‭data.‬

‭●‬ ‭Data‬‭is‬‭entered‬‭in‬‭cells,‬‭and‬‭formatting‬‭options‬‭like‬‭fonts,‬‭borders,‬‭and‬‭alignment‬
‭help make sheets neat and readable.‬

‭●‬ ‭Users can sort, filter, and organize tables for better data management.‬
‭●‬ ‭Formulas‬ ‭and‬ ‭functions‬ ‭(SUM,‬ ‭AVERAGE,‬ ‭IF)‬ ‭help‬ ‭perform‬ ‭quick‬ ‭and‬ ‭accurate‬

‭calculations.‬

‭●‬ ‭Excel allows creating charts and graphs to visually understand data and trends.‬
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‭UNIT 2.3 : Microsoft PowerPoint‬

‭Introduction‬

‭Microsoft‬ ‭PowerPoint‬ ‭is‬ ‭a‬ ‭presentation‬ ‭software‬ ‭developed‬ ‭by‬ ‭Microsoft‬

‭and‬ ‭is‬ ‭a‬ ‭part‬ ‭of‬ ‭the‬ ‭MS‬ ‭Office‬‭.‬ ‭It‬ ‭is‬ ‭used‬ ‭to‬ ‭create‬ ‭professional‬

‭presentations‬ ‭that‬ ‭can‬ ‭include‬ ‭text,‬ ‭pictures,‬ ‭charts,‬ ‭graphs,‬ ‭audio,‬

‭video,‬ ‭and‬ ‭animations‬‭.‬ ‭PowerPoint‬ ‭helps‬ ‭in‬ ‭presenting‬ ‭ideas,‬ ‭reports,‬ ‭or‬

‭lessons in a‬‭visually attractive and systematic‬‭manner.‬

‭A‬ ‭PowerPoint‬ ‭presentation‬ ‭is‬ ‭made‬‭up‬‭of‬‭slides‬‭,‬‭which‬‭are‬‭like‬‭pages‬‭in‬‭a‬

‭notebook.‬ ‭Each‬ ‭slide‬ ‭can‬‭contain‬‭different‬‭types‬‭of‬‭content‬‭depending‬‭on‬

‭the‬ ‭topic‬ ‭of‬ ‭the‬ ‭presentation.‬ ‭PowerPoint‬ ‭is‬ ‭widely‬ ‭used‬ ‭in‬ ‭education,‬

‭business,‬‭research,‬‭and‬‭training‬‭programs‬‭because‬‭it‬‭helps‬‭the‬‭audience‬

‭understand information easily and quickly.‬

‭A‬ ‭file‬ ‭created‬ ‭in‬ ‭Microsoft‬ ‭PowerPoint‬ ‭is‬ ‭saved‬ ‭with‬ ‭the‬ ‭.ppt‬ ‭or‬ ‭.pptx‬

‭extension.‬
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‭Features of Microsoft PowerPoint‬

‭Some of the main features of MS PowerPoint are:‬

‭●‬ ‭User-friendly‬ ‭Interface:‬ ‭PowerPoint‬ ‭has‬ ‭an‬ ‭easy-to-use‬ ‭interface‬

‭with menus and icons.‬

‭●‬ ‭Attractive‬ ‭Templates‬ ‭and‬ ‭Themes:‬ ‭Pre-designed‬ ‭templates‬ ‭help‬

‭users make beautiful slides.‬

‭●‬ ‭Multimedia‬ ‭Support:‬ ‭You‬ ‭can‬ ‭insert‬ ‭images,‬ ‭videos,‬ ‭audio‬ ‭clips,‬

‭and animations‬‭in slides.‬

‭●‬ ‭Transitions‬‭and‬‭Animations:‬‭Make‬‭the‬‭presentation‬‭lively‬‭by‬‭adding‬

‭movement and effects.‬

‭●‬ ‭Slide Master:‬‭Allows uniform design and formatting‬‭for all slides.‬

‭Starting Microsoft PowerPoint‬

‭To start PowerPoint:‬

‭1.‬ ‭Click on the‬‭Start Menu‬‭.‬

‭2.‬ ‭Type‬‭PowerPoint‬‭in the search box.‬

‭3.‬ ‭Click on the‬‭Microsoft PowerPoint‬‭icon to open it.‬

‭After opening PowerPoint, the‬‭Home Screen‬‭appears‬‭where you can:‬

‭●‬ ‭Open a‬‭Blank Presentation‬‭, or‬

‭●‬ ‭Choose a‬‭pre-designed template‬

‭35‬‭। page‬ ‭Shiv Nadar Institution of Eminence‬
‭Deemed to be University‬



‭The PowerPoint Window Interface‬

‭When PowerPoint opens, the screen shows different parts:‬

‭●‬ ‭Title Bar:‬‭Displays the file name and program name.‬

‭●‬ ‭Ribbon:‬‭Contains‬‭tabs‬‭(Home,‬‭Insert,‬‭Design,‬‭Transitions,‬‭Animations,‬

‭Slide‬ ‭Show,‬ ‭Review,‬ ‭View).‬ ‭Each‬ ‭tab‬ ‭has‬ ‭different‬ ‭commands‬

‭grouped together.‬

‭●‬ ‭Slide Pane:‬‭Shows the current slide for editing.‬

‭●‬ ‭Notes‬ ‭Pane:‬ ‭Allows‬ ‭the‬ ‭presenter‬ ‭to‬ ‭add‬ ‭notes‬ ‭that‬ ‭are‬ ‭visible‬‭only‬

‭during the presentation.‬

‭●‬ ‭Status Bar:‬‭Shows slide number, language, and view‬‭options.‬
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‭Designing Professional Presentation‬

‭Steps to create a new presentation:‬

‭1.‬ ‭Open‬‭MS PowerPoint‬‭.‬

‭2.‬ ‭Click on‬‭File → New‬‭.‬

‭3.‬ ‭Select‬‭Blank Presentation‬‭or choose a ready-made‬‭Template‬‭.‬

‭4.‬ ‭Click on‬‭Create‬‭.‬

‭5.‬ ‭Add slides using‬‭Home → New Slide‬‭.‬

‭6.‬ ‭Enter content such as text, pictures, or charts on each slide.‬

‭Understanding Slide Layouts‬

‭A‬‭slide layout‬‭defines how content is arranged on‬‭a slide.‬

‭Examples of common layouts:‬

‭●‬ ‭Title Slide:‬‭For title and subtitle.‬

‭●‬ ‭Title and Content:‬‭For headings and related text or‬‭images.‬

‭●‬ ‭Two Content:‬‭For comparing two pieces of information‬‭side by side.‬

‭●‬ ‭Blank Slide:‬‭For complete freedom to design your own‬‭layout.‬

‭You can change the layout anytime:‬

‭Go to‬‭Home → Layout → Select Layout Type‬‭.‬
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‭Working with Templates‬

‭A‬ ‭template‬ ‭is‬ ‭a‬ ‭pre-designed‬ ‭slide‬ ‭format‬ ‭that‬ ‭includes‬ ‭colors,‬‭fonts,‬‭and‬

‭background styles.‬

‭Templates save time and give a professional look to your presentation.‬

‭Steps to use a template:‬

‭1.‬ ‭Click‬‭File → New‬‭.‬

‭2.‬ ‭Choose from‬‭Available Templates and Themes‬‭.‬

‭3.‬ ‭Select your desired design and click‬‭Create‬‭.‬

‭Templates‬‭are‬‭ideal‬‭for‬‭business‬‭presentations,‬‭resumes,‬‭school‬‭projects,‬

‭and reports‬‭.‬
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‭Inserting Text Box, Pictures, and Shapes‬

‭Inserting Text Box:‬

‭●‬ ‭Click inside a‬‭text box‬‭and type your content.‬

‭●‬ ‭You‬‭can‬‭format‬‭the‬‭text‬‭using‬‭the‬‭Home‬‭tab‬‭:‬‭change‬‭font‬‭style,‬‭size,‬

‭and color.‬

‭●‬ ‭Align the text (left, right, center, justify) as needed.‬

‭Inserting Pictures:‬

‭●‬ ‭Go to‬‭Insert → Pictures‬‭.‬

‭●‬ ‭Choose an image from your computer or online.‬

‭●‬ ‭Resize or reposition the image by dragging its corners.‬
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‭Inserting Shapes:‬

‭●‬ ‭Go to‬‭Insert → Shapes‬‭.‬

‭●‬ ‭Select a shape like a rectangle, arrow, circle, or star.‬

‭●‬ ‭Draw the shape on the slide and format it with color or outline.‬

‭Designing Slides‬
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‭A‬ ‭good‬ ‭design‬ ‭makes‬ ‭the‬ ‭presentation‬ ‭more‬ ‭attractive‬ ‭and‬ ‭easy‬ ‭to‬

‭understand.‬

‭●‬ ‭Go to‬‭Design → Themes‬‭to choose a theme.‬

‭●‬ ‭Use‬‭Variants‬‭to adjust color combinations.‬

‭●‬ ‭Use‬‭Format Background‬‭to set solid or gradient colors.‬

‭●‬ ‭The‬‭Slide‬‭Master‬‭feature‬‭helps‬‭apply‬‭the‬‭same‬‭design‬‭to‬‭all‬‭slides‬‭at‬

‭once.‬

‭Tips for Good Design:‬

‭●‬ ‭Use simple fonts and light backgrounds.‬

‭●‬ ‭Avoid too much text on a single slide.‬

‭●‬ ‭Use relevant images and graphics.‬

‭●‬ ‭Keep colors consistent throughout the presentation.‬

‭Adding Transitions and Animations‬

‭Transitions-‬ ‭are‬ ‭visual‬ ‭effects‬ ‭applied‬ ‭when‬ ‭moving‬ ‭from‬ ‭one‬ ‭slide‬ ‭to‬

‭another.‬

‭Steps to add transitions:‬
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‭1.‬ ‭Select the slide.‬

‭2.‬ ‭Go to the Transitions‬‭tab‬‭.‬

‭3.‬ ‭Choose a transition effect (Fade, Push, Wipe, Split, etc.).‬

‭Click‬‭Apply to All‬‭to use the same transition throughout.‬

‭Animations-‬‭make text or objects appear with motion.‬

‭Steps to add animation:‬

‭1.‬ ‭Select the object or text.‬

‭2.‬ ‭Go to the Animations‬‭tab‬‭.‬

‭3.‬ ‭Choose an animation effect (Fly In, Zoom, Appear, etc.).‬

‭4.‬ ‭Adjust the timing and order using the Animation‬‭Pane‬‭.‬

‭Animations‬‭should‬‭be‬‭used‬‭carefully‬‭—‬‭too‬‭many‬‭can‬‭make‬‭a‬‭presentation‬

‭confusing.‬
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‭Inserting Charts, Tables, and SmartArt‬

‭●‬ ‭Charts:‬‭Represent data visually using bar, column,‬‭line, or pie charts.‬

‭○‬ ‭Go‬ ‭to‬ ‭Insert‬ ‭→‬ ‭Chart‬ ‭→‬ ‭select‬ ‭chart‬ ‭type‬ ‭→‬ ‭enter‬ ‭data‬ ‭in‬ ‭Excel‬

‭sheet.‬

‭●‬ ‭Tables:‬‭Organize information in rows and columns.‬

‭○‬ ‭Go to‬‭Insert → Table‬‭→ choose number of rows and columns.‬

‭●‬ ‭SmartArt:‬ ‭Used‬ ‭to‬ ‭create‬ ‭diagrams‬ ‭and‬ ‭flowcharts‬ ‭to‬ ‭show‬

‭processes, hierarchies, or relationships.‬

‭○‬ ‭Go to‬‭Insert → SmartArt‬‭→ choose a diagram and fill‬‭text.‬

‭Slide Show and Presentation View‬

‭Once all slides are ready, you can display them as a slide show.‬

‭Steps to start a slide show:‬

‭1.‬ ‭Go to‬‭Slide Show tab → From Beginning‬‭or press‬‭F5‬‭.‬
‭2.‬ ‭Use the‬‭arrow keys‬‭to move between slides.‬
‭3.‬ ‭Press‬‭Esc‬‭to exit the slide show.‬

‭You‬ ‭can‬ ‭also‬ ‭rehearse‬ ‭your‬ ‭presentation‬ ‭using‬ ‭Rehearse‬ ‭Timings‬ ‭and‬

‭record your voice using‬‭Record Slide Show‬‭.‬

‭Saving, Printing, and Sharing a Presentation‬

‭●‬ ‭To‬‭Save‬‭:‬

‭○‬ ‭Go‬ ‭to‬ ‭File‬ ‭→‬ ‭Save‬ ‭As‬ ‭→‬ ‭Choose‬‭Location‬‭→‬‭Enter‬‭File‬‭Name‬‭→‬

‭Save‬‭.‬

‭●‬ ‭To‬‭Print‬‭:‬

‭○‬ ‭Go to‬‭File → Print → Choose Printer → Set Layout →‬‭Print‬‭.‬

‭●‬ ‭To‬‭Share‬‭:‬

‭○‬ ‭Go to‬‭File → Share → Choose option (Email, OneDrive,‬‭or Link)‬‭.‬

‭You can also export a presentation as a‬‭PDF or video‬‭file for easy sharing.‬

‭Tips for Creating an Effective Presentation‬
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‭1.‬ ‭Keep slides‬‭simple and clear‬‭.‬
‭2.‬ ‭Use‬‭short sentences and bullet points‬‭instead of paragraphs.‬
‭3.‬ ‭Use‬‭images, charts, and diagrams‬‭to make data easy‬‭to understand.‬
‭4.‬ ‭Choose‬‭contrasting colors‬‭for background and text.‬
‭5.‬ ‭Rehearse before presenting to ensure smooth delivery.‬

‭Activity:‬‭Prepare a 5- Slide Presentation on “My Cereer‬‭Path”‬

‭Summary:‬
‭●‬ ‭PowerPoint‬ ‭is‬ ‭a‬ ‭presentation‬ ‭software‬ ‭used‬ ‭to‬ ‭create‬ ‭slides‬ ‭with‬ ‭text,‬ ‭images,‬

‭audio, video, and animations.‬
‭●‬ ‭It‬ ‭provides‬ ‭templates,‬ ‭themes,‬ ‭layouts,‬ ‭and‬ ‭design‬ ‭tools‬ ‭to‬ ‭make‬ ‭presentations‬

‭attractive and professional.‬
‭●‬ ‭Users‬ ‭can‬ ‭insert‬ ‭text‬ ‭boxes,‬ ‭pictures,‬ ‭shapes,‬ ‭tables,‬ ‭charts,‬ ‭and‬ ‭SmartArt‬ ‭to‬

‭present information clearly.‬
‭●‬ ‭Transitions‬‭and‬‭animations‬‭help‬‭make‬‭slides‬‭engaging,‬‭while‬‭Slide‬‭Show‬‭mode‬‭is‬

‭used to present the final work.‬
‭●‬ ‭Presentations‬‭can‬‭be‬‭saved,‬‭printed,‬‭and‬‭shared‬‭easily,‬‭making‬‭PowerPoint‬‭useful‬

‭for studies, business, and projects.‬
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‭UNIT 3: Data Analysis‬

‭Introduction‬

‭Data‬ ‭is‬ ‭everywhere‬ ‭—‬ ‭in‬ ‭schools,‬ ‭businesses,‬ ‭and‬ ‭research.‬ ‭Data‬ ‭is‬ ‭any‬
‭information‬ ‭that‬ ‭can‬ ‭be‬ ‭collected,‬ ‭recorded,‬ ‭and‬ ‭analyzed,‬ ‭like‬ ‭numbers,‬
‭text, dates, or logical values (TRUE/FALSE).‬

‭Data‬ ‭Analysis‬ ‭is‬ ‭the‬ ‭process‬ ‭of‬ ‭examining‬ ‭and‬ ‭interpreting‬ ‭data‬ ‭to‬ ‭find‬
‭meaningful insights, trends, and patterns.‬

‭A‬ ‭Dashboard‬ ‭is‬ ‭a‬ ‭single-screen‬ ‭visual‬ ‭display‬ ‭of‬ ‭key‬ ‭information‬ ‭using‬
‭charts,‬ ‭graphs,‬ ‭and‬ ‭KPIs.‬ ‭It‬ ‭allows‬ ‭quick‬ ‭understanding‬ ‭of‬ ‭trends‬ ‭and‬
‭comparisons without reading raw data.‬

‭Importance:‬

‭●‬ ‭Summarizes complex data‬
‭●‬ ‭Highlights important metrics‬
‭●‬ ‭Enables faster decisions‬
‭●‬ ‭Saves time in reporting‬
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‭Importing Raw Data‬

‭Steps:‬

‭1.‬ ‭Open Excel.‬
‭2.‬ ‭Go to‬‭Data → Get Data → From Text/CSV‬‭.‬
‭3.‬ ‭Select your file and preview the data.‬
‭4.‬ ‭Check that columns are aligned correctly.‬
‭5.‬ ‭Click‬‭Load‬‭to import.‬

‭Tip:‬‭Keep imported data in a separate sheet named‬‭Raw_Data‬‭.‬

‭Cleaning Data‬

‭1. Remove Duplicates‬

‭Purpose:‬‭Avoid repeated rows that can affect analysis.‬

‭Steps:‬

‭1.‬ ‭Select the range of cells containing data.‬
‭2.‬ ‭Go to‬‭Data → Remove Duplicates‬‭.‬
‭3.‬ ‭In the dialog box, select columns to check.‬
‭4.‬ ‭Click‬‭OK‬‭.‬
‭5.‬ ‭Excel‬ ‭removes‬ ‭duplicates‬ ‭and‬ ‭shows‬ ‭a‬ ‭message‬ ‭of‬ ‭how‬ ‭many‬ ‭were‬

‭removed.‬
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‭2. Trim Extra Spaces‬

‭Purpose:‬ ‭Remove‬ ‭unnecessary‬ ‭spaces‬ ‭that‬ ‭can‬ ‭cause‬ ‭formula‬ ‭or‬ ‭sorting‬
‭errors.‬
‭Steps:‬

‭1.‬ ‭In‬ ‭a‬ ‭new‬ ‭column,‬ ‭type‬ ‭formula‬ ‭=TRIM(A2)‬ ‭(replace‬ ‭A2‬ ‭with‬ ‭cell‬
‭reference).‬

‭2.‬ ‭Press‬‭Enter‬‭and copy the formula down for all rows.‬
‭3.‬ ‭Copy‬‭the‬‭new‬‭column‬‭→‬‭Right-click‬‭→‬‭Paste‬‭Values‬‭to‬‭replace‬‭original‬

‭data.‬

‭3. Find & Replace Errors‬
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‭Purpose:‬‭Correct misspelled words or missing values.‬
‭Steps:‬

‭1.‬ ‭Press‬‭Ctrl + H‬‭.‬
‭2.‬ ‭In‬‭Find What‬‭, enter the wrong value.‬
‭3.‬ ‭In‬‭Replace With‬‭, enter the correct value.‬
‭4.‬ ‭Click‬‭Replace All‬‭.‬

‭4. Handle Blank Cells‬

‭Purpose:‬‭Prevent errors in formulas and charts.‬
‭Steps:‬

‭1.‬ ‭Go to‬‭Home → Find & Select → Go To Special → Blanks‬‭.‬
‭2.‬ ‭Select all blank cells.‬
‭3.‬ ‭Type “N/A” or 0 and press‬‭Ctrl + Enter‬‭to fill all‬‭selected blanks.‬

‭5. Check Data Types‬

‭Purpose:‬‭Ensure numbers, dates, and text are correctly‬‭formatted.‬
‭Steps:‬

‭1.‬ ‭Select a column → Right-click → Format Cells.‬
‭2.‬ ‭Choose the appropriate type (Number, Date, Text).‬
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‭Sorting and Filtering‬

‭Sorting‬

‭Purpose:‬‭Arrange data to identify patterns.‬
‭Steps:‬

‭1.‬ ‭Select data range.‬
‭2.‬ ‭Go to‬‭Data → Sort‬‭.‬
‭3.‬ ‭Choose column → Ascending/Descending → OK‬

‭Filtering‬

‭Purpose:‬‭Show only relevant rows.‬
‭Steps:‬

‭1.‬ ‭Select header row →‬‭Data → Filter‬‭.‬
‭2.‬ ‭Click dropdown → Select criteria‬

‭Understanding Structured Datasets‬

‭Guidelines:‬

‭●‬ ‭Each column with clear heading‬
‭●‬ ‭Each row represents one record‬
‭●‬ ‭Avoid blank rows/merged cells‬
‭●‬ ‭Keep formatting consistent‬
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‭Dashboard Components‬

‭1. Data Table‬

‭●‬ ‭Cleaned dataset used for calculations and charts‬

‭2. KPIs (Key Performance Indicators)‬

‭Definition:‬ ‭Measurable‬ ‭values‬ ‭that‬ ‭indicate‬ ‭performance‬ ‭of‬ ‭a‬ ‭metric‬ ‭or‬
‭process.‬
‭Purpose:‬

‭●‬ ‭Highlight critical numbers (total, average, max, percentage)‬
‭●‬ ‭Quickly show important insights without analyzing full data‬

‭How to use:‬

‭1.‬ ‭Calculate metric using formulas (‬‭SUM()‬‭,‬‭AVERAGE()‬‭,‬‭MAX()‬‭)‬
‭2.‬ ‭Insert‬‭Text Box‬‭or‬‭Card‬‭to display value‬
‭3.‬ ‭Format for visibility; connect to slicers if needed‬

‭3. Charts & Graphs‬

‭●‬ ‭Select data → Insert → Choose chart → Add title and labels‬
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‭4. Slicers‬

‭Purpose:‬‭Interactive filter for tables/charts‬
‭Steps:‬

‭1.‬ ‭Select data table → Insert → Slicer → Choose field‬
‭2.‬ ‭Connect slicer to charts for dynamic filtering‬

‭5. Filters‬

‭●‬ ‭Show specific segments of data (Data → Filter → Choose criteria)‬

‭Layout Planning‬

‭●‬ ‭Decide KPIs, charts, slicers‬
‭●‬ ‭KPIs at top, charts at center, slicers at side‬
‭●‬ ‭Maintain spacing, alignment, consistent colors‬
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‭Visualization Techniques‬

‭●‬ ‭Bar Chart:‬‭Compare categories horizontally‬
‭●‬ ‭Column Chart:‬‭Compare vertically / show growth‬
‭●‬ ‭Line Chart:‬‭Show trends over time‬
‭●‬ ‭Pie Chart:‬‭Show proportion of whole‬

‭Combining Multiple Charts‬

‭When‬ ‭you‬ ‭combine‬ ‭multiple‬ ‭charts‬ ‭in‬ ‭a‬ ‭dashboard,‬ ‭you‬ ‭can‬ ‭understand‬
‭data‬‭from‬‭different‬‭perspectives‬‭in‬‭one‬‭view.‬‭It‬‭helps‬‭in‬‭better‬‭comparison‬
‭and decision-making.‬

‭Purpose:‬

‭●‬ ‭To give a‬‭complete story‬‭of data rather than isolated‬‭insights.‬
‭●‬ ‭Helps‬ ‭viewers‬ ‭connect‬‭different‬‭metrics‬‭like‬‭sales,‬‭profit,‬‭region,‬‭and‬

‭time.‬

‭Tips for Combining Charts:‬

‭1.‬ ‭Logical Placement:‬
‭Arrange‬ ‭charts‬ ‭in‬ ‭a‬ ‭meaningful‬ ‭order‬ ‭—‬ ‭for‬ ‭example,‬ ‭show‬ ‭overall‬

‭sales trend at the top and region-wise details below it.‬

‭2.‬ ‭Consistent Scale:‬
‭Use similar axis ranges and units (₹, %, etc.) to avoid confusion.‬

‭3.‬ ‭Uniform Formatting:‬
‭Keep‬ ‭font,‬ ‭colors,‬ ‭and‬ ‭chart‬ ‭styles‬ ‭consistent‬ ‭across‬ ‭all‬ ‭charts‬ ‭for‬ ‭a‬

‭professional look.‬

‭4.‬ ‭Interactive Linking:‬
‭Use‬‭filters‬‭or‬‭slicers‬‭that‬‭control‬‭multiple‬‭charts‬‭at‬‭once‬‭—‬‭so‬‭when‬‭a‬

‭user selects a region, all related charts update together.‬
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‭Highlighting Key Insights‬

‭Highlighting‬ ‭important‬ ‭insights‬ ‭makes‬ ‭your‬ ‭dashboard‬ ‭action-oriented‬
‭and helps users quickly focus on what matters most.‬

‭Purpose:‬

‭●‬ ‭To emphasize trends, targets, or exceptions.‬
‭●‬ ‭To make decision-making faster by drawing attention to key metrics.‬

‭Methods to Highlight Key Insights:‬

‭1.‬ ‭KPIs (Key Performance Indicators):‬
‭Display‬ ‭top‬ ‭metrics‬ ‭like‬ ‭total‬ ‭sales,‬‭growth‬‭%,‬‭or‬‭profit‬‭margin‬‭using‬
‭bold text or cards.‬

‭2.‬ ‭Chart Labels & Data Callouts:‬
‭Show exact values or percentage change directly on charts for clarity.‬

‭3.‬ ‭Conditional Formatting:‬
‭Apply‬‭color‬‭logic‬‭(e.g.,‬‭green‬‭for‬‭positive‬‭growth,‬‭red‬‭for‬‭negative)‬‭to‬

‭instantly show performance status.‬
‭4.‬ ‭Use of Shapes or Icons:‬

‭Add‬ ‭arrows‬ ‭(↑↓)‬ ‭or‬ ‭trend‬ ‭symbols‬ ‭near‬ ‭KPIs‬ ‭to‬‭indicate‬‭progress‬‭or‬
‭decline.‬

‭Dashboard Design Best Practices‬

‭A‬ ‭well-designed‬ ‭dashboard‬ ‭is‬‭clear,‬‭interactive,‬‭and‬‭easy‬‭to‬‭understand‬‭.‬
‭Good‬‭design‬‭helps‬‭users‬‭make‬‭decisions‬‭faster‬‭and‬‭reduces‬‭confusion.‬‭The‬
‭goal is not just to display data — it is to‬‭tell a‬‭story‬‭through visuals.‬
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‭1. Keep It Simple and Focused‬

‭Avoid‬‭adding‬‭too‬‭many‬‭charts‬‭or‬‭colors.‬‭A‬‭clean‬‭layout‬‭helps‬‭users‬‭focus‬‭on‬
‭the key message.‬

‭●‬ ‭Show only the most relevant KPIs and charts.‬
‭●‬ ‭Use white space to separate sections clearly.‬
‭●‬ ‭Avoid clutter — “Less is more.”‬

‭Example:‬ ‭Instead‬ ‭of‬ ‭10‬ ‭small‬ ‭charts,‬ ‭show‬ ‭3–4‬ ‭that‬ ‭actually‬ ‭explain‬
‭business performance.‬

‭2. Maintain Consistency‬

‭Consistency makes your dashboard professional and easy to read.‬

‭●‬ ‭Use the same‬‭font, colors, and chart styles‬‭throughout.‬
‭●‬ ‭Align all elements properly.‬
‭●‬ ‭Keep the scale and formatting of numbers uniform.‬

‭Tip:‬ ‭Use‬ ‭one‬ ‭color‬ ‭theme‬ ‭for‬ ‭the‬ ‭entire‬ ‭dashboard‬ ‭(e.g.,‬ ‭blue‬ ‭for‬ ‭positive‬
‭values, red for negative).‬

‭3. Highlight Key Metrics‬

‭Ensure that important insights are visible at first glance.‬

‭●‬ ‭Use bold fonts or larger sizes for KPIs.‬
‭●‬ ‭Apply‬‭conditional formatting‬‭to highlight trends.‬
‭●‬ ‭Place major KPIs at the top section of the dashboard.‬

‭Example:‬ ‭Show‬ ‭“Total‬ ‭Sales”‬ ‭and‬ ‭“Profit‬ ‭Margin”‬ ‭in‬ ‭large‬ ‭cards‬ ‭above‬ ‭all‬
‭charts.‬

‭4. Ensure Data Accuracy‬

‭A visually appealing dashboard is useless if the data is wrong.‬

‭●‬ ‭Double-check all formulas and references.‬
‭●‬ ‭Update data connections regularly.‬
‭●‬ ‭Use protected sheets if multiple users are accessing the dashboard.‬

‭Tip:‬‭Always verify numbers before final presentation.‬
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‭5. Choose the Right Chart Type‬

‭Each‬‭chart‬‭type‬‭communicates‬‭a‬‭different‬‭message.‬‭Choose‬‭based‬‭on‬‭your‬
‭goal:‬

‭●‬ ‭Bar / Column Chart:‬‭Compare categories‬
‭●‬ ‭Line Chart:‬‭Show trends over time‬
‭●‬ ‭Pie / Donut Chart:‬‭Show part-to-whole relationship‬
‭●‬ ‭Map Chart:‬‭Display geographic data‬

‭Example:‬‭To‬‭show‬‭monthly‬‭growth,‬‭a‬‭line‬‭chart‬‭is‬‭more‬‭effective‬‭than‬‭a‬‭bar‬
‭chart.‬

‭6. Make It Interactive‬

‭Interactivity increases engagement and usability.‬

‭●‬ ‭Add‬‭Slicers or Drop-down filters‬‭to allow users to‬‭explore data.‬
‭●‬ ‭Use buttons or navigation links for switching between views.‬
‭●‬ ‭Ensure slicers control multiple charts for consistent filtering.‬

‭Example:‬ ‭User‬ ‭selects‬‭“North‬‭Region”‬‭→‬‭all‬‭charts‬‭instantly‬‭update‬‭for‬‭that‬
‭region.‬

‭7. Test Before Sharing‬

‭Always test your dashboard before finalizing it.‬

‭●‬ ‭Check on different screen sizes (laptop, projector, etc.).‬
‭●‬ ‭Verify if charts are readable and slicers work correctly.‬
‭●‬ ‭Ask for feedback from others to find improvement areas.‬

‭Tip:‬ ‭A‬ ‭dashboard‬ ‭is‬ ‭successful‬ ‭only‬ ‭when‬ ‭the‬ ‭user‬ ‭understands‬‭it‬‭without‬
‭explanation.‬
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‭Basics of Power BI‬

‭Power‬ ‭BI‬ ‭is‬ ‭a‬ ‭data‬ ‭visualization‬ ‭and‬ ‭business‬ ‭intelligence‬ ‭tool‬ ‭made‬ ‭by‬
‭Microsoft.‬
‭It‬‭helps‬‭you‬‭turn‬‭your‬‭Excel‬‭or‬‭other‬‭data‬‭into‬‭beautiful‬‭charts,‬‭graphs,‬‭and‬
‭dashboards quickly and easily.‬

‭In Short-‬
‭Power BI is an advanced version of Excel dashboards that helps you make‬
‭smart, interactive, and shareable reports using data.‬

‭Power Bi Interface‬

‭When‬ ‭you‬ ‭open‬ ‭Power‬ ‭BI‬ ‭Desktop‬‭,‬ ‭you’ll‬ ‭see‬ ‭a‬ ‭simple‬ ‭workspace‬ ‭where‬
‭you create your reports and dashboards.‬

‭1. Ribbon‬

‭●‬ ‭Located at the top, just like in Excel.‬
‭●‬ ‭Contains tabs like Home, Insert, Modeling, View, and Help.‬
‭●‬ ‭You use it to import data, add visuals, format charts, or publish‬

‭reports.‬

‭Example:‬
‭Click Home → Get Data → Excel to bring your Excel file into Power BI.‬
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‭2. Report View‬

‭●‬ ‭The large white area in the center of the screen.‬
‭●‬ ‭This is where you design your dashboard using charts, visuals, and‬

‭text.‬

‭Think of it like a blank canvas where you design your report.‬

‭3. Page Tabs Area‬

‭●‬ ‭The Page Tabs Area is located at the bottom of the Power BI Desktop‬
‭window.‬

‭●‬ ‭It is used to switch between different report pages in your Power BI‬
‭file.‬

‭●‬ ‭Just like Excel has multiple sheets, Power BI can have multiple report‬
‭pages, and each page can contain different visuals or dashboards.‬

‭●‬ ‭You can rename, duplicate, move, or delete report pages from here.‬

‭4. Visualizations Pane‬

‭●‬ ‭Contains all the chart types and visual tools like bar chart, pie chart,‬
‭card, table, etc.‬

‭●‬ ‭You can also format visuals, change colors, and add titles from here.‬

‭5. Data View and Model View‬

‭On the left side, you’ll see three small icons:‬

‭1.‬ ‭Report View (icon) – where you create visuals.‬
‭2.‬ ‭Data View (icon) – to view your data table (like Excel sheet).‬
‭3.‬ ‭Model View (icon) – to see relationships between tables.‬

‭Example:‬‭If you imported more than one table (like‬‭Sales and Customers),‬
‭you can connect them here.‬

‭What Power BI Does:‬

‭●‬ ‭Connects with Excel files, databases, or online data‬
‭●‬ ‭Helps you clean and organize data‬
‭●‬ ‭Creates interactive dashboards and reports‬
‭●‬ ‭Lets you share those dashboards with others‬
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‭Common Visuals in Power BI:‬

‭●‬ ‭Bar chart‬
‭●‬ ‭Pie chart‬
‭●‬ ‭Line chart‬
‭●‬ ‭Maps‬
‭●‬ ‭Cards (for total values)‬

‭Why Use Power BI:‬

‭●‬ ‭Works just like Excel but more powerful‬
‭●‬ ‭Dashboards look more professional and interactive‬
‭●‬ ‭Updates automatically when your data changes‬
‭●‬ ‭Used widely in companies for reports and analysis‬

‭Activity:‬‭Create Mini Dashboard using Excel Data‬

‭Summary:‬
‭●‬ ‭Data‬‭Analysis‬‭helps‬‭in‬‭understanding‬‭information‬‭by‬‭finding‬‭patterns,‬‭trends,‬‭and‬

‭insights from raw data.‬
‭●‬ ‭Excel‬ ‭tools‬ ‭like‬ ‭importing‬ ‭data,‬ ‭cleaning‬ ‭data,‬ ‭sorting,‬ ‭filtering,‬ ‭and‬ ‭organizing‬

‭datasets make analysis accurate and reliable.‬
‭●‬ ‭Dashboards‬ ‭summarize‬ ‭key‬ ‭information‬ ‭using‬ ‭KPIs,‬‭charts,‬‭slicers,‬‭and‬‭filters‬‭for‬

‭quick decision-making.‬
‭●‬ ‭Different‬ ‭chart‬ ‭types‬ ‭(bar,‬ ‭column,‬ ‭line,‬ ‭pie)‬ ‭help‬ ‭visualize‬ ‭data‬ ‭clearly‬ ‭and‬

‭effectively.‬
‭●‬ ‭Power‬ ‭BI‬‭is‬‭a‬‭powerful‬‭tool‬‭that‬‭creates‬‭interactive,‬‭professional‬‭dashboards‬‭and‬

‭reports for deeper and smarter data analysis.‬
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‭Unit 4: Canva‬

‭Introduction to Canva‬

‭In‬ ‭today’s‬ ‭digital‬ ‭world,‬ ‭visuals‬ ‭are‬ ‭very‬ ‭important.‬ ‭Posters,‬ ‭infographics,‬
‭and images help communicate information quickly and effectively.‬

‭Canva‬ ‭is‬ ‭an‬ ‭online‬ ‭graphic‬ ‭design‬ ‭platform‬ ‭that‬ ‭allows‬ ‭anyone‬ ‭to‬ ‭create‬
‭professional-looking designs easily‬‭, without advanced‬‭technical skills.‬

‭Why use Canva:‬

‭●‬ ‭Easy drag-and-drop interface‬
‭●‬ ‭Millions of templates for social media posts, posters, and infographics‬
‭●‬ ‭Access to free images, icons, charts, and fonts‬
‭●‬ ‭Helps create attractive visuals quickly‬

‭Canva Interface‬

‭When you open Canva, you see:‬

‭●‬ ‭Home / Dashboard:‬‭Access your designs, templates,‬‭and folders‬
‭●‬ ‭Search Bar:‬‭Quickly find templates or elements‬
‭●‬ ‭Create a Design:‬‭Choose a blank canvas or ready-made‬‭template‬
‭●‬ ‭Left‬ ‭Panel:‬ ‭Tabs‬ ‭for‬ ‭Templates,‬ ‭Elements,‬ ‭Text,‬ ‭Uploads,‬ ‭Photos,‬

‭Backgrounds‬
‭●‬ ‭Top‬ ‭Panel:‬ ‭Tools‬ ‭for‬ ‭undo/redo,‬ ‭position,‬ ‭transparency,‬ ‭and‬

‭alignment‬
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‭●‬ ‭Right‬ ‭Panel‬ ‭/‬ ‭Canvas:‬ ‭Where‬ ‭your‬ ‭design‬ ‭appears‬ ‭and‬ ‭edits‬ ‭are‬
‭made‬

‭Using Templates‬

‭Templates‬ ‭are‬ ‭pre-designed‬ ‭layouts‬ ‭that‬ ‭save‬ ‭time‬ ‭and‬ ‭make‬ ‭designs‬
‭professional.‬
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‭How to use:‬

‭1.‬ ‭Click‬‭Templates‬‭→ Search by category (Poster, Infographic)‬
‭2.‬ ‭Click on a template to apply it to your canvas‬
‭3.‬ ‭Replace text, images, and icons with your own content‬
‭4.‬ ‭Adjust colors and layout if needed‬

‭Tip:‬‭Always pick templates suitable for your theme‬‭or message.‬

‭Designing Posters & Infographics‬

‭Posters‬ ‭and‬ ‭infographics‬ ‭are‬ ‭visual‬ ‭representations‬ ‭of‬ ‭information.‬ ‭They‬
‭help:‬

‭●‬ ‭Catch attention‬
‭●‬ ‭Explain ideas simply‬
‭●‬ ‭Convey messages clearly‬

‭Steps to create a design:‬

‭1.‬ ‭Choose the purpose (awareness, education, promotion, etc.)‬
‭2.‬ ‭Decide key message and content‬
‭3.‬ ‭Pick a layout and color scheme‬

‭4.‬ ‭Add images, icons, and text‬
‭5.‬ ‭Arrange elements neatly for clarity‬
‭6.‬ ‭Save or download the final design‬

‭Tip:‬‭Keep it simple, readable, and visually balanced.‬

‭Adding Images & Icons‬

‭Images and icons make your design attractive and informative.‬

‭Steps:‬

‭1.‬ ‭Go to‬‭Elements → Photos / Icons‬
‭2.‬ ‭Search for the image or icon you need‬
‭3.‬ ‭Click to insert → Drag to move → Resize as needed‬
‭4.‬ ‭Adjust layer order using‬‭Position → Forward / Backward‬
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‭Uploads:‬‭You‬‭can‬‭also‬‭upload‬‭your‬‭own‬‭images‬‭(Upload‬‭→‬‭Upload‬‭Media‬‭→‬
‭Select File)‬

‭Text Formatting‬

‭Text conveys the message clearly. Canva allows:‬

‭●‬ ‭Headings, Subheadings, Body Text‬
‭●‬ ‭Change‬‭font style, size, color, spacing, and alignment‬
‭●‬ ‭Apply effects like bold, italics, uppercase, or shadow‬

‭Steps to format:‬

‭1.‬ ‭Click on the text box → Select text‬
‭2.‬ ‭Use top panel to choose font, size, color, and alignment‬
‭3.‬ ‭Adjust spacing using the‬‭Spacing‬‭tool for better readability‬

‭Tip:‬‭Use readable fonts and avoid too many styles‬‭in one design.‬

‭Color Schemes & Layouts‬

‭Colors and layout create visual impact.‬

‭Tips for effective design:‬

‭●‬ ‭Use 2–3 main colors for consistency‬
‭●‬ ‭Ensure contrast between text and background‬
‭●‬ ‭Align elements neatly for balance‬
‭●‬ ‭Keep margins and spacing uniform‬
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‭Steps to apply colors:‬

‭1.‬ ‭Select element or text → Click color option‬
‭2.‬ ‭Choose a color from the palette or enter hex code‬
‭3.‬ ‭For background, click‬‭Background → Choose color or‬‭image‬

‭Activity:‬‭Design a Poster for an Awareness Campaign‬

‭Summary:‬

‭●‬ ‭Canva‬‭is‬‭an‬‭easy‬‭online‬‭tool‬‭used‬‭to‬‭create‬‭posters,‬‭infographics,‬‭and‬‭other‬‭visual‬
‭designs.‬

‭●‬ ‭It‬ ‭provides‬ ‭templates,‬ ‭images,‬ ‭icons,‬ ‭and‬ ‭fonts‬ ‭that‬ ‭help‬ ‭in‬‭making‬‭professional‬
‭designs quickly.‬

‭●‬ ‭Users can customize templates by editing text, colors, images, and layout.‬
‭●‬ ‭Canva‬ ‭tools‬ ‭allow‬ ‭adding‬ ‭images,‬ ‭icons,‬ ‭and‬ ‭formatted‬ ‭text‬ ‭for‬ ‭clear‬ ‭and‬

‭attractive visuals.‬
‭●‬ ‭Good‬ ‭design‬ ‭principles‬ ‭like‬ ‭simple‬ ‭layout,‬ ‭readable‬ ‭fonts,‬ ‭and‬ ‭consistent‬ ‭colors‬

‭make posters effective.‬
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‭Unit 5: Artificial Intelligence‬

‭Introduction to Artificial Intelligence‬

‭Artificial‬ ‭Intelligence,‬ ‭commonly‬ ‭known‬ ‭as‬ ‭AI,‬ ‭is‬ ‭a‬ ‭branch‬ ‭of‬ ‭computer‬
‭science‬ ‭that‬ ‭focuses‬ ‭on‬ ‭creating‬ ‭machines‬ ‭that‬ ‭can‬ ‭perform‬ ‭tasks‬
‭requiring human intelligence.‬
‭It allows computers to think, learn, and make decisions similar to humans.‬

‭In‬‭simple‬‭words,‬‭AI‬‭means‬‭making‬‭machines‬‭smart‬‭enough‬‭to‬‭understand,‬
‭learn, and solve problems on their own.‬

‭According to John McCarthy, who is known as the father of AI:‬

‭“Artificial‬ ‭Intelligence‬ ‭is‬ ‭the‬ ‭science‬ ‭and‬ ‭engineering‬ ‭of‬ ‭making‬
‭intelligent machines, especially intelligent computer programs.”‬

‭Examples of AI in Daily Life‬

‭●‬ ‭Voice assistants like Siri, Alexa, and Google Assistant.‬
‭●‬ ‭Chatbots used on websites for customer service.‬
‭●‬ ‭Google Maps showing real-time traffic updates.‬
‭●‬ ‭Social Media platforms recommending friends, posts, or reels.‬

‭Goals of AI‬

‭The main aim of Artificial Intelligence is to make machines:‬

‭●‬ ‭Learn from experiences.‬
‭●‬ ‭Adapt to new situations.‬
‭●‬ ‭Perform human-like tasks efficiently.‬
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‭History and Evolution of Artificial Intelligence‬

‭The‬ ‭idea‬‭of‬‭machines‬‭that‬‭can‬‭think‬‭is‬‭not‬‭new.‬‭It‬‭has‬‭existed‬‭for‬‭decades,‬
‭even‬ ‭in‬ ‭ancient‬ ‭stories‬ ‭about‬ ‭mechanical‬ ‭men.‬ ‭However,‬ ‭the‬ ‭real‬
‭development‬ ‭of‬ ‭AI‬ ‭began‬ ‭in‬ ‭the‬ ‭20th‬ ‭century‬ ‭with‬ ‭the‬ ‭invention‬ ‭of‬
‭computers.‬

‭Early Developments‬

‭●‬ ‭In‬ ‭1950,‬ ‭British‬ ‭mathematician‬ ‭Alan‬‭Turing‬‭proposed‬‭the‬‭concept‬‭of‬
‭intelligent‬ ‭machines‬ ‭and‬ ‭introduced‬ ‭the‬ ‭Turing‬ ‭Test‬ ‭to‬ ‭check‬ ‭if‬ ‭a‬
‭machine can think like a human.‬

‭●‬ ‭In‬ ‭1956,‬ ‭during‬ ‭the‬ ‭Dartmouth‬ ‭Conference,‬ ‭the‬ ‭term‬ ‭“Artificial‬
‭Intelligence”‬‭was‬‭officially‬‭used‬‭by‬‭John‬‭McCarthy,‬‭marking‬‭the‬‭birth‬
‭of AI as a field of study.‬

‭Growth of AI Over the Years‬

‭Period‬ ‭Development‬

‭1960s–1970s‬ ‭Scientists developed early programs that could solve‬
‭math problems and play games like chess.‬

‭1980s‬ ‭Creation of Expert Systems, capable of making decisions‬
‭like human specialists.‬

‭1990s‬ ‭AI became more practical with speech recognition and‬
‭robotics.‬

‭2000s‬ ‭Growth of Machine Learning, where computers learn‬
‭from data automatically.‬

‭2010–Present‬ ‭AI became a part of everyday life — used in healthcare,‬
‭education, business, and entertainment.‬

‭Important Scientists in AI‬

‭●‬ ‭Alan Turing – Laid the foundation of AI.‬
‭●‬ ‭John McCarthy – Coined the term Artificial Intelligence.‬
‭●‬ ‭Marvin Minsky – Worked on cognitive simulation.‬
‭●‬ ‭Geoffrey Hinton – Known as the “Godfather of Deep Learning.”‬
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‭Types of Artificial Intelligence‬

‭Artificial‬ ‭Intelligence‬ ‭can‬ ‭be‬‭divided‬‭into‬‭two‬‭main‬‭categories‬‭—‬‭based‬‭on‬
‭capabilities and based on functionalities.‬

‭Narrow AI (Weak AI):‬

‭●‬ ‭Performs one specific task only.‬
‭●‬ ‭Cannot perform tasks outside its training.‬
‭●‬ ‭Examples: Voice assistants, email spam filters, Netflix‬

‭recommendations.‬

‭General AI:‬

‭●‬ ‭Can perform any intellectual task like a human being.‬
‭●‬ ‭Can think, reason, and adapt independently.‬
‭●‬ ‭Still under development and research.‬

‭Super AI:‬

‭●‬ ‭Hypothetical AI that surpasses human intelligence.‬
‭●‬ ‭Can think, reason, and create ideas better than humans.‬
‭●‬ ‭Exists only in theory as of now.‬

‭Importance of Artificial Intelligence‬

‭AI‬ ‭plays‬ ‭a‬ ‭crucial‬ ‭role‬ ‭in‬ ‭today’s‬ ‭modern‬ ‭world.‬ ‭It‬ ‭is‬ ‭helping‬ ‭almost‬ ‭every‬
‭sector‬ ‭—‬ ‭from‬ ‭education‬ ‭to‬ ‭medicine‬ ‭—‬ ‭to‬ ‭become‬ ‭more‬ ‭efficient‬ ‭and‬
‭intelligent.‬

‭Automation:‬
‭AI‬ ‭helps‬ ‭in‬ ‭performing‬ ‭repetitive‬ ‭tasks‬ ‭without‬ ‭human‬ ‭help,‬ ‭saving‬ ‭time‬
‭and effort.‬

‭Data Analysis:‬
‭AI‬ ‭can‬ ‭analyze‬ ‭large‬ ‭amounts‬ ‭of‬ ‭data‬ ‭in‬ ‭seconds‬ ‭and‬ ‭provide‬ ‭valuable‬
‭insights.‬

‭Decision Making:‬
‭AI‬‭helps‬‭organizations‬‭make‬‭faster‬‭and‬‭more‬‭accurate‬‭decisions‬‭using‬‭data‬
‭and predictions.‬

‭Healthcare:‬
‭Doctors use AI tools to detect diseases and design better treatments.‬
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‭Education:‬
‭AI‬ ‭helps‬ ‭in‬ ‭personalized‬ ‭learning,‬ ‭where‬ ‭students‬ ‭get‬ ‭lessons‬ ‭based‬ ‭on‬
‭their abilities.‬

‭Accessibility:‬
‭AI‬ ‭provides‬ ‭support‬ ‭to‬ ‭differently-abled‬ ‭individuals‬ ‭—‬ ‭for‬ ‭example,‬
‭speech-to-text and text-to-speech systems.‬

‭Current Applications of Artificial Intelligence‬

‭Artificial‬ ‭Intelligence‬ ‭is‬ ‭now‬ ‭a‬ ‭part‬ ‭of‬ ‭almost‬ ‭every‬ ‭modern‬ ‭digital‬ ‭tool.‬
‭Many‬‭AI‬‭systems‬‭are‬‭used‬‭today‬‭for‬‭communication,‬‭coding,‬‭creativity,‬‭and‬
‭problem-solving.‬
‭Here‬ ‭are‬ ‭some‬ ‭of‬ ‭the‬ ‭most‬ ‭popular‬ ‭and‬ ‭latest‬ ‭AI‬ ‭applications‬‭being‬‭used‬
‭around the world:‬

‭1. ChatGPT (by OpenAI)‬

‭●‬ ‭A powerful AI chatbot that can understand questions, hold‬
‭conversations, and generate text, essays, emails, or even computer‬
‭code.‬

‭●‬ ‭It uses Natural Language Processing (NLP) and Machine Learning to‬
‭respond naturally and intelligently.‬

‭●‬ ‭Used by students, teachers, writers, and developers worldwide.‬

‭2. Google Gemini (by Google DeepMind)‬

‭●‬ ‭Gemini is Google’s most advanced AI model that can process text,‬
‭images, audio, and video together.‬

‭●‬ ‭It powers Google tools like Bard, Docs, and Search with smarter and‬
‭faster results.‬

‭●‬ ‭Used for creative writing, code generation, and data analysis.‬

‭3. DeepSeek (China-based AI model)‬

‭●‬ ‭A highly efficient open-source AI model known for fast processing‬
‭and accurate responses.‬

‭●‬ ‭Used for data analysis, language translation, and chatbot‬
‭development.‬

‭●‬ ‭Competes with GPT-based models in research and business‬
‭solutions.‬
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‭4. Copilot (by Microsoft & GitHub)‬

‭●‬ ‭An AI assistant that helps programmers write code faster.‬
‭●‬ ‭Integrated into Visual Studio and GitHub, it suggests code, fixes‬

‭errors, and completes programs automatically.‬
‭●‬ ‭A great example of AI in software development.‬

‭5. Midjourney (AI Image Generator)‬

‭●‬ ‭An advanced AI tool that creates high-quality images and artworks‬
‭from text descriptions.‬

‭●‬ ‭Artists, designers, and marketers use it for creative projects and‬
‭digital art generation.‬

‭●‬ ‭It uses‬‭Generative AI‬‭to turn imagination into visuals.‬

‭Uses of AI in Day to Day Life‬

‭In Daily Life:‬

‭●‬ ‭Voice assistants like Alexa and Siri.‬
‭●‬ ‭Chatbots for online customer service.‬
‭●‬ ‭Google Maps for navigation.‬
‭●‬ ‭Social media filters and recommendations.‬

‭In Healthcare:‬

‭●‬ ‭AI helps detect diseases through X-rays and reports.‬
‭●‬ ‭Virtual nurses and robots assist in surgeries.‬

‭In Education:‬

‭●‬ ‭Smart‬ ‭learning‬ ‭platforms‬ ‭adjust‬ ‭lessons‬ ‭according‬ ‭to‬ ‭student‬
‭performance.‬

‭In Business:‬

‭●‬ ‭AI‬ ‭predicts‬ ‭customer‬ ‭behavior‬ ‭and‬ ‭helps‬ ‭companies‬ ‭make‬
‭marketing decisions.‬

‭In Finance:‬

‭●‬ ‭AI‬ ‭is‬ ‭used‬ ‭for‬ ‭fraud‬ ‭detection,‬ ‭credit‬ ‭scoring,‬ ‭and‬ ‭stock‬ ‭market‬
‭predictions.‬

‭Shiv Nadar Institution of Eminence‬
‭Deemed to be University‬ ‭68‬‭। page‬



‭In Transportation:‬

‭●‬ ‭Self-driving cars and AI-based traffic management systems.‬

‭Advantages and Disadvantages of AI‬

‭Advantages of AI‬

‭1.‬ ‭Accuracy: AI reduces human errors and provides precise results.‬
‭2.‬ ‭24×7 Availability: Machines don’t need rest or breaks.‬
‭3.‬ ‭High Speed: AI performs complex calculations within seconds.‬
‭4.‬ ‭Works‬ ‭in‬ ‭Risky‬‭Environments:‬‭AI‬‭robots‬‭can‬‭explore‬‭space,‬‭mines,‬‭or‬

‭deep oceans.‬
‭5.‬ ‭Productivity: AI increases efficiency in industries and businesses.‬

‭Disadvantages of AI‬

‭●‬ ‭High Cost: Developing AI systems is expensive.‬
‭●‬ ‭Unemployment: Machines can replace human jobs in some areas.‬
‭●‬ ‭No Emotions: AI cannot understand human feelings or moral values.‬
‭●‬ ‭Over-dependence: Too much reliance on AI can reduce human skills.‬
‭●‬ ‭Privacy Issues: Data used for AI systems can be misused or hacked.‬

‭●‬ ‭Activity:‬‭Use AI tools to make formal applications‬‭in a structured way.‬

‭Summary:‬

‭●‬ ‭Artificial‬‭Intelligence‬‭is‬‭the‬‭technology‬‭that‬‭enables‬‭machines‬‭to‬‭learn,‬‭think,‬‭and‬
‭make decisions like humans.‬

‭●‬ ‭It‬ ‭has‬ ‭grown‬ ‭from‬ ‭early‬ ‭ideas‬ ‭in‬ ‭the‬ ‭1950s‬ ‭to‬ ‭today’s‬ ‭advanced‬ ‭tools‬ ‭used‬ ‭in‬
‭education, business, healthcare, and daily life.‬

‭●‬ ‭AI‬ ‭is‬ ‭used‬ ‭in‬ ‭voice‬ ‭assistants,‬ ‭chatbots,‬ ‭navigation‬‭apps,‬‭recommendations,‬‭and‬
‭many modern applications.‬

‭●‬ ‭There‬ ‭are‬ ‭different‬ ‭types‬ ‭of‬ ‭AI,‬ ‭and‬ ‭each‬ ‭helps‬ ‭in‬ ‭tasks‬ ‭like‬ ‭automation,‬ ‭data‬
‭analysis, and decision-making.‬

‭●‬ ‭AI‬ ‭has‬ ‭many‬ ‭advantages‬ ‭such‬ ‭as‬ ‭accuracy‬ ‭and‬ ‭speed,‬ ‭but‬ ‭also‬ ‭challenges‬ ‭like‬
‭cost, unemployment, and privacy concerns.‬
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‭Unit 6: Cybersecurity‬

‭What is Cybersecurity?‬

‭Cybersecurity‬ ‭refers‬ ‭to‬ ‭the‬ ‭practice‬ ‭of‬ ‭defending‬ ‭computers,‬ ‭mobile‬
‭devices,‬ ‭servers,‬ ‭networks,‬ ‭and‬ ‭data‬ ‭from‬ ‭malicious‬ ‭attacks.‬‭These‬‭attacks‬
‭are‬ ‭often‬ ‭carried‬ ‭out‬ ‭by‬ ‭hackers‬ ‭to‬ ‭steal‬ ‭information,‬‭damage‬‭systems,‬‭or‬
‭gain unauthorized access.‬

‭In‬‭today’s‬‭world,‬‭where‬‭almost‬‭every‬‭task‬‭is‬‭done‬‭online‬‭—‬‭from‬‭banking‬‭to‬
‭education—cybersecurity‬ ‭has‬ ‭become‬ ‭a‬ ‭necessity.‬ ‭Without‬ ‭it,‬ ‭both‬
‭individuals‬ ‭and‬ ‭organizations‬ ‭face‬ ‭serious‬‭risks‬‭like‬‭identity‬‭theft,‬‭financial‬
‭loss, or misuse of personal data.‬

‭Example:‬
‭If‬ ‭a‬ ‭hacker‬ ‭gains‬ ‭access‬ ‭to‬ ‭your‬ ‭email‬ ‭account,‬ ‭they‬ ‭can‬ ‭misuse‬ ‭your‬
‭personal‬‭conversations,‬‭reset‬‭your‬‭banking‬‭passwords,‬‭and‬‭even‬‭scam‬‭your‬
‭contacts. Cybersecurity prevents such situations.‬

‭Shiv Nadar Institution of Eminence‬
‭Deemed to be University‬ ‭70‬‭। page‬



‭Importance of Cybersecurity‬

‭Cybersecurity‬ ‭is‬ ‭important‬ ‭because‬ ‭it‬ ‭protects‬ ‭the‬ ‭Confidentiality,‬
‭Integrity, and Availability (CIA)‬‭of information.‬

‭●‬ ‭Confidentiality‬ ‭→‬ ‭Ensures‬ ‭that‬ ‭sensitive‬ ‭data‬ ‭(like‬ ‭bank‬ ‭details‬ ‭or‬
‭passwords) is accessible only to authorized people.‬

‭●‬ ‭Integrity‬‭→ Keeps data accurate and prevents unauthorized‬‭changes.‬

‭●‬ ‭Availability‬ ‭→‬ ‭Makes‬ ‭sure‬ ‭information‬ ‭and‬ ‭systems‬ ‭are‬ ‭available‬
‭whenever needed.‬

‭Real-life Importance:‬

‭●‬ ‭For‬ ‭Individuals:‬ ‭Protects‬ ‭personal‬ ‭information‬ ‭like‬ ‭photos,‬
‭passwords, and online transactions.‬

‭●‬ ‭For‬ ‭Businesses:‬ ‭Ensures‬ ‭smooth‬ ‭operation‬ ‭of‬ ‭systems,‬ ‭protects‬
‭customer data, and avoids financial loss.‬

‭●‬ ‭For‬ ‭Nations:‬ ‭Safeguards‬ ‭defense,‬ ‭government,‬ ‭and‬ ‭critical‬
‭infrastructure from cyber warfare.‬

‭Safe Browsing Practices‬

‭Safe‬ ‭browsing‬ ‭is‬ ‭about‬ ‭using‬ ‭the‬ ‭internet‬ ‭in‬ ‭a‬ ‭secure‬ ‭manner‬ ‭to‬ ‭avoid‬
‭harmful‬‭websites,‬‭viruses,‬‭or‬‭scams.‬‭It‬‭reduces‬‭the‬‭chances‬‭of‬‭falling‬‭victim‬
‭to fraud or downloading malware.‬

‭Safe Browsing Tips:‬

‭1.‬ ‭Use‬ ‭HTTPS‬ ‭Websites‬ ‭–‬ ‭Websites‬ ‭starting‬ ‭with‬ ‭https:‬‭//‬ ‭are‬ ‭more‬
‭secure than‬‭http:‬‭//.‬

‭2.‬ ‭Do‬ ‭Not‬ ‭Click‬ ‭Unknown‬ ‭Links‬ ‭–‬ ‭Fake‬ ‭links‬ ‭in‬ ‭messages‬ ‭or‬ ‭pop-ups‬
‭may install malware.‬

‭3.‬ ‭Avoid‬ ‭Public‬ ‭Wi-Fi‬ ‭for‬ ‭Banking‬ ‭–‬ ‭Hackers‬ ‭can‬ ‭easily‬ ‭steal‬ ‭data‬ ‭on‬
‭open networks.‬
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‭4.‬ ‭Keep Browser Updated‬‭– Regular updates fix security loopholes.‬

‭5.‬ ‭Install Antivirus & Firewalls‬‭– These act as protective‬‭shields.‬

‭Example:‬
‭If‬‭you‬‭receive‬‭a‬‭link‬‭saying‬‭“Click‬‭here‬‭to‬‭win‬‭a‬‭free‬‭iPhone”‬‭,‬‭it‬‭is‬‭most‬‭likely‬
‭a phishing trap. Safe browsing helps you identify and avoid such scams.‬

‭Strong Passwords & Two-Factor Authentication (2FA)‬

‭A‬ ‭password‬ ‭is‬ ‭like‬ ‭the‬ ‭first‬ ‭lock‬ ‭to‬ ‭your‬ ‭digital‬ ‭accounts.‬ ‭Weak‬ ‭passwords‬
‭are easy for hackers to crack.‬

‭How to Create a Strong Password:‬

‭●‬ ‭Minimum 8–12 characters‬
‭●‬ ‭Mix of uppercase letters, lowercase letters, numbers, and symbols‬
‭●‬ ‭Avoid using names, birthdays, or simple sequences like “123456”‬

‭Two-Factor Authentication (2FA):‬
‭2FA‬‭adds‬‭an‬‭extra‬‭step‬‭of‬‭verification.‬‭For‬‭example,‬‭even‬‭if‬‭someone‬‭knows‬
‭your‬ ‭Gmail‬ ‭password,‬ ‭they‬ ‭cannot‬ ‭log‬ ‭in‬ ‭without‬ ‭the‬ ‭OTP‬ ‭(One-Time‬
‭Password) sent to your phone.‬
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‭Example:‬

‭●‬ ‭Password:‬‭Ravi@2025‬
‭●‬ ‭2FA:‬ ‭OTP‬ ‭sent‬ ‭on‬ ‭phone/email‬ ‭→‬ ‭makes‬ ‭it‬ ‭almost‬ ‭impossible‬ ‭for‬

‭hackers to break in.‬

‭Online Safety‬

‭Online‬ ‭Safety‬ ‭means‬ ‭protecting‬ ‭yourself,‬ ‭your‬ ‭personal‬ ‭data,‬ ‭and‬ ‭your‬
‭digital content while using the internet.‬
‭It‬ ‭includes‬ ‭safe‬ ‭habits,‬ ‭awareness,‬ ‭and‬ ‭responsible‬ ‭use‬ ‭of‬ ‭social‬ ‭media,‬
‭websites, and online tools.‬

‭Importance of Online Safety‬

‭●‬ ‭Protects your personal and financial information‬
‭●‬ ‭Prevents cyberbullying, fraud, and identity theft‬
‭●‬ ‭Builds responsible digital behavior‬
‭●‬ ‭Keeps your devices secure from viruses and malware‬
‭●‬ ‭Promotes safe and respectful communication online‬

‭How to Stay Safe Online (General Protection Tips)‬

‭Be Smart. Be Safe.‬

‭●‬ ‭Use‬‭strong passwords‬‭and change them regularly‬
‭●‬ ‭Don’t share personal information with strangers‬
‭●‬ ‭Use‬‭antivirus software‬‭and keep your device updated‬
‭●‬ ‭Think before you click‬‭— avoid suspicious links‬
‭●‬ ‭Use‬‭two-factor authentication (2FA)‬‭for extra security‬
‭●‬ ‭Keep‬‭backup copies‬‭of important files and photos‬

‭What‬ ‭Should‬‭We‬‭Share‬ ‭and‬‭What‬ ‭Should‬‭We‬‭Avoid‬ ‭Sharing‬
‭on the Internet or Social Media?‬

‭Sharing‬ ‭information‬ ‭on‬ ‭the‬ ‭internet‬ ‭or‬ ‭social‬ ‭media‬ ‭must‬ ‭be‬ ‭done‬
‭thoughtfully,‬ ‭because‬ ‭once‬ ‭something‬ ‭is‬ ‭posted‬ ‭online,‬ ‭it‬ ‭can‬ ‭reach‬
‭thousands‬ ‭of‬ ‭people‬ ‭within‬ ‭seconds.‬ ‭The‬ ‭following‬ ‭guidelines‬ ‭help‬ ‭us‬
‭understand‬ ‭what‬ ‭is‬ ‭safe‬ ‭and‬ ‭appropriate‬ ‭to‬ ‭share‬ ‭—‬ ‭and‬ ‭what‬ ‭we‬ ‭must‬
‭avoid.‬
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‭What We SHOULD Share‬

‭1. Positive and Educational Content‬

‭We‬ ‭should‬ ‭share‬‭information‬‭that‬‭helps,‬‭educates,‬‭or‬‭inspires‬‭others,‬‭such‬
‭as:‬

‭●‬ ‭Study notes, facts, or learning material‬
‭●‬ ‭Motivational quotes or positive messages‬
‭●‬ ‭Useful tips, tutorials, or awareness posts‬

‭2. Your Skills, Creativity, and Achievements‬

‭It is safe and good to share content that represents your talent, such as:‬

‭●‬ ‭Art, craft, music, dance, or photography‬
‭●‬ ‭Sports achievements, certificates, or school activities‬
‭●‬ ‭Personal projects or creative work‬

‭What We SHOULD NOT Share‬

‭1. Personal Information‬

‭Never share private details that can harm your safety, such as:‬

‭●‬ ‭Home address, phone number, or school name‬
‭●‬ ‭Your daily location or travel plans‬
‭●‬ ‭Passwords, OTPs, bank/card details‬

‭2. Sensitive Photos or Videos‬

‭Avoid‬ ‭posting‬ ‭anything‬ ‭that‬ ‭can‬ ‭embarrass‬ ‭you‬ ‭now‬ ‭or‬ ‭in‬ ‭the‬ ‭future,‬
‭including:‬

‭●‬ ‭Personal or family photos in private places‬
‭●‬ ‭Images/videos that can be misused or edited‬
‭●‬ ‭Anything you would not want teachers or parents to see‬
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‭Identifying Phishing, Scam, and Fake News‬

‭In‬ ‭today’s‬ ‭digital‬ ‭world,‬ ‭it‬ ‭is‬ ‭very‬ ‭important‬ ‭to‬ ‭identify‬ ‭phishing,‬ ‭scams,‬
‭and‬‭fake‬‭news‬‭to‬‭stay‬‭safe‬‭online.‬‭These‬‭can‬‭mislead‬‭users,‬‭steal‬‭personal‬
‭information, or spread false information.‬

‭1. Phishing‬

‭●‬ ‭Definition:‬ ‭Phishing‬ ‭is‬ ‭a‬ ‭fraudulent‬ ‭attempt‬ ‭to‬ ‭obtain‬ ‭sensitive‬
‭information,‬ ‭like‬ ‭passwords,‬ ‭credit‬ ‭card‬ ‭numbers,‬ ‭or‬‭bank‬‭details‬‭,‬
‭by pretending to be a trustworthy source.‬

‭●‬ ‭Common Signs:‬

‭○‬ ‭Emails or messages asking for personal information.‬
‭○‬ ‭Suspicious links or attachments.‬
‭○‬ ‭Sense of urgency (e.g., “Your account will be closed!”).‬

‭●‬ ‭How to Avoid:‬

‭○‬ ‭Do not click on unknown links.‬
‭○‬ ‭Verify the sender's email address.‬
‭○‬ ‭Use official websites to login instead of email links.‬

‭2. Scams‬

‭●‬ ‭Definition:‬ ‭A‬ ‭scam‬ ‭is‬ ‭a‬ ‭fraudulent‬ ‭scheme‬ ‭that‬ ‭tricks‬ ‭people‬ ‭into‬
‭giving money, personal information, or other resources.‬

‭●‬ ‭Common Types:‬

‭○‬ ‭Lottery scams (“You have won a prize, send money to claim”).‬
‭○‬ ‭Online shopping scams (fake products, fake sellers).‬
‭○‬ ‭Job scams (fake job offers asking for fees).‬

‭●‬ ‭How to Avoid:‬

‭○‬ ‭Check the authenticity of the source.‬
‭○‬ ‭Do not share personal or financial information.‬
‭○‬ ‭Report suspicious activities.‬
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‭3. Fake News‬

‭●‬ ‭Definition:‬ ‭Fake‬ ‭news‬ ‭is‬‭false‬‭or‬‭misleading‬‭information‬‭presented‬
‭as news‬‭. It can spread quickly online.‬

‭●‬ ‭Common Signs:‬

‭○‬ ‭Sensational or shocking headlines.‬
‭○‬ ‭No credible sources cited.‬
‭○‬ ‭Shared on unreliable websites or social media.‬

‭●‬ ‭How to Avoid:‬

‭○‬ ‭Cross-check information with‬‭reliable sources‬‭.‬
‭○‬ ‭Verify images or videos using fact-check websites.‬
‭○‬ ‭Think critically before sharing information.‬

‭Extra Tips for Students:‬

‭●‬ ‭Always be careful with emails, messages, or social media posts.‬
‭●‬ ‭Install antivirus and security software on devices.‬
‭●‬ ‭Educate friends and family about phishing, scams, and fake news.‬

‭Cybersecurity Threats: Malware, Ransomware, and Phishing‬

‭1.‬ ‭Malware:‬

‭○‬ ‭Malicious software designed to damage or spy on systems.‬
‭○‬ ‭Includes viruses, worms, Trojans, spyware, and adware.‬
‭○‬ ‭Example:‬ ‭A‬ ‭fake‬ ‭game‬ ‭app‬ ‭secretly‬ ‭steals‬ ‭your‬ ‭data‬ ‭once‬

‭installed.‬

‭2.‬ ‭Ransomware:‬

‭○‬ ‭A‬ ‭type‬ ‭of‬ ‭malware‬ ‭that‬ ‭locks‬ ‭your‬ ‭files‬ ‭and‬ ‭demands‬ ‭money‬
‭(ransom) to unlock them.‬

‭○‬ ‭Example:‬‭In‬‭2017,‬‭the‬‭“WannaCry”‬‭ransomware‬‭attack‬‭affected‬
‭thousands of computers worldwide.‬
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‭3.‬ ‭Phishing:‬

‭○‬ ‭Fake‬ ‭emails,‬ ‭SMS,‬ ‭or‬ ‭calls‬ ‭that‬ ‭trick‬ ‭users‬ ‭into‬ ‭giving‬ ‭away‬
‭personal or banking details.‬

‭○‬ ‭Example:‬ ‭A‬ ‭fake‬ ‭email‬‭looking‬‭like‬‭it‬‭is‬‭from‬‭your‬‭bank‬‭asking‬
‭for account details.‬

‭Summary:‬

‭●‬ ‭Cybersecurity‬ ‭protects‬ ‭computers,‬ ‭networks,‬ ‭and‬ ‭data‬ ‭from‬ ‭hackers,‬ ‭theft,‬ ‭and‬
‭online threats.‬

‭●‬ ‭Safe‬ ‭browsing,‬ ‭strong‬ ‭passwords,‬ ‭and‬ ‭two-factor‬ ‭authentication‬ ‭help‬ ‭protect‬
‭personal information.‬

‭●‬ ‭Online‬‭safety‬‭teaches‬‭us‬‭what‬‭to‬‭share‬‭and‬‭what‬‭to‬‭avoid‬‭sharing‬‭on‬‭the‬‭internet‬
‭or social media.‬

‭●‬ ‭Cyber‬ ‭threats‬ ‭like‬ ‭phishing,‬ ‭scams,‬ ‭malware,‬‭and‬‭ransomware‬‭can‬‭steal‬‭data‬‭or‬
‭cause damage, so awareness is important.‬

‭●‬ ‭Staying‬ ‭updated,‬ ‭thinking‬ ‭before‬ ‭clicking,‬ ‭and‬ ‭following‬ ‭safe‬ ‭online‬‭habits‬‭keep‬
‭individuals and organizations secure.‬
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‭Entrepreneurial and Financial Skills‬

‭Unit 7:‬‭Entrepreneurship Development & Basic‬
‭Fundamentals of Business‬

‭What is Entrepreneurship‬

‭Entrepreneurship‬ ‭is‬ ‭the‬ ‭process‬ ‭of‬ ‭starting‬ ‭a‬ ‭new‬ ‭business‬ ‭venture‬ ‭to‬
‭provide‬ ‭products‬ ‭or‬ ‭services‬ ‭and‬ ‭make‬ ‭a‬ ‭profit.‬ ‭It‬ ‭involves‬ ‭identifying‬
‭opportunities,‬ ‭developing‬ ‭ideas,‬ ‭organizing‬ ‭resources,‬ ‭and‬ ‭taking‬ ‭risks‬ ‭to‬
‭create something valuable.‬

‭An‬ ‭entrepreneur‬ ‭is‬ ‭a‬ ‭person‬ ‭who‬ ‭takes‬ ‭the‬ ‭initiative‬ ‭to‬ ‭start‬ ‭a‬ ‭new‬
‭business.‬ ‭Entrepreneurs‬ ‭play‬ ‭a‬ ‭vital‬ ‭role‬ ‭in‬ ‭the‬ ‭economy‬ ‭by‬ ‭generating‬
‭employment,‬ ‭promoting‬ ‭innovation,‬ ‭and‬ ‭contributing‬ ‭to‬ ‭the‬ ‭nation’s‬
‭development.‬

‭Definition‬

‭“Entrepreneurship‬ ‭is‬ ‭the‬ ‭dynamic‬ ‭process‬ ‭of‬ ‭creating‬
‭incremental‬‭wealth‬‭by‬‭individuals‬‭who‬‭assume‬‭the‬‭major‬‭risks‬‭in‬
‭terms of equity, time, and career.”‬

‭Key Characteristics of Entrepreneurship‬

‭1.‬ ‭Innovation: Creating new products, services, or ways of doing‬
‭business.‬
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‭2.‬ ‭Risk-taking: Willingness to take calculated risks to achieve success.‬
‭3.‬ ‭Vision: Having a clear goal and direction for the business.‬
‭4.‬ ‭Decision-making: Making quick and effective business decisions.‬
‭5.‬ ‭Leadership: Guiding a team and motivating others toward a‬

‭common goal.‬
‭6.‬ ‭Goal-oriented: Focused on achieving business objectives efficiently.‬

‭Importance of Entrepreneurship‬

‭●‬ ‭Creates job opportunities.‬
‭●‬ ‭Promotes innovation and technological progress.‬
‭●‬ ‭Encourages economic growth.‬
‭●‬ ‭Improves living standards by offering useful products and services.‬
‭●‬ ‭Supports regional and national development.‬

‭Example‬

‭Entrepreneurs‬ ‭like‬ ‭Ratan‬ ‭Tata,‬ ‭Elon‬ ‭Musk,‬ ‭and‬ ‭Falguni‬ ‭Nayar‬ ‭(Nykaa)‬ ‭are‬
‭examples‬ ‭of‬ ‭individuals‬ ‭who‬ ‭turned‬ ‭innovative‬ ‭ideas‬ ‭into‬ ‭successful‬
‭businesses.‬

‭Entrepreneurial Mindset‬

‭An‬ ‭entrepreneurial‬ ‭mindset‬ ‭means‬ ‭thinking‬ ‭and‬ ‭behaving‬ ‭like‬ ‭an‬
‭entrepreneur.‬
‭It‬ ‭involves‬ ‭creativity,‬ ‭confidence,‬ ‭and‬ ‭the‬ ‭ability‬ ‭to‬ ‭adapt‬ ‭to‬ ‭changing‬
‭situations.‬
‭People‬ ‭with‬ ‭an‬ ‭entrepreneurial‬ ‭mindset‬ ‭see‬ ‭challenges‬ ‭as‬ ‭opportunities‬
‭rather than obstacles.‬

‭Qualities of an Entrepreneurial Mindset‬

‭1.‬ ‭Creativity: Thinking differently and coming up with new ideas.‬
‭2.‬ ‭Risk-taking: Willing to take challenges and calculated risks.‬
‭3.‬ ‭Resilience: The strength to overcome failures and keep trying.‬
‭4.‬ ‭Self-motivation: Staying focused without external pressure.‬
‭5.‬ ‭Adaptability: Adjusting to changes in market or technology.‬
‭6.‬ ‭Vision: Having a long-term goal and clear direction.‬

‭How to Develop an Entrepreneurial Mindset‬

‭●‬ ‭Keep learning new things and observing market trends.‬
‭●‬ ‭Stay confident and open to feedback.‬
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‭●‬ ‭Set clear goals and work consistently.‬
‭●‬ ‭Network with positive and inspiring people.‬
‭●‬ ‭Learn from both success and failure.‬

‭Example‬

‭Entrepreneurs‬ ‭like‬ ‭Steve‬ ‭Jobs‬ ‭and‬ ‭Jeff‬ ‭Bezos‬ ‭succeeded‬ ‭because‬ ‭of‬ ‭their‬
‭strong mindset, creativity, and persistence.‬

‭Business Idea Generation & Planning‬

‭Every successful business starts with a strong idea.‬
‭Business‬ ‭idea‬ ‭generation‬ ‭means‬ ‭discovering‬ ‭opportunities‬ ‭that‬ ‭can‬ ‭be‬
‭turned into a profitable business.‬

‭Sources of Business Ideas‬

‭1.‬ ‭Personal Experience: Turning hobbies or interests into business (e.g.,‬
‭photography, baking).‬

‭2.‬ ‭Market Needs: Identifying problems customers face and providing‬
‭solutions.‬

‭3.‬ ‭Existing Products: Improving current products or adding new‬
‭features.‬

‭4.‬ ‭Observation: Noticing new trends or gaps in the market.‬
‭5.‬ ‭Innovation and Technology: Using technology to create new services.‬

‭Steps in Idea Generation‬

‭1.‬ ‭Identify a problem or need.‬
‭2.‬ ‭Think of possible solutions.‬
‭3.‬ ‭Analyze which idea is most practical and profitable.‬
‭4.‬ ‭Conduct market research to check customer demand.‬
‭5.‬ ‭Select the best idea to implement.‬

‭Business Planning‬

‭Once the idea is selected, the next step is business planning.‬
‭A‬‭business‬‭plan‬‭is‬‭a‬‭written‬‭document‬‭that‬‭explains‬‭how‬‭the‬‭business‬‭will‬

‭work, grow, and make profit.‬

‭Main Components of a Business Plan‬

‭●‬ ‭Executive Summary: Overview of the business.‬
‭●‬ ‭Business Description: Nature, goal, and mission of the business.‬
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‭●‬ ‭Market Analysis: Study of customers and competitors.‬
‭●‬ ‭Organization Structure: Details about team members and‬

‭management.‬
‭●‬ ‭Product/Service Description: What you are offering and its benefits.‬
‭●‬ ‭Marketing Plan: How you will promote and sell the product.‬
‭●‬ ‭Financial Plan: Budget, cost, and profit projections.‬

‭Importance of a Business Plan‬

‭●‬ ‭Helps in setting clear goals.‬
‭●‬ ‭Guides in decision-making.‬
‭●‬ ‭Attracts investors and lenders.‬
‭●‬ ‭Helps measure progress.‬

‭Marketing‬

‭Marketing‬ ‭is‬ ‭the‬ ‭process‬ ‭of‬ ‭promoting‬ ‭and‬ ‭selling‬ ‭products‬ ‭or‬ ‭services.A‬
‭good‬ ‭marketing‬ ‭strategy‬ ‭helps‬ ‭startups‬ ‭reach‬ ‭the‬ ‭right‬ ‭customers‬ ‭and‬
‭build a strong brand.‬

‭Importance of Marketing for Startups‬

‭●‬ ‭Creates brand awareness.‬
‭●‬ ‭Builds trust among customers.‬
‭●‬ ‭Increases sales and growth.‬
‭●‬ ‭Helps startups compete in the market.‬

‭Effective Marketing Strategies‬

‭1.‬ ‭Social Media Marketing:‬
‭Promoting business through platforms like Instagram, Facebook,‬
‭LinkedIn, or YouTube.‬

‭2.‬ ‭Digital Advertising:‬
‭Using paid ads (Google Ads, Facebook Ads) to reach specific‬
‭audiences.‬

‭3.‬ ‭Content Marketing:‬
‭Creating blogs, videos, or infographics to educate and attract‬
‭customers.‬

‭4.‬ ‭Email Marketing:‬
‭Sending promotional or informative emails to customers.‬

‭5.‬ ‭Influencer Marketing:‬
‭Partnering with influencers to promote your brand.‬

‭81‬‭। page‬ ‭Shiv Nadar Institution of Eminence‬
‭Deemed to be University‬



‭6.‬ ‭Referral Programs:‬
‭Giving rewards to customers who refer new clients.‬

‭7.‬ ‭Branding:‬
‭Creating a unique logo, tagline, and identity for your business.‬

‭Example‬

‭Brands‬ ‭like‬ ‭Mamaearth,‬ ‭Zomato,‬ ‭and‬ ‭Boat‬ ‭grew‬ ‭quickly‬ ‭using‬ ‭digital‬
‭marketing and influencer campaigns.‬

‭Funding Source‬

‭Funding means arranging the money required to start and run a business.‬
‭It is one of the most crucial steps for any startup.‬

‭Types of Funding Sources‬

‭1.‬ ‭Personal Savings:‬
‭Using one’s own money to start the business.‬

‭2.‬ ‭Family and Friends:‬
‭Borrowing funds from relatives or close friends.‬

‭3.‬ ‭Bank Loans:‬
‭Getting business loans or credit from banks.‬
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‭4.‬ ‭Angel Investors:‬
‭Individuals who invest money in startups in exchange for ownership‬
‭or equity.‬

‭5.‬ ‭Venture Capitalists:‬
‭Investment firms that fund startups with high growth potential.‬

‭6.‬ ‭Government Schemes:‬
‭The Government of India supports young entrepreneurs, small‬
‭businesses, and startups through various schemes. These schemes‬
‭provide loans, subsidies, training, mentorship, and financial‬
‭assistance so that students and youth can start or expand their‬
‭business.‬

‭Examples:‬

‭1. Startup India‬

‭●‬ ‭What‬‭it‬‭is:‬‭A‬‭major‬‭initiative‬‭by‬‭the‬‭Government‬‭of‬‭India‬‭to‬‭promote‬
‭innovation and entrepreneurship.‬

‭●‬ ‭Benefits:‬
‭○‬ ‭Recognized‬ ‭startups‬ ‭get‬ ‭tax‬ ‭benefits,‬ ‭easy‬ ‭compliance,‬ ‭and‬

‭mentorship support.‬
‭○‬ ‭Access‬ ‭to‬ ‭startup‬ ‭networks,‬ ‭incubators,‬ ‭investors,‬‭and‬‭training‬

‭programs.‬
‭○‬ ‭Helps young entrepreneurs convert their ideas into businesses.‬

‭2. Pradhan Mantri MUDRA Yojana (PMMY)‬

‭●‬ ‭What‬‭it‬‭is:‬‭A‬‭scheme‬‭that‬‭provides‬‭collateral-free‬‭loans‬‭to‬‭small‬‭and‬
‭micro businesses.‬

‭●‬ ‭Loan Categories:‬
‭○‬ ‭Shishu:‬‭Up to ₹50,000‬
‭○‬ ‭Kishor:‬‭₹50,000 to ₹5 lakh‬
‭○‬ ‭Tarun:‬‭₹5 lakh to ₹20 lakh‬

‭●‬ ‭Benefits:‬
‭○‬ ‭Useful‬ ‭for‬ ‭starting‬ ‭small‬ ‭shops,‬ ‭services,‬ ‭tuition‬ ‭centers,‬

‭workshops, or expanding an existing small business.‬
‭○‬ ‭No heavy paperwork and no need for big security or collateral.‬

‭3. PMEGP (Prime Minister Employment Generation Programme)‬

‭●‬ ‭What‬ ‭it‬ ‭is:‬ ‭A‬ ‭credit-linked‬ ‭subsidy‬ ‭scheme‬ ‭that‬ ‭helps‬ ‭new‬
‭entrepreneurs start micro enterprises.‬
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‭●‬ ‭Project Cost Limits:‬
‭○‬ ‭Manufacturing sector:‬‭Up to ₹50 lakh‬
‭○‬ ‭Service sector:‬‭Up to ₹20 lakh‬

‭●‬ ‭Subsidy (Government Contribution):‬
‭○‬ ‭General category:‬

‭■‬ ‭25% in rural areas‬
‭■‬ ‭15% in urban areas‬

‭○‬ ‭Special category (SC/ST/Women/Hill areas):‬
‭■‬ ‭35% in rural areas‬
‭■‬ ‭25% in urban areas‬

‭7.‬ ‭Crowdfunding:‬
‭Raising small amounts of money from a large number of people,‬
‭usually through online platforms.‬

‭Importance of Funding‬

‭●‬ ‭Helps in business setup and product development.‬
‭●‬ ‭Supports marketing and expansion.‬
‭●‬ ‭Encourages innovation and research.‬
‭●‬ ‭Builds investor confidence and credibility.‬

‭Basic of Accounting‬

‭Accounting is called the‬‭language of business‬‭because‬‭it helps record and‬
‭understand all the financial activities of an organization.‬
‭It shows whether the business is making a profit or facing a loss and helps‬
‭in planning future growth.‬

‭Objectives of Accounting‬

‭●‬ ‭To record all business transactions in a systematic manner.‬
‭●‬ ‭To find out the profit or loss of the business.‬
‭●‬ ‭To know the financial position at a particular date.‬
‭●‬ ‭To help management make business decisions.‬
‭●‬ ‭To provide information to investors, banks, and the government.‬

‭Basic Terms in Accounting‬

‭●‬ ‭Assets:‬‭Things owned by the business (like cash, building,‬‭furniture,‬
‭machines).‬

‭●‬ ‭Liabilities:‬‭Amounts owed by the business to others‬‭(like loans,‬
‭creditors).‬

‭●‬ ‭Capital:‬‭The money invested by the owner in the business.‬
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‭●‬ ‭Revenue (Income):‬‭Money earned from selling goods or services.‬
‭●‬ ‭Expenses:‬‭Costs spent to run the business (like rent,‬‭salary,‬

‭electricity).‬

‭Debit and Credit‬

‭In accounting, every transaction has two sides one side is Debit (Dr.) and‬
‭the other side is Credit (Cr.).‬
‭This is based on the Double Entry System of Accounting, which means:‬

‭“For every debit, there is an equal and opposite credit.”‬

‭Example:‬
‭If you buy furniture for ₹5,000 in cash —‬

‭●‬ ‭Furniture (asset) increases →‬‭Debit Furniture A/c‬‭₹5,000‬
‭●‬ ‭Cash decreases →‬‭Credit Cash A/c ₹5,000‬

‭So both sides are equal — one debit, one credit.‬

‭Component  of Accounting‬

‭1.‬ ‭Journal:‬
‭The first book where all transactions are recorded date-wise.‬

‭2.‬ ‭Ledger:‬
‭A book where transactions from the journal are grouped under specific accounts‬
‭(like Cash Account, Sales Account).‬

‭3.‬ ‭Trial Balance:‬
‭A list of all debit and credit balances to check correctness of entries.‬

‭4.‬ ‭Profit & Loss Account:‬
‭A statement showing total income, expenses, and profit or loss.‬

‭5.‬ ‭Balance Sheet:‬
‭A summary showing all assets, liabilities, and capital on a specific date.‬

‭Importance of Accounting for Entrepreneurs‬

‭●‬ ‭Helps in tracking income and expenses.‬
‭●‬ ‭Shows profit or loss clearly.‬
‭●‬ ‭Useful for financial planning and decision-making.‬
‭●‬ ‭Helps when applying for bank loans or government schemes.‬
‭●‬ ‭Builds transparency and trust with investors.‬
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‭Taxes‬

‭Taxes are the mandatory payments that individuals and businesses must‬
‭give to the government to help it run the country and provide public‬
‭services such as roads, schools, hospitals, and security.‬

‭In simple words‬

‭Tax is a part of your income or profit that you pay to the government.‬

‭Purpose of Taxes‬

‭●‬ ‭To generate money for government activities and development.‬
‭●‬ ‭To provide public services like healthcare, education, and‬

‭infrastructure.‬
‭●‬ ‭To reduce the gap between rich and poor through fair contribution.‬
‭●‬ ‭To control inflation and manage the economy.‬

‭Types of Taxes‬

‭Taxes are mainly divided into two types‬

‭1. Direct Tax‬

‭●‬ ‭Tax paid directly by a person or business to the government.‬
‭●‬ ‭It cannot be transferred to anyone else.‬
‭●‬ ‭Example: Income Tax, Corporate Tax, Wealth Tax‬

‭Example:‬
‭If you earn ₹5,00,000 a year, you pay income tax on that income directly to‬
‭the government.‬

‭2. Indirect Tax‬

‭●‬ ‭Tax that is collected by sellers from consumers and later paid to the‬
‭government.‬

‭●‬ ‭It is included in the price of goods and services.‬
‭●‬ ‭Example: GST (Goods and Services Tax), Excise Duty, Customs Duty‬

‭Example:‬
‭When you buy a mobile phone for ₹10,000, GST is already added to the‬
‭price that’s an indirect tax.‬
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‭Goods and Services Tax (GST)‬

‭GST‬‭is the most common indirect tax in India today.‬
‭It replaced many older taxes like VAT, Service Tax, and Excise Duty.‬

‭Full Form:‬‭Goods and Services Tax‬

‭Key Features of GST:‬

‭●‬ ‭One single tax for the whole country.‬
‭●‬ ‭Collected at every stage of production and distribution.‬
‭●‬ ‭Makes the tax system simpler and more transparent.‬

‭Types of GST:‬

‭Type‬ ‭Collected By‬ ‭Used For‬

‭CGST‬‭(Central GST)‬ ‭Central Government‬ ‭On sales within the same state‬

‭SGST‬‭(State GST)‬ ‭State Government‬ ‭On sales within the same state‬

‭IGST‬‭(Integrated‬
‭GST)‬

‭Central Government‬ ‭On sales between different‬
‭states‬

‭Importance of Paying Taxes‬

‭●‬ ‭Helps the government build infrastructure and public facilities.‬
‭●‬ ‭Supports national defense and safety.‬
‭●‬ ‭Encourages economic growth and stability.‬
‭●‬ ‭Creates a responsible and law-abiding business environment.‬
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‭Activity:‬ ‭Group Discussion on Entrepreneurship‬

‭Summary:‬

‭●‬ ‭Entrepreneurship means starting and managing a new business by taking risks,‬
‭using creativity, and solving problems.‬

‭●‬ ‭Entrepreneurs need skills like innovation, leadership, decision-making, and a‬
‭strong entrepreneurial mindset.‬

‭●‬ ‭A good business idea comes from observing needs, trends, and opportunities, and‬
‭is developed through proper planning and market research.‬

‭●‬ ‭Marketing, funding, and a clear business plan help new startups grow, attract‬
‭customers, and manage finances effectively.‬

‭●‬ ‭Basic accounting and taxes are essential for running a business responsibly and‬
‭understanding profit, expenses, assets, and legal requirements.‬
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‭Unit 8: E-commerce & Digital Marketing‬

‭What is E-Commerce‬

‭E-Commerce‬ ‭(Electronic‬ ‭Commerce)‬ ‭refers‬ ‭to‬ ‭the‬ ‭process‬ ‭of‬ ‭buying‬ ‭and‬
‭selling‬‭goods‬‭or‬‭services‬‭over‬‭the‬‭internet.‬‭It‬‭includes‬‭all‬‭business‬‭activities‬
‭that‬ ‭involve‬ ‭an‬ ‭online‬ ‭platform‬ ‭such‬ ‭as‬ ‭websites,‬ ‭apps,‬ ‭or‬ ‭digital‬
‭marketplaces.‬

‭Through‬ ‭E-Commerce,‬ ‭customers‬ ‭can‬ ‭place‬ ‭orders,‬ ‭make‬ ‭payments,‬ ‭and‬
‭get their products delivered to their doorstep all through digital means.‬
‭It‬ ‭connects‬‭buyers‬‭and‬‭sellers‬‭globally‬‭and‬‭removes‬‭the‬‭need‬‭for‬‭physical‬

‭presence.‬

‭Examples:‬‭Amazon,‬‭Flipkart,‬‭Meesho,‬‭Myntra,‬‭Blinkit,‬‭and‬‭JioMart‬‭are‬‭some‬
‭popular E-Commerce platforms.‬

‭Features of E-Commerce‬

‭●‬ ‭Conducted entirely through digital platforms.‬
‭●‬ ‭Operates 24×7, offering convenience to customers.‬
‭●‬ ‭Uses secure electronic payment methods.‬
‭●‬ ‭Reduces business costs by removing middlemen.‬
‭●‬ ‭Reaches a global audience.‬

‭Advantages of E-Commerce‬

‭●‬ ‭Time-saving and convenient for both buyer and seller.‬
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‭●‬ ‭Easy access to a wide range of products.‬
‭●‬ ‭Helps small businesses reach global markets.‬
‭●‬ ‭Reduces paper and manual work.‬

‭Disadvantages of E-Commerce‬

‭●‬ ‭Risk of online fraud or scams.‬
‭●‬ ‭Lack of personal interaction with customers.‬
‭●‬ ‭Requires stable internet connectivity.‬
‭●‬ ‭Heavy competition among online sellers.‬

‭Traditional Business Trend vs Non-Traditional Business Trend‬

‭In‬ ‭the‬ ‭past,‬ ‭business‬ ‭activities‬ ‭were‬ ‭limited‬ ‭to‬ ‭physical‬ ‭stores,‬ ‭manual‬
‭billing,‬ ‭and‬ ‭face-to-face‬ ‭interactions.‬ ‭This‬ ‭was‬ ‭known‬ ‭as‬ ‭the‬ ‭traditional‬
‭business trend.‬
‭With‬ ‭technological‬ ‭advancements,‬ ‭the‬ ‭non-traditional‬ ‭(modern)‬ ‭business‬
‭trend‬ ‭emerged,‬ ‭which‬ ‭depends‬ ‭on‬ ‭the‬ ‭internet,‬ ‭online‬ ‭transactions,‬ ‭and‬
‭digital communication.‬

‭The‬ ‭following‬ ‭table‬ ‭shows‬ ‭the‬ ‭clear‬ ‭differences‬ ‭between‬ ‭traditional‬ ‭and‬
‭non-traditional business trends:‬

‭Basis‬ ‭of‬
‭Comparison‬

‭Traditional Business‬ ‭Non-Traditional‬ ‭(Modern)‬
‭Business‬

‭Nature‬ ‭of‬
‭Business‬

‭Conducted‬ ‭through‬
‭physical‬ ‭stores‬ ‭and‬
‭offices.‬

‭Conducted‬ ‭through‬ ‭online‬
‭websites,‬ ‭mobile‬ ‭apps,‬ ‭and‬
‭e-platforms.‬

‭Customer‬
‭Reach‬

‭Limited‬ ‭to‬ ‭local‬ ‭or‬
‭regional markets.‬

‭Global‬ ‭reach‬ ‭—‬ ‭customers‬
‭from anywhere.‬

‭Working Hours‬ ‭Operates‬ ‭only‬ ‭during‬
‭fixed business hours.‬

‭Operates‬ ‭24×7,‬ ‭all‬ ‭days‬ ‭of‬ ‭the‬
‭week.‬

‭Communication‬ ‭Direct‬ ‭and‬
‭face-to-face.‬

‭Digital‬ ‭—‬ ‭through‬ ‭email,‬ ‭chat,‬
‭or social media.‬

‭Transaction‬
‭Mode‬

‭Cash‬ ‭or‬ ‭cheque‬
‭payments.‬

‭Digital‬ ‭payments‬ ‭via‬ ‭UPI,‬
‭cards, or net banking.‬
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‭Promotion‬
‭Methods‬

‭Newspaper,‬ ‭posters,‬
‭TV,‬ ‭and‬
‭word-of-mouth.‬

‭Online‬ ‭ads,‬ ‭SEO,‬ ‭and‬ ‭social‬
‭media promotions.‬

‭Record Keeping‬ ‭Manual‬ ‭records‬ ‭and‬
‭paper files.‬

‭Digital‬ ‭databases‬ ‭and‬ ‭cloud‬
‭storage.‬

‭Operating Cost‬ ‭High‬ ‭cost‬‭due‬‭to‬‭rent‬
‭and staff.‬

‭Lower‬ ‭cost‬ ‭due‬ ‭to‬ ‭automation‬
‭and online systems.‬

‭Examples‬ ‭Local‬ ‭shops‬ ‭and‬
‭small traders.‬

‭Amazon,‬ ‭Flipkart,‬ ‭Meesho,‬
‭online startups.‬

‭Basics of Online Business‬

‭An‬ ‭Online‬ ‭Business‬ ‭is‬ ‭any‬ ‭business‬ ‭that‬ ‭operates‬ ‭primarily‬ ‭through‬ ‭the‬
‭internet.‬ ‭It‬ ‭includes‬ ‭selling‬ ‭products‬ ‭or‬ ‭services,‬ ‭handling‬ ‭customers,‬ ‭and‬
‭making transactions through online platforms.‬

‭Starting‬‭an‬‭online‬‭business‬‭is‬‭easier‬‭and‬‭cheaper‬‭than‬‭starting‬‭a‬‭traditional‬
‭one.‬ ‭The‬ ‭entrepreneur‬ ‭can‬‭work‬‭from‬‭home‬‭or‬‭anywhere‬‭with‬‭an‬‭internet‬
‭connection.‬

‭Steps to Start an Online Business‬

‭1.‬ ‭Select a Business Idea:‬‭Choose what product or service‬‭to sell.‬
‭2.‬ ‭Market Research:‬‭Study competitors and customer demand.‬
‭3.‬ ‭Create‬ ‭a‬ ‭Website‬ ‭or‬ ‭Online‬ ‭Store:‬ ‭Use‬ ‭platforms‬ ‭like‬ ‭Shopify,‬

‭Amazon, or Meesho.‬
‭4.‬ ‭Register the Business:‬‭Get GST and other legal registrations.‬
‭5.‬ ‭Add‬‭Payment‬‭Options:‬‭Use‬‭secure‬‭payment‬‭gateways‬‭like‬‭Razorpay,‬

‭Paytm, or Google Pay.‬
‭6.‬ ‭Marketing:‬‭Use social media and ads to reach customers.‬
‭7.‬ ‭Customer‬ ‭Support:‬ ‭Offer‬ ‭fast‬ ‭service‬ ‭through‬ ‭chat,‬ ‭calls,‬ ‭or‬

‭WhatsApp.‬

‭Benefits of Online Business‬

‭●‬ ‭Lower investment cost.‬
‭●‬ ‭Access to a global market.‬
‭●‬ ‭Flexibility to operate anytime, anywhere.‬
‭●‬ ‭Easy to track orders and customer behavior.‬
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‭Use of Social Media for Business‬

‭Social‬‭media‬‭has‬‭become‬‭a‬‭key‬‭element‬‭of‬‭modern‬‭business.‬‭Platforms‬‭like‬
‭Facebook,‬ ‭Instagram,‬ ‭LinkedIn,‬ ‭YouTube,‬ ‭and‬ ‭WhatsApp‬ ‭Business‬ ‭help‬
‭companies‬ ‭promote‬ ‭their‬ ‭products‬ ‭and‬ ‭communicate‬ ‭directly‬ ‭with‬
‭customers.‬

‭Businesses‬ ‭use‬ ‭social‬ ‭media‬ ‭for‬ ‭advertising,‬ ‭feedback,‬ ‭customer‬ ‭support,‬
‭and branding. It helps build relationships and increases visibility.‬

‭Example:‬
‭A‬ ‭clothing‬ ‭brand‬ ‭can‬ ‭use‬ ‭Instagram‬ ‭to‬ ‭post‬‭pictures‬‭of‬‭new‬‭designs,‬‭run‬

‭ad campaigns, and chat directly with buyers through DMs.‬

‭Benefits of Using Social Media‬

‭●‬ ‭Increases brand awareness.‬
‭●‬ ‭Builds trust through direct engagement.‬
‭●‬ ‭Easy to share information about products.‬
‭●‬ ‭Cost-effective promotion compared to traditional ads.‬
‭●‬ ‭Instant customer feedback and interaction.‬

‭Popular Platforms and Their Use:‬

‭Platform‬ ‭Use in Business‬

‭Facebook‬ ‭Pages,‬ ‭paid‬ ‭ads,‬ ‭and‬ ‭groups‬ ‭for‬ ‭business‬
‭promotion.‬

‭Instagram‬ ‭Product‬ ‭display,‬ ‭influencer‬‭marketing,‬‭reels,‬‭and‬
‭ads.‬

‭LinkedIn‬ ‭Professional‬ ‭networking‬ ‭and‬
‭business-to-business marketing.‬

‭YouTube‬ ‭Video‬ ‭tutorials,‬ ‭product‬ ‭demos,‬ ‭and‬
‭advertisements.‬

‭WhatsApp‬
‭Business‬

‭Direct‬ ‭messaging,‬ ‭order‬ ‭updates,‬ ‭and‬ ‭quick‬
‭support.‬
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‭Social Media Marketing‬

‭Social‬ ‭Media‬ ‭Marketing‬ ‭(SMM)‬ ‭is‬ ‭the‬ ‭process‬ ‭of‬ ‭using‬ ‭social‬ ‭media‬
‭platforms‬ ‭to‬ ‭promote‬‭a‬‭business,‬‭product,‬‭or‬‭service.‬‭It‬‭is‬‭an‬‭essential‬‭part‬
‭of‬ ‭digital‬ ‭marketing‬‭and‬‭helps‬‭in‬‭building‬‭brand‬‭reputation‬‭and‬‭customer‬
‭loyalty.‬

‭Main Activities in Social Media Marketing‬

‭1.‬ ‭Creating‬‭and‬‭Posting‬‭Content:‬‭Regular‬‭updates,‬‭photos,‬‭videos,‬‭and‬
‭stories.‬

‭2.‬ ‭Paid Advertising:‬‭Running targeted ads to specific‬‭audiences.‬
‭3.‬ ‭Influencer‬ ‭Collaborations:‬ ‭Partnering‬ ‭with‬ ‭influencers‬ ‭for‬

‭promotion.‬
‭4.‬ ‭Customer Interaction:‬‭Responding to comments and messages.‬
‭5.‬ ‭Analyzing‬ ‭Performance:‬ ‭Tracking‬ ‭engagement,‬ ‭reach,‬ ‭and‬ ‭sales‬

‭results.‬

‭Advantages of Social Media Marketing‬

‭●‬ ‭Low cost compared to traditional advertising.‬
‭●‬ ‭Wider audience reach.‬
‭●‬ ‭Builds trust through real-time interaction.‬
‭●‬ ‭Easy to measure performance through analytics.‬
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‭●‬ ‭Boosts brand loyalty and visibility.‬

‭Example:‬
‭Brands‬ ‭like‬ ‭Boat‬‭,‬ ‭Mamaearth‬‭,‬‭and‬‭Lenskart‬‭used‬‭social‬‭media‬‭marketing‬
‭effectively to connect with young audiences and grow rapidly.‬

‭Online Business Development‬

‭Online‬ ‭business‬ ‭development‬ ‭refers‬ ‭to‬ ‭the‬ ‭continuous‬ ‭process‬ ‭of‬
‭expanding‬ ‭and‬ ‭improving‬ ‭a‬ ‭business’s‬ ‭presence‬ ‭on‬ ‭digital‬ ‭platforms.‬ ‭It‬
‭focuses on improving sales, customer satisfaction, and brand reputation.‬

‭Key Steps in Online Business Development‬

‭1.‬ ‭Market Research:‬‭Understanding target audience and‬‭competitors.‬
‭2.‬ ‭Website‬ ‭Optimization:‬‭Ensuring‬‭the‬‭site‬‭is‬‭user-friendly‬‭and‬‭mobile‬

‭compatible.‬
‭3.‬ ‭SEO‬ ‭(Search‬ ‭Engine‬ ‭Optimization):‬ ‭Improving‬ ‭visibility‬ ‭on‬ ‭Google‬

‭and other search engines.‬
‭4.‬ ‭Content Creation:‬‭Regular blogs, videos, and social‬‭media updates.‬
‭5.‬ ‭Email Marketing:‬‭Sending offers and newsletters to‬‭customers.‬
‭6.‬ ‭Customer‬ ‭Relationship‬ ‭Management‬ ‭(CRM):‬ ‭Maintaining‬ ‭good‬

‭relationships through support and communication.‬
‭7.‬ ‭Online‬ ‭Reputation‬ ‭Management:‬ ‭Handling‬ ‭reviews‬ ‭and‬ ‭feedback‬

‭positively.‬

‭Importance of Online Business Development‬

‭●‬ ‭Increases brand visibility and reach.‬
‭●‬ ‭Builds long-term customer trust.‬
‭●‬ ‭Enhances competitiveness.‬
‭●‬ ‭Leads to sustainable business growth.‬

‭Summary:‬

‭●‬ ‭E-commerce involves buying and selling products online, offering 24×7 access,‬
‭global reach, and convenient digital payments.‬

‭●‬ ‭Modern (non-traditional) business works through websites, apps, and online‬
‭platforms, unlike traditional physical shops.‬

‭●‬ ‭Online businesses use websites, marketplaces, and secure payment gateways to‬
‭sell products or services easily and at low cost.‬

‭●‬ ‭Social media helps businesses promote products, engage with customers, and‬
‭build brand awareness through posts, ads, and influencers.‬

‭●‬ ‭Digital marketing activities like content creation, SEO, ads, and customer‬

‭communication support online business growth and visibility.‬
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‭Unit 9: Financial Literacy & Investment‬

‭Financial Literacy‬

‭Financial‬ ‭Literacy‬ ‭is‬ ‭the‬ ‭knowledge‬ ‭and‬ ‭skills‬ ‭to‬ ‭make‬ ‭informed‬ ‭and‬
‭effective‬ ‭decisions‬ ‭about‬ ‭money.‬ ‭It‬ ‭includes‬ ‭budgeting,‬ ‭saving,‬ ‭investing,‬
‭and planning for short-term and long-term goals.‬

‭Importance‬

‭●‬ ‭Helps make smart financial decisions‬

‭●‬ ‭Prepares for emergencies‬

‭●‬ ‭Reduces debt risks‬

‭●‬ ‭Builds financial independence‬

‭●‬ ‭Encourages responsible spending habits‬

‭Usage in Daily Life‬

‭●‬ ‭Planning monthly allowances‬

‭●‬ ‭Saving for short-term goals (gadgets, trips)‬

‭●‬ ‭Investing in long-term instruments (mutual funds, stocks)‬

‭●‬ ‭Comparing prices before purchases‬

‭Example‬

‭A‬‭student‬‭tracks‬‭weekly‬‭pocket‬‭money,‬‭saves‬‭₹1,000‬‭for‬‭future‬‭investment,‬
‭and spends ₹2,000 responsibly on entertainment and essentials.‬
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‭What is Money?‬
‭Money is anything people widely accept in exchange for goods and‬
‭services. It works because everyone trusts its value.‬

‭Key functions:‬

‭1.‬ ‭Medium of exchange‬‭– you trade money for things.‬
‭2.‬ ‭Unit of account‬‭– prices are written in rupees, dollars,‬‭etc.‬
‭3.‬ ‭Store of value‬‭– you can keep it and use it later.‬

‭Types of Money Today‬

‭1.‬ ‭Cash‬‭– coins & paper notes.‬
‭2.‬ ‭Cards‬ ‭–‬ ‭Debit‬ ‭card‬ ‭(spend‬ ‭your‬ ‭bank‬ ‭balance),‬‭Credit‬‭card‬‭(borrow‬

‭up to a limit).‬
‭3.‬ ‭Digital‬ ‭Payments‬ ‭–‬ ‭UPI‬ ‭apps‬ ‭(Ponape,‬ ‭G‬ ‭Pay),‬ ‭mobile‬ ‭wallets‬

‭(Paytm),‬ ‭net-banking,‬ ‭QR‬ ‭codes,‬ ‭NFC‬ ‭tap-to-pay,‬ ‭even‬
‭cryptocurrencies.‬

‭Needs vs Wants‬

‭●‬ ‭Needs‬ ‭=‬ ‭must-haves‬ ‭for‬ ‭survival‬ ‭or‬ ‭basic‬ ‭well-being‬ ‭(food,‬ ‭water,‬
‭shelter, basic clothes, medicine, school fees).‬

‭●‬ ‭Wants‬ ‭=‬‭nice-to-haves‬‭that‬‭make‬‭life‬‭fun‬‭or‬‭stylish‬‭(gaming‬‭console,‬
‭branded shoes, fancy vacation).‬
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‭Rule of thumb:‬‭Cover needs first, then decide how‬‭much of your leftover‬
‭money can go to wants.‬

‭What is a Budget?‬
‭A‬‭budget‬‭is‬‭a‬‭written‬‭plan‬‭that‬‭shows‬‭the‬ ‭estimated‬‭income‬‭and‬ ‭planned‬
‭spending  over a specific period of time (Such as month , Quarterly).‬

‭1.‬ ‭See exactly where your money goes.‬
‭2.‬ ‭Avoid overspending.‬
‭3.‬ ‭Save for goals (new laptop, college, emergency fund).‬
‭4.‬ ‭Prepare for surprises‬
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‭Example – Student Budget Chart‬

‭Pocket Money = ₹1000‬
‭Items‬ ‭How Much (₹)‬
‭Food & Snacks‬ ‭300‬
‭Transport‬ ‭150‬
‭Mobile Recharge‬ ‭100‬
‭School Supplies‬ ‭200‬
‭Entertainment (movies,games)‬ ‭100‬
‭Savings‬ ‭150‬
‭Total‬ ‭₹1000‬

‭Simple 50-30-20 Budget Rule for students‬
‭●‬ ‭50 % Needs‬
‭●‬ ‭30 % Wants‬
‭●‬ ‭20 % Savings & Investments‬

‭What is Expense?‬
‭An‬‭expense‬‭is‬‭the‬‭money‬‭you‬‭spend‬‭to‬‭buy‬‭goods‬‭or‬‭services.‬‭Money‬‭you‬
‭pay‬‭for something like food, clothes, school fees,‬‭travel, etc.‬
‭Types of Expenses:‬

‭Type‬ ‭Example‬
‭Essential (Needs)‬ ‭Food, rent, medicine, school fees‬

‭Non-essential (Wants)‬ ‭Movies, video games, snacks outside‬

‭Tracking‬‭of‬‭Expenses?‬
‭Tracking‬‭expenses‬‭means‬‭writing‬‭down‬‭every‬‭time‬‭you‬‭spend‬‭money‬‭—‬
‭so you can see where your money is going.‬
‭Example Table:‬

‭Total Spending :170‬
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‭What is a Bank?‬
‭A‬ ‭bank‬ ‭is‬ ‭a‬ ‭financial‬ ‭institution‬ ‭that‬ ‭helps‬ ‭people‬ ‭save‬ ‭money,‬ ‭borrow‬
‭money,‬‭and‬‭manage‬‭their‬‭finances.‬‭It‬‭acts‬‭as‬‭a‬‭safe‬‭place‬‭to‬‭deposit‬‭money‬
‭and‬ ‭provides‬ ‭various‬ ‭financial‬ ‭services‬ ‭like‬ ‭loans,‬ ‭credit‬ ‭cards,‬ ‭and‬ ‭online‬
‭payments.‬

‭Banking Products & Services‬

‭Banking‬ ‭products‬ ‭are‬ ‭tools‬ ‭provided‬ ‭by‬ ‭banks‬ ‭to‬ ‭manage‬ ‭money‬ ‭safely,‬
‭make transactions, and earn interest.‬

‭Types of Bank Accounts & Services‬

‭Product/Service‬ ‭Use‬ ‭Example‬
‭Savings Account‬ ‭Safe money storage + earn interest‬ ‭Saving‬ ‭money‬ ‭for‬

‭future‬ ‭needs‬ ‭or‬
‭emergency funds‬

‭Current Account‬ ‭Frequent transactions for business‬ ‭Daily‬ ‭transactions‬‭for‬‭a‬
‭shop or online seller‬

‭Fixed‬ ‭Deposit‬
‭(FD)‬

‭Locked funds earn higher interest‬ ‭Investing‬ ‭₹20,000‬ ‭for‬ ‭1‬
‭year‬ ‭to‬ ‭earn‬ ‭higher‬
‭returns‬

‭Recurring‬
‭Deposit (RD)‬

‭Save small amounts monthly‬ ‭Depositing‬ ‭₹1,000‬
‭every‬ ‭month‬ ‭for‬ ‭1‬ ‭year‬
‭to build savings‬

‭Debit/Credit‬
‭Cards‬

‭Cashless transactions‬ ‭Paying‬ ‭for‬ ‭groceries,‬
‭fuel,‬ ‭or‬ ‭online‬
‭shopping‬

‭Loans‬ ‭Borrow‬ ‭money‬ ‭for‬ ‭education,‬
‭personal or business‬

‭Education‬ ‭loan‬ ‭for‬
‭higher‬ ‭studies‬ ‭or‬ ‭a‬
‭bike loan‬
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‭Tips for Using Bank Services‬

‭●‬ ‭Always check minimum balance requirements‬

‭●‬ ‭Set alerts for debit/credit transactions‬

‭●‬ ‭Use net banking for secure transfers‬
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‭Investments: Mutual Funds, Stock Market & Cryptocurrencies‬

‭Investment Definition:‬

‭Investment means putting money in assets to earn returns over time.‬

‭Mutual Funds‬

‭Definition:‬ ‭Pool‬ ‭of‬‭money‬‭from‬‭many‬‭investors‬‭managed‬‭by‬‭professionals‬
‭and invested in stocks, bonds, or other instruments.‬

‭Types:‬

‭●‬ ‭Equity Funds:‬‭Invest mostly in stocks‬

‭●‬ ‭Debt Funds:‬‭Invest in bonds and fixed-income securities‬

‭●‬ ‭Hybrid Funds:‬‭Combination of equity and debt‬

‭Advantages:‬

‭●‬ ‭Reduces risk through diversification‬

‭●‬ ‭Professionally managed‬

‭●‬ ‭Small investors can participate‬

‭Disadvantages:‬

‭●‬ ‭Subject to market risk‬

‭●‬ ‭Management fees may reduce returns‬

‭Example:‬‭A student invests ₹5,000 in a balanced mutual‬‭fund for 3 years.‬
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‭Stock Market:‬

‭Definition:‬‭Platform to buy/sell shares of publicly‬‭listed companies.‬

‭Importance:‬

‭●‬ ‭Grow wealth through dividends and capital gains‬

‭●‬ ‭Learn about business and economics‬

‭Pros:‬‭High returns, ownership in companies‬
‭Cons:‬‭High risk, requires research and monitoring‬

‭Example:‬‭A‬‭student‬‭buys‬‭10‬‭shares‬‭of‬‭a‬‭tech‬‭company,‬‭monitors‬‭prices,‬‭and‬
‭calculates gains.‬

‭Cryptocurrencies:‬

‭Definition:‬ ‭Digital‬ ‭currencies‬ ‭using‬ ‭cryptography‬ ‭for‬ ‭security;‬ ‭not‬
‭regulated by central banks.‬

‭Pros:‬‭Potential high returns, decentralized‬
‭Cons:‬‭Highly volatile, limited acceptance‬

‭Example:‬‭A student invests ₹2,000 in Bitcoin to learn‬‭market behavior.‬
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‭Risk vs Return Table‬

‭Investment Type‬ ‭Risk‬ ‭Return‬
‭Fixed Deposit‬ ‭Low‬ ‭Low‬
‭Mutual Fund‬ ‭Moderate‬ ‭Moderate‬
‭Stock Market‬ ‭High‬ ‭High‬
‭Cryptocurrency‬ ‭Very High‬ ‭Very High‬

‭Long-Term Wealth Building‬

‭Creating‬ ‭financial‬ ‭stability‬ ‭and‬ ‭growth‬ ‭through‬ ‭consistent‬ ‭saving‬ ‭and‬
‭investing over time.‬

‭Importance:‬
‭●‬ ‭Financial independence‬

‭●‬ ‭Prepare for life goals (education, home, retirement)‬

‭●‬ ‭Reduce reliance on loans‬

‭Ways to Build Wealth:‬
‭1.‬ ‭Save early and regularly‬

‭2.‬ ‭Invest in mutual funds, stocks, retirement schemes‬

‭3.‬ ‭Reinvest returns for compounding benefits‬

‭4.‬ ‭Maintain an emergency fund‬

‭Example:‬ ‭A‬ ‭student‬ ‭invests‬ ‭₹500‬ ‭monthly‬ ‭in‬ ‭mutual‬ ‭funds‬ ‭and‬ ‭RD‬ ‭from‬
‭age 16 to build a corpus by age 25.‬
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‭Summary:‬

‭●‬ ‭Financial‬ ‭literacy‬ ‭helps‬ ‭in‬ ‭making‬ ‭smart‬ ‭decisions‬ ‭about‬ ‭earning,‬ ‭saving,‬
‭spending, and investing money.‬

‭●‬ ‭Understanding‬‭needs‬‭vs‬‭wants,‬‭budgeting,‬‭and‬‭tracking‬‭expenses‬‭helps‬‭manage‬
‭money wisely.‬

‭●‬ ‭Banks‬‭provide‬‭essential‬‭services‬‭like‬‭savings‬‭accounts,‬‭FDs,‬‭RDs,‬‭cards,‬‭and‬‭loans‬
‭to keep money safe and support financial plans.‬

‭●‬ ‭Investments‬ ‭such‬ ‭as‬ ‭mutual‬ ‭funds,‬ ‭stocks,‬ ‭and‬ ‭cryptocurrencies‬ ‭offer‬ ‭ways‬ ‭to‬
‭grow wealth but come with different levels of risk and return.‬

‭●‬ ‭Long-term‬‭wealth‬‭building‬‭requires‬‭regular‬‭saving,‬‭smart‬‭investing,‬‭and‬‭planning‬
‭for future goals.‬
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‭Communication and Presentation Skills‬

‭Unit 10:‬‭Communication & Public Speaking‬

‭Introduction‬

‭In‬‭today’s‬‭world,‬‭communication‬‭plays‬‭a‬‭vital‬‭role‬‭in‬‭every‬‭field‬‭—‬‭whether‬
‭it is education, business, or employment.‬
‭Good‬ ‭communication‬ ‭skills‬ ‭help‬ ‭us‬ ‭express‬ ‭our‬ ‭ideas‬ ‭clearly,‬ ‭understand‬
‭others effectively, and build strong relationships.‬

‭When‬ ‭we‬ ‭enter‬ ‭the‬ ‭professional‬ ‭world,‬ ‭it‬ ‭becomes‬ ‭important‬ ‭to‬
‭communicate‬ ‭confidently‬ ‭and‬ ‭respectfully‬‭,‬ ‭whether‬ ‭through‬ ‭speaking,‬
‭writing, or even body language.‬
‭This‬ ‭unit‬ ‭will‬ ‭help‬ ‭students‬ ‭learn‬ ‭about‬ ‭verbal‬ ‭and‬ ‭non-verbal‬
‭communication,‬ ‭writing‬ ‭an‬ ‭effective‬ ‭resume,‬ ‭and‬ ‭developing‬ ‭interview‬
‭and group discussion skills.‬

‭Verbal Communication‬
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‭Verbal‬ ‭communication‬ ‭means‬ ‭expressing‬ ‭thoughts‬ ‭and‬ ‭ideas‬ ‭using‬
‭spoken or written words‬‭.‬
‭It is the most common form of communication used in day-to-day life.‬

‭Types of Verbal Communication‬

‭1.‬ ‭Oral Communication:‬
‭Includes‬ ‭face-to-face‬ ‭conversations,‬ ‭meetings,‬ ‭presentations,‬ ‭group‬
‭discussions, and telephone calls.‬

‭○‬ ‭Example:‬ ‭Talking‬ ‭to‬ ‭a‬ ‭teacher,‬ ‭giving‬ ‭a‬ ‭speech,‬ ‭or‬ ‭answering‬
‭questions in an interview.‬

‭2.‬ ‭Written Communication:‬
‭Involves writing letters, emails, reports, and resumes.‬

‭○‬ ‭Example: Sending a professional email to apply for a job.‬

‭Qualities of Good Verbal Communication‬

‭●‬ ‭Speak clearly and confidently.‬
‭●‬ ‭Use polite and respectful language.‬
‭●‬ ‭Listen carefully before responding.‬
‭●‬ ‭Avoid slang or informal words in professional situations.‬
‭●‬ ‭Maintain a positive tone and attitude.‬

‭Non-Verbal Communication‬
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‭Non-verbal‬ ‭communication‬ ‭means‬ ‭expressing‬ ‭messages‬ ‭without‬ ‭using‬
‭words‬‭.‬
‭It includes gestures, facial expressions, posture, and eye contact.‬

‭In‬ ‭professional‬ ‭situations,‬ ‭non-verbal‬ ‭communication‬ ‭is‬ ‭as‬ ‭important‬ ‭as‬
‭words‬‭—‬‭because‬‭your‬‭body‬‭language‬‭often‬‭speaks‬‭louder‬‭than‬‭what‬‭you‬
‭say.‬

‭Types of Non-Verbal Communication‬

‭1.‬ ‭Gestures:‬
‭Movements of hands or arms that support verbal communication.‬
‭Example: Nodding your head to show agreement.‬

‭2.‬ ‭Facial Expressions:‬
‭The‬ ‭look‬ ‭on‬ ‭your‬ ‭face‬ ‭conveys‬ ‭emotions‬ ‭like‬‭happiness,‬‭confidence,‬
‭or concern.‬

‭3.‬ ‭Eye Contact:‬
‭Maintaining‬ ‭eye‬ ‭contact‬ ‭shows‬ ‭attentiveness‬ ‭and‬ ‭honesty.‬ ‭Avoid‬
‭staring or looking away too often.‬

‭4.‬ ‭Posture:‬
‭Sit‬ ‭or‬ ‭stand‬‭straight‬‭to‬‭show‬‭confidence‬‭and‬‭interest.‬‭Avoid‬‭crossing‬
‭arms or slouching.‬

‭5.‬ ‭Appearance:‬
‭Dress‬ ‭neatly‬ ‭and‬ ‭appropriately‬ ‭for‬‭formal‬‭settings.‬‭It‬‭gives‬‭a‬‭positive‬
‭first impression.‬

‭Importance of Non-Verbal Communication‬

‭●‬ ‭Builds trust and confidence.‬
‭●‬ ‭Supports and strengthens verbal communication.‬
‭●‬ ‭Helps express emotions effectively.‬
‭●‬ ‭Creates a professional image.‬
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‭Listening Skills‬

‭Listening‬ ‭is‬ ‭the‬ ‭ability‬ ‭to‬ ‭receive,‬ ‭understand,‬ ‭and‬ ‭respond‬ ‭to‬ ‭spoken‬
‭messages.‬
‭It is one of the most important parts of effective communication.‬
‭Good‬ ‭listening‬ ‭helps‬ ‭in‬ ‭learning,‬ ‭understanding‬ ‭others,‬ ‭and‬ ‭building‬
‭strong relationships.‬

‭Listening is not the same as hearing‬

‭Hearing‬ ‭means‬ ‭just‬ ‭receiving‬ ‭sound,while‬ ‭listening‬ ‭means‬
‭understanding the meaning behind those sounds.‬

‭Importance of Listening Skills:‬

‭●‬ ‭Helps in understanding ideas clearly.‬
‭●‬ ‭Builds trust and cooperation.‬
‭●‬ ‭Improves learning and concentration.‬
‭●‬ ‭Avoids confusion and misunderstandings.‬
‭●‬ ‭Essential for success in studies and workplace communication.‬

‭Types of Listening:‬

‭1.‬ ‭Active Listening:‬‭Paying full attention and responding‬‭appropriately.‬
‭2.‬ ‭Passive Listening:‬‭Hearing words without full attention.‬
‭3.‬ ‭Critical Listening:‬‭Evaluating and analyzing the message.‬
‭4.‬ ‭Empathetic Listening:‬‭Understanding the speaker’s‬‭feelings and‬

‭emotions.‬

‭Barriers to Good Listening:‬

‭●‬ ‭Lack of focus or interest.‬
‭●‬ ‭Interrupting the speaker.‬
‭●‬ ‭Noise or distractions.‬
‭●‬ ‭Prejudgment or bias.‬
‭●‬ ‭Emotional reactions or anger.‬

‭How to Improve Listening Skills:‬

‭●‬ ‭Focus fully on the speaker.‬
‭●‬ ‭Avoid interrupting while others talk.‬
‭●‬ ‭Maintain eye contact and show interest.‬
‭●‬ ‭Ask questions to clarify doubts.‬
‭●‬ ‭Keep an open and patient attitude.‬
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‭Group Discussion (GD) Skills‬

‭A‬‭Group‬‭Discussion‬‭is‬‭a‬‭formal‬‭discussion‬‭among‬‭a‬‭small‬‭group‬‭of‬‭people‬
‭on a specific topic.‬
‭It‬ ‭is‬ ‭used‬ ‭by‬ ‭companies‬ ‭and‬ ‭colleges‬ ‭to‬ ‭test‬ ‭your‬ ‭communication,‬
‭teamwork, and leadership‬‭skills.‬

‭Qualities Evaluated in GD‬

‭●‬ ‭Communication and clarity of thoughts‬
‭●‬ ‭Confidence and leadership‬
‭●‬ ‭Listening and respecting others’ opinions‬
‭●‬ ‭Ability to stay on topic‬
‭●‬ ‭Positive attitude and teamwork‬

‭Tips for Effective Group Discussion‬

‭●‬ ‭Start the discussion confidently.‬
‭●‬ ‭Speak politely and logically.‬
‭●‬ ‭Don’t interrupt others.‬
‭●‬ ‭Use facts, examples, or data to support your points.‬
‭●‬ ‭Conclude positively.‬

‭Example GD Topics‬

‭●‬ ‭“Social Media: A Boon or a Bane?”‬
‭●‬ ‭“Online Education vs Traditional Learning”‬
‭●‬ ‭“Role of Technology in Modern Jobs”‬
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‭Public Speaking :‬

‭Public Speaking‬‭is the skill of‬‭speaking confidently‬‭in front of an‬
‭audience‬‭to share ideas, information, or opinions.‬‭It is an important part of‬
‭communication and is used in schools, workplaces, and public events.‬

‭Public speaking helps in developing leadership qualities, improving‬
‭confidence, and building the ability to influence others. A good public‬
‭speaker does not just talk — they connect with the audience emotionally‬
‭and intellectually.‬

‭Public speaking means addressing a group of people in a structured and‬
‭deliberate manner to‬‭inform, persuade, or entertain‬‭.‬
‭It is a skill that combines both‬‭verbal communication‬‭(words) and‬
‭non-verbal communication‬‭(gestures, posture, eye contact).‬

‭Importance of Public Speaking:‬

‭1.‬ ‭Builds Confidence:‬‭Helps overcome stage fear and shyness.‬
‭2.‬ ‭Improves Communication:‬‭Develops clear and effective‬‭expression.‬
‭3.‬ ‭Leadership Development:‬‭Leaders inspire others through‬‭strong‬

‭speaking skills.‬
‭4.‬ ‭Professional Growth:‬‭Useful for interviews, meetings,‬‭and‬

‭presentations.‬
‭5.‬ ‭Influences People:‬‭A powerful tool to motivate and‬‭convince others.‬

‭Qualities of a Good Public Speaker‬

‭●‬ ‭Confidence:‬‭Speak naturally and without fear.‬
‭●‬ ‭Clarity:‬‭Use simple and understandable language.‬
‭●‬ ‭Voice Control:‬‭Speak loudly enough and with proper‬‭tone.‬
‭●‬ ‭Body Language:‬‭Maintain good posture and use hand‬‭gestures‬

‭effectively.‬
‭●‬ ‭Eye Contact:‬‭Look at your audience to build connections.‬
‭●‬ ‭Preparation:‬‭Be well-prepared and organized.‬
‭●‬ ‭Engagement:‬‭Interact with the audience through questions‬‭or‬

‭examples.‬

‭Tips for Effective Public Speaking‬

‭1.‬ ‭Know Your Topic:‬‭Research well and understand what‬‭you’re talking‬
‭about.‬

‭2.‬ ‭Know Your Audience:‬‭Understand their interests and‬‭level of‬
‭knowledge.‬
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‭3.‬ ‭Start Strong:‬‭Begin with a quote, question, or short story to grab‬
‭attention.‬

‭4.‬ ‭Stay Calm:‬‭Take deep breaths to manage nervousness.‬
‭5.‬ ‭Practice Regularly:‬‭The more you speak, the more confident‬‭you‬

‭become.‬
‭6.‬ ‭Use Visuals:‬‭Support your speech with slides, charts,‬‭or images if‬

‭needed.‬
‭7.‬ ‭End Positively:‬‭Summarize your message clearly and‬‭thank your‬

‭audience.‬

‭How to Engage the Audience‬

‭No matter how good your speech or presentation is, it will not be effective‬
‭unless the‬‭audience is interested and engaged‬‭.‬
‭Engaging the audience means‬‭capturing their attention‬‭,‬‭keeping them‬
‭involved‬‭, and making them feel connected to what you‬‭are saying.‬

‭An engaging speaker turns a one-way speech into a two-way experience —‬
‭where the audience listens, reacts, and participates.‬

‭Ways to Engage the Audience‬

‭1.‬ ‭Start with a Hook:‬
‭Begin your talk with something that catches attention — a question,‬
‭a surprising fact, or a short story.‬

‭2.‬ ‭Make Eye Contact:‬
‭Look directly at your audience instead of reading from notes. This‬
‭builds trust and connection.‬

‭3.‬ ‭Use Body Language:‬
‭Move naturally, use hand gestures, and smile. Your body language‬
‭should show confidence and energy.‬

‭4.‬ ‭Ask Questions:‬
‭Involve your audience by asking questions or encouraging them to‬
‭share thoughts.‬

‭5.‬ ‭Use Visuals:‬
‭Include slides, pictures, or videos to make your presentation‬
‭interesting and easy to understand.‬

‭6.‬ ‭Relate to the Audience:‬
‭Use examples or experiences that match the audience’s age,‬
‭background, or interests.‬
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‭7.‬ ‭Vary Your Voice and Tone:‬
‭Avoid speaking in a flat tone. Use pauses and changes in voice to‬
‭create emphasis and keep attention.‬

‭8.‬ ‭Encourage Participation:‬
‭Conduct small activities, polls, or discussions if possible.‬

‭9.‬ ‭Show Enthusiasm:‬
‭Be passionate about your topic — enthusiasm is contagious!‬

‭Importance of Audience Engagement‬

‭●‬ ‭Keeps the audience focused throughout the presentation.‬
‭●‬ ‭Makes the session memorable and meaningful.‬
‭●‬ ‭Builds connection and understanding between speaker and listener.‬
‭●‬ ‭Encourages feedback and interaction.‬
‭●‬ ‭Increases the overall effectiveness of communication.‬

‭Elements of Presentation‬

‭A presentation is a way of communicating ideas, information, or messages‬
‭to an audience. It helps in expressing thoughts clearly and developing‬
‭public speaking confidence. A good presentation is well-planned, clear,‬
‭and engaging.‬

‭Meaning of Presentation‬

‭A presentation means sharing knowledge or information in a structured‬
‭manner using speech, visuals, and body language. It can be done using‬
‭tools like PowerPoint, charts, or posters to make the message more‬
‭effective.‬

‭Elements of a Good Presentation‬

‭Content:‬

‭●‬ ‭The information or message that is to be shared.‬
‭●‬ ‭It should be clear, meaningful, and organized.‬
‭●‬ ‭Avoid unnecessary details and focus on main points.‬

‭Organization:‬

‭●‬ ‭Divide the presentation into three parts:‬

‭1.‬ ‭Introduction: Greet the audience and introduce the topic.‬
‭2.‬ ‭Body: Explain the main ideas with facts, examples, and visuals.‬
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‭3.‬ ‭Conclusion: Summarize the key points and end with an‬
‭impactful message.‬

‭Audience Awareness‬

‭●‬ ‭Understand who your audience is.‬
‭●‬ ‭Use suitable language, tone, and examples according to their‬

‭interest and understanding.‬

‭Visual Aids‬

‭●‬ ‭Use slides, images, charts, or short videos to make the presentation‬
‭interesting.‬

‭●‬ ‭Keep visuals simple, clear, and easy to read.‬

‭Delivery Style‬

‭●‬ ‭Speak clearly, confidently, and naturally.‬
‭●‬ ‭Maintain eye contact and use body language effectively.‬
‭●‬ ‭Avoid reading directly from notes.‬

‭Time Management‬

‭●‬ ‭Plan and practice the presentation within the given time limit.‬
‭●‬ ‭Give enough time to each section – introduction, body, and‬

‭conclusion.‬

‭Engagement‬

‭●‬ ‭Interact with the audience through questions or short activities.‬
‭●‬ ‭Encourage feedback or participation to maintain interest.‬

‭Confidence & Body Language‬

‭●‬ ‭Stand straight and appear confident.‬
‭●‬ ‭Use hand gestures and facial expressions to support your message.‬

‭Use of Technology‬

‭●‬ ‭Use tools like PowerPoint, Canva, or Prezi for designing slides.‬
‭●‬ ‭Check all technical equipment before starting the presentation.‬

‭Tips for Effective Presentation‬

‭●‬ ‭Start with an interesting quote, story, or question.‬
‭●‬ ‭Keep slides neat and avoid too much text.‬
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‭●‬ ‭Practice before presenting to improve timing and confidence.‬
‭●‬ ‭End with a strong conclusion or message.‬

‭Activity:‬‭Present Yourself , Group Discussion‬

‭Summary:‬

‭●‬ ‭Communication is the ability to express ideas clearly through verbal‬
‭(spoken/written) and non-verbal (body language) methods.‬

‭●‬ ‭Good speaking, listening, posture, eye contact, and confidence are essential for‬
‭effective communication in studies and professional life.‬

‭●‬ ‭Group discussions and public speaking help build clarity, confidence, leadership,‬
‭and teamwork.‬

‭●‬ ‭Audience engagement—through eye contact, questions, stories, and‬
‭visuals—makes presentations more effective and interesting.‬

‭●‬ ‭A good presentation requires clear content, proper organization, visuals,‬
‭confidence, and good delivery skills.‬
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‭Unit 11: Formal Communication‬

‭Introduction to Email‬

‭Email‬ ‭(Electronic‬ ‭Mail)‬ ‭is‬ ‭a‬ ‭digital‬ ‭method‬ ‭to‬ ‭send‬ ‭and‬ ‭receive‬ ‭messages‬
‭over‬ ‭the‬ ‭internet.‬ ‭It‬ ‭is‬ ‭widely‬ ‭used‬ ‭in‬ ‭personal,‬ ‭educational,‬ ‭and‬
‭professional communication‬‭.‬

‭Importance of Email:‬

‭●‬ ‭Fast and reliable communication‬
‭●‬ ‭Send attachments like documents, images, presentations‬
‭●‬ ‭Maintains a record of communication‬
‭●‬ ‭Can reach multiple recipients simultaneously‬

‭Structure of Formal Emails‬

‭A professional email should follow a clear structure:‬

‭1.‬ ‭Subject:‬‭Short and precise; describe purpose‬

‭○‬ ‭Example: “Project Submission – Data Analysis Report”‬

‭2.‬ ‭Greeting / Salutation:‬‭Start politely‬

‭○‬ ‭Example: “Dear Sir/Madam,” or “Hi Rohit,”‬
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‭3.‬ ‭Body:‬‭Main message, clear and concise‬

‭○‬ ‭Use short paragraphs, polite and professional tone‬

‭4.‬ ‭Closing / Signature:‬‭End politely with your details‬

‭○‬ ‭Example: “Best regards, Anmol Tyagi”‬

‭Tip:‬‭Proofread before sending to avoid mistakes‬

‭Steps to Send an Email:‬

‭Step 1: Open Gmail‬

‭👉 Go to www.gmail.com or open the Gmail app on your phone.‬
‭Step 2: Login‬

‭👉 Enter your email ID and password.‬

‭Step 3: Click on “Compose”‬

‭👉 It means “write a new message”.‬
‭Step 4: Fill the Email:‬

‭●‬ ‭To‬ ‭–‬ ‭Write‬ ‭the‬ ‭email‬ ‭address‬ ‭of‬ ‭the‬ ‭person‬ ‭you‬ ‭want‬ ‭to‬ ‭send‬ ‭(e.g.‬
‭teacher@gmail.com)‬

‭●‬ ‭Subject – Write the title (e.g.‬‭Homework‬‭)‬
‭●‬ ‭Message‬ ‭–‬ ‭Write‬ ‭your‬ ‭message‬ ‭(e.g.‬ ‭Hello‬ ‭Ma’am,‬ ‭I‬ ‭am‬‭sending‬‭my‬

‭homework.‬‭)‬

‭Step 5: Attach File (Optional)‬

‭👉 Click the 📎‬‭paperclip‬‭to add a file or photo.‬

‭Step 6: Click “Send”‬

‭👉 Your email will be sent.‬
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‭Using CC & BCC‬

‭●‬ ‭CC (Carbon Copy):‬‭Send copy to others for awareness‬
‭●‬ ‭BCC‬ ‭(Blind‬ ‭Carbon‬ ‭Copy):‬ ‭Send‬ ‭to‬ ‭recipients‬ ‭without‬ ‭showing‬

‭addresses‬

‭Use cases:‬

‭●‬ ‭CC → Inform colleagues or teachers‬
‭●‬ ‭BCC → Protect privacy in mass emails‬

‭Attaching Documents Securely‬

‭Steps:‬

‭1.‬ ‭Click‬‭Attach / Paperclip icon‬
‭2.‬ ‭Select the file (PDF, Word, Excel)‬
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‭3.‬ ‭Ensure file size is within limit‬
‭4.‬ ‭Mention the attachment in the email body‬

‭Tip:‬‭Double-check attachments before sending‬

‭Professional Email Tone‬

‭●‬ ‭Use polite, respectful language‬
‭●‬ ‭Avoid slang or casual words‬
‭●‬ ‭Keep sentences short and clear‬
‭●‬ ‭Use proper punctuation and capitalization‬

‭Example:‬

‭●‬ ‭Professional: “Please find attached the report for your review.”‬
‭●‬ ‭Unprofessional: “Hey, see the file I sent you.”‬

‭Extra Tips‬

‭●‬ ‭Use‬ ‭a‬ ‭professional‬ ‭email‬ ‭address‬ ‭(example:‬
‭firstname.lastname@gmail.com)‬

‭●‬ ‭Avoid sending emails in ALL CAPS (looks like shouting)‬
‭●‬ ‭Reply within 24 hours to maintain professionalism‬
‭●‬ ‭Use bullet points for clarity in long emails‬
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‭Data Sharing‬
‭Data Sharing in Cloud Services means storing and accessing files on the‬
‭internet and allowing others to view, edit, or download them from‬
‭anywhere, anytime.‬
‭It helps users collaborate online without using pen drives or local storage‬
‭devices.‬

‭Cloud Storage‬

‭Introduction to Cloud Storage‬
‭●‬ ‭Google‬ ‭Cloud‬ ‭Services‬ ‭are‬ ‭online‬ ‭tools‬ ‭provided‬ ‭by‬ ‭Google‬ ‭that‬

‭help‬ ‭individuals,‬ ‭schools,‬ ‭and‬ ‭businesses‬ ‭store,‬ ‭manage,‬ ‭and‬ ‭use‬
‭data safely on the internet‬‭.‬

‭●‬ ‭Instead‬ ‭of‬ ‭keeping‬ ‭everything‬ ‭only‬ ‭on‬ ‭a‬ ‭computer‬ ‭or‬ ‭hard‬ ‭disk,‬ ‭we‬
‭can‬ ‭save‬ ‭our‬ ‭files,‬ ‭documents,‬ ‭photos,‬ ‭and‬ ‭applications‬‭on‬‭Google’s‬
‭cloud.‬

‭●‬ ‭This‬‭makes‬‭it‬‭possible‬‭to‬‭access‬‭files‬‭anywhere,‬‭anytime,‬‭from‬‭any‬
‭device‬‭(computer, tablet, or mobile phone).‬

‭●‬ ‭Google‬ ‭Cloud‬ ‭Services‬ ‭also‬‭provide‬‭many‬‭applications‬‭for‬‭working,‬
‭learning, and sharing‬‭.‬

‭Benefits:‬

‭●‬ ‭Accessibility‬ ‭–‬ ‭Files‬ ‭can‬ ‭be‬ ‭opened‬ ‭anytime‬ ‭with‬ ‭internet‬
‭connection.‬
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‭●‬ ‭Collaboration‬ ‭–‬ ‭Many‬ ‭people‬ ‭can‬ ‭work‬ ‭together‬‭on‬‭the‬‭same‬‭file‬‭at‬
‭the same time.‬

‭●‬ ‭Data Safety‬‭– Data is protected with Google’s strong‬‭security system.‬
‭●‬ ‭Cost‬‭Saving‬‭–‬‭No‬‭need‬‭to‬‭buy‬‭extra‬‭storage‬‭devices‬‭like‬‭pen‬‭drives‬‭or‬

‭external hard disks.‬
‭●‬ ‭Automatic Updates‬‭– Apps and services get updated‬‭automatically.‬
‭●‬ ‭Backup‬ ‭Facility‬ ‭–‬ ‭If‬ ‭a‬ ‭device‬ ‭is‬ ‭lost‬ ‭or‬ ‭damaged,‬ ‭data‬ ‭is‬ ‭still‬ ‭safe‬

‭online.‬

‭Importance of Cloud Services:‬

‭●‬ ‭For‬ ‭Students‬ ‭and‬ ‭Teachers‬ ‭–‬ ‭Helps‬ ‭in‬ ‭sharing‬ ‭homework,‬ ‭notes,‬
‭assignments,‬ ‭and‬ ‭presentations.‬ ‭Online‬ ‭classes‬ ‭and‬ ‭group‬ ‭projects‬
‭become easier.‬

‭●‬ ‭For‬ ‭Business‬ ‭–‬ ‭Companies‬ ‭use‬ ‭it‬ ‭for‬ ‭storing‬ ‭data,‬ ‭running‬ ‭software,‬
‭and working with teams across the world.‬

‭●‬ ‭For‬‭Daily‬‭Life‬‭–‬‭People‬‭use‬‭Google‬‭Drive,‬‭Gmail,‬‭and‬‭Google‬‭Photos‬‭to‬
‭keep documents and memories safe.‬

‭●‬ ‭For‬ ‭Innovation‬ ‭–‬ ‭Developers‬ ‭use‬ ‭Google‬ ‭Cloud‬ ‭to‬ ‭build‬ ‭apps,‬
‭websites, and smart technologies.‬

‭●‬ ‭For‬ ‭Remote‬ ‭Work‬ ‭–‬ ‭In‬ ‭today’s‬‭world,‬‭cloud‬‭services‬‭make‬‭it‬‭possible‬
‭to work from home or any location.‬

‭Examples of Cloud Services:‬
‭●‬ ‭Google Drive‬
‭●‬ ‭OneDrive‬
‭●‬ ‭iCloud‬

‭Uploading & Organizing Files‬
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‭Steps:‬

‭1.‬ ‭Open cloud storage account‬
‭2.‬ ‭Click‬‭Upload → File / Folder‬
‭3.‬ ‭Select files from your computer‬
‭4.‬ ‭Organize into folders‬

‭Tips:‬

‭●‬ ‭Use clear folder names‬
‭●‬ ‭Group similar files‬
‭●‬ ‭Avoid clutter for easy access‬

‭Sharing Files‬

‭Steps:‬

‭1.‬ ‭Right-click file →‬‭Share‬
‭2.‬ ‭Enter recipient emails‬
‭3.‬ ‭Set permission (‬‭View / Comment / Edit‬‭)‬
‭4.‬ ‭Click‬‭Send‬

‭Tip:‬‭Only share with authorized users‬

‭Extra Tips‬

‭●‬ ‭Regularly backup important files‬
‭●‬ ‭Keep folders and file names consistent‬
‭●‬ ‭Use two-factor authentication for security‬
‭●‬ ‭Check file permissions before sharing‬

‭Activity:‬‭Discuss on email creation‬

‭Summary:‬

‭●‬ ‭Email is a fast and professional way to communicate, send files, and keep records‬
‭of messages.‬

‭●‬ ‭A formal email includes a clear subject, polite greeting, short and organized body,‬
‭and proper closing with your name.‬

‭●‬ ‭CC and BCC help share information with others while maintaining privacy when‬
‭needed.‬

‭●‬ ‭Cloud storage allows storing, organizing, and sharing files online safely using‬
‭services like Google Drive, OneDrive, and iCloud.‬

‭●‬ ‭Cloud tools help in collaboration, data backup, and easy access to files from any‬
‭device.‬
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‭Profile Building and Life Skills‬

‭Unit 12: Leadership & Growth‬

‭Introduction‬

‭In‬‭any‬‭organization‬‭or‬‭group‬‭activity,‬‭success‬‭depends‬‭on‬‭how‬‭well‬‭people‬
‭work together.‬
‭Good‬‭leaders‬‭and‬‭team‬‭members‬‭play‬‭an‬‭important‬‭role‬‭in‬‭achieving‬‭goals‬
‭efficiently.‬

‭Leadership,‬ ‭teamwork,‬ ‭and‬ ‭project‬ ‭management‬ ‭are‬ ‭three‬ ‭essential‬
‭professional‬ ‭skills‬ ‭that‬ ‭help‬ ‭in‬ ‭planning,‬ ‭coordinating,‬ ‭and‬ ‭completing‬
‭work effectively‬‭.‬
‭A‬ ‭person‬ ‭who‬ ‭can‬ ‭lead,‬ ‭make‬ ‭decisions,‬ ‭and‬ ‭work‬ ‭well‬ ‭with‬ ‭others‬
‭becomes a valuable asset in any workplace.‬

‭This‬‭unit‬‭focuses‬‭on‬‭leadership‬‭qualities,‬‭teamwork‬‭roles,‬‭workplace‬‭ethics,‬
‭and how to plan and manage projects with clear timelines.‬

‭Shiv Nadar Institution of Eminence‬
‭Deemed to be University‬ ‭122‬‭। page‬



‭Leadership Qualities‬

‭Leadership‬ ‭means‬ ‭the‬ ‭ability‬ ‭to‬ ‭guide,‬ ‭influence,‬ ‭and‬ ‭motivate‬ ‭others‬ ‭to‬
‭achieve common goals.‬
‭A‬ ‭good‬ ‭leader‬ ‭inspires‬ ‭the‬ ‭team,‬ ‭provides‬ ‭direction,‬ ‭and‬ ‭ensures‬ ‭that‬
‭everyone contributes positively.‬

‭Key Qualities of a Good Leader‬

‭1.‬ ‭Vision:‬ ‭A‬ ‭leader‬ ‭should‬ ‭have‬‭a‬‭clear‬‭idea‬‭of‬‭what‬‭the‬‭team‬‭wants‬‭to‬
‭achieve.‬

‭2.‬ ‭Communication:‬ ‭The‬ ‭ability‬ ‭to‬ ‭convey‬ ‭ideas‬ ‭and‬ ‭listen‬ ‭to‬ ‭others‬
‭effectively.‬

‭3.‬ ‭Confidence:‬ ‭Believing‬ ‭in‬ ‭oneself‬ ‭and‬ ‭making‬ ‭decisions‬ ‭without‬
‭hesitation.‬

‭4.‬ ‭Empathy:‬‭Understanding team members’ feelings and‬‭challenges.‬

‭5.‬ ‭Responsibility:‬‭Taking ownership of tasks and results.‬

‭6.‬ ‭Integrity:‬‭Being honest and maintaining ethical behavior.‬

‭7.‬ ‭Decision-making:‬ ‭Making‬ ‭the‬ ‭right‬ ‭choice‬ ‭after‬ ‭analyzing‬ ‭all‬
‭options.‬

‭8.‬ ‭Motivation:‬‭Encouraging and inspiring others to do‬‭their best.‬

‭Importance of Leadership‬

‭●‬ ‭Builds direction and purpose for the team.‬
‭●‬ ‭Improves productivity and coordination.‬
‭●‬ ‭Helps in solving conflicts and challenges.‬
‭●‬ ‭Encourages teamwork and creativity.‬
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‭Types of Leadership‬

‭Style‬ ‭Meaning‬ ‭Example‬

‭Autocratic‬ ‭Leader‬ ‭makes‬ ‭all‬
‭decisions‬

‭Military‬
‭commander‬

‭Democratic‬ ‭Team‬ ‭participates‬ ‭in‬
‭decisions‬

‭School‬ ‭project‬
‭leader‬

‭Transformatio‬
‭nal‬

‭Inspires‬ ‭change‬ ‭and‬
‭creativity‬

‭Elon Musk‬

‭Transactional‬ ‭Focused‬ ‭on‬ ‭rules‬ ‭and‬
‭rewards‬

‭Sales manager‬

‭Servant‬ ‭Puts team first‬ ‭Community‬
‭leaders‬

‭Teamwork‬

‭Teamwork‬ ‭means‬ ‭working‬ ‭together‬ ‭with‬ ‭a‬ ‭group‬‭of‬‭people‬‭to‬‭achieve‬‭a‬
‭common‬ ‭goal‬‭.‬ ‭It‬ ‭is‬ ‭when‬ ‭every‬ ‭team‬ ‭member‬ ‭contributes‬ ‭their‬ ‭skills,‬
‭ideas, and efforts‬‭to complete a task successfully.‬

‭Example:‬

‭In‬‭a‬‭school‬‭project,‬‭when‬‭students‬‭divide‬‭the‬‭work‬‭—‬‭one‬‭makes‬‭the‬‭chart,‬
‭one collects information, and another presents it — that’s teamwork.‬

‭Importance of Teamwork:‬

‭1.‬ ‭Builds cooperation:‬‭People learn how to work together‬‭peacefully.‬

‭2.‬ ‭Improves efficiency:‬‭Tasks get done faster when everyone‬‭helps.‬

‭3.‬ ‭Encourages creativity:‬‭Different ideas from team members‬‭create‬
‭better solutions.‬

‭4.‬ ‭Develops communication skills:‬‭Teamwork improves how‬‭we share‬
‭and listen.‬

‭5.‬ ‭Builds trust and support:‬‭Team members rely on each‬‭other for‬
‭success.‬
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‭6.‬ ‭Helps achieve common goals:‬‭A team can do more than a single‬
‭person.‬

‭Qualities of a Good Team Member:‬

‭●‬ ‭Cooperation‬
‭●‬ ‭Respect‬
‭●‬ ‭Good communication‬
‭●‬ ‭Responsibility‬
‭●‬ ‭Positive attitude‬
‭●‬ ‭Willingness to help others‬

‭What is Growth?‬

‭Growth‬ ‭means‬ ‭an‬ ‭increase,‬ ‭improvement,‬ ‭or‬ ‭positive‬ ‭development‬ ‭in‬
‭something‬ ‭over‬ ‭time.‬ ‭It‬ ‭can‬ ‭refer‬ ‭to‬ ‭physical‬ ‭size,‬ ‭skills,‬ ‭knowledge,‬
‭business, economy, or any form of progress.‬

‭In simple words:‬
‭Growth‬ ‭is‬ ‭the‬ ‭process‬ ‭of‬ ‭becoming‬ ‭better,‬ ‭bigger,‬ ‭stronger,‬ ‭or‬ ‭more‬
‭advanced than before.‬

‭Types of growth:‬

‭●‬ ‭Personal Growth:‬‭Learning new skills, gaining confidence‬
‭●‬ ‭Professional Growth:‬‭Doing better at studies or work‬
‭●‬ ‭Organizational Growth:‬‭School or business improving‬‭and achieving‬

‭more‬

‭Example:‬ ‭Learning‬ ‭a‬ ‭new‬ ‭language‬ ‭or‬ ‭organizing‬ ‭a‬ ‭school‬ ‭event‬ ‭shows‬
‭personal and professional growth.‬

‭How Leaders Help Growth‬

‭Good leaders:‬

‭●‬ ‭Teach and guide others‬
‭●‬ ‭Give feedback to improve‬
‭●‬ ‭Motivate and encourage team members‬
‭●‬ ‭Give opportunities to try new things‬

‭Example:‬ ‭Google‬ ‭allows‬ ‭employees‬ ‭to‬ ‭work‬ ‭on‬ ‭their‬ ‭own‬ ‭ideas,‬ ‭helping‬
‭them grow.‬

‭125‬‭। page‬ ‭Shiv Nadar Institution of Eminence‬
‭Deemed to be University‬



‭Challenges in Leadership and Growth‬

‭●‬ ‭People may resist change‬
‭●‬ ‭Miscommunication can cause problems‬
‭●‬ ‭Limited time or resources‬
‭●‬ ‭Team conflicts‬
‭●‬ ‭Stress and pressure‬

‭Tip:‬‭Stay calm, communicate clearly, and learn from‬‭mistakes.‬

‭How to Develop Leadership Skills‬

‭1.‬ ‭Take responsibility in class or projects‬
‭2.‬ ‭Learn from role models‬
‭3.‬ ‭Practice speaking and listening‬
‭4.‬ ‭Work with your team‬
‭5.‬ ‭Solve problems smartly‬
‭6.‬ ‭Learn from feedback‬

‭Activity:‬‭Discussion on leadership and personal growth.‬

‭Summary:‬

‭●‬ ‭Leadership‬ ‭means‬ ‭guiding‬ ‭and‬ ‭motivating‬ ‭others‬ ‭with‬ ‭qualities‬ ‭like‬ ‭vision,‬
‭confidence, communication, and responsibility.‬

‭●‬ ‭Teamwork‬ ‭helps‬ ‭people‬ ‭work‬ ‭together,‬ ‭share‬ ‭tasks,‬ ‭build‬ ‭trust,‬ ‭and‬ ‭achieve‬
‭common goals efficiently.‬

‭●‬ ‭Growth‬ ‭refers‬ ‭to‬ ‭improving‬ ‭skills,‬ ‭knowledge,‬ ‭and‬ ‭performance‬ ‭at‬ ‭personal,‬
‭professional, and organizational levels.‬

‭●‬ ‭Good‬ ‭leaders‬ ‭support‬ ‭growth‬ ‭by‬ ‭motivating‬ ‭the‬ ‭team,‬ ‭giving‬ ‭feedback,‬ ‭and‬
‭creating opportunities to learn.‬

‭●‬ ‭Leadership‬ ‭and‬ ‭growth‬ ‭require‬ ‭overcoming‬ ‭challenges‬ ‭through‬ ‭clear‬
‭communication, cooperation, and continuous learning.‬
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‭Unit 13:  Professional use of Social Media‬

‭Introduction to Social Media‬

‭Social media refers to‬‭web-based platforms and mobile‬‭apps‬‭that allow people‬
‭to‬‭create, share, and exchange information, photos,‬‭and videos‬‭in virtual‬
‭communities.‬

‭Types of Social Media:‬

‭Type‬ ‭Examples‬ ‭Purpose‬

‭Social Networking Sites‬ ‭Facebook,‬
‭Instagram‬

‭Connect with friends and share‬
‭posts.‬

‭Professional Networking‬
‭Sites‬

‭LinkedIn‬ ‭Build career contacts and find‬
‭jobs.‬

‭Media Sharing Platforms‬ ‭YouTube,‬
‭Snapchat‬

‭Share videos and tutorials.‬

‭Microblogging Sites‬ ‭X (Twitter),‬
‭Threads‬

‭Share short updates or ideas.‬

‭Messaging Apps‬ ‭WhatsApp,‬
‭Telegram‬

‭Send instant messages and‬
‭files.‬

‭Discussion Forums‬ ‭Quora, Reddit‬ ‭Share knowledge and opinions.‬
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‭Importance of Social Media:‬

‭●‬ ‭Improves global communication.‬
‭●‬ ‭Enhances learning and information sharing.‬
‭●‬ ‭Builds personal and professional connections.‬
‭●‬ ‭Promotes business and career opportunities.‬
‭●‬ ‭Encourages creativity and innovation.‬

‭Popular Social Media Platforms‬

‭Platform‬ ‭Main Use‬

‭Facebook‬ ‭Social connection, sharing updates and‬
‭photos.‬

‭Instagram‬ ‭Visual storytelling and creativity.‬

‭LinkedIn‬ ‭Professional networking and job search.‬

‭YouTube‬ ‭Educational and entertainment videos.‬

‭X (Twitter)‬ ‭Sharing quick updates and opinions.‬

‭Telegram /‬
‭WhatsApp‬

‭Fast communication and document‬
‭sharing.‬

‭Professional Use of Social Media‬

‭Building Online Presence:‬

‭Your‬‭online presence‬‭is how people view you on the‬‭internet — through your‬
‭posts, achievements, and profiles.‬
‭A positive and active online presence builds‬‭trust‬‭and credibility‬‭.‬

‭Personal Branding:‬

‭Personal Branding‬‭means creating a unique and professional‬‭image of yourself‬
‭online by showing your‬‭skills, achievements, and personality‬‭.‬

‭●‬ ‭Share your learning experiences or creative work.‬
‭●‬ ‭Keep your online tone positive and respectful.‬
‭●‬ ‭Follow experts or pages related to your field.‬

‭Example:‬‭A student sharing their artwork, a coding‬‭project, or a business idea on‬
‭LinkedIn.‬
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‭Using Social Media for Career Growth‬

‭Networking:‬

‭●‬ ‭Connect with teachers, seniors, and professionals.‬
‭●‬ ‭Join online study or career groups.‬
‭●‬ ‭Follow mentors and organizations in your career field.‬

‭Sharing Skills & Achievements:‬

‭●‬ ‭Post your certificates, projects, and creative work.‬
‭●‬ ‭Share blogs or thoughts about your learning journey.‬
‭●‬ ‭Tag institutions or companies where you’ve worked or volunteered.‬

‭Benefits:‬

‭●‬ ‭Increases visibility and recognition.‬
‭●‬ ‭Helps in finding internships or job opportunities.‬
‭●‬ ‭Builds your personal and professional confidence.‬

‭Introduction to Job Portals‬

‭Job portals help people‬‭search and apply for jobs‬‭online‬‭easily.‬

‭Job Portal‬ ‭Features‬

‭Naukri.com‬ ‭India’s most used site for all sectors and skill levels.‬

‭Indeed‬ ‭Global job search platform.‬

‭LinkedIn‬
‭Jobs‬

‭Built into LinkedIn — matches your profile to job‬
‭openings.‬

‭LinkedIn‬

‭LinkedIn‬‭is a‬‭professional networking platform‬‭that‬‭helps students, job seekers,‬
‭and professionals‬‭connect, learn, and grow‬‭in their‬‭careers.‬

‭It allows users to:‬

‭●‬ ‭Create a‬‭digital professional profile‬‭(like a resume).‬
‭●‬ ‭Connect with professionals, teachers, and mentors.‬
‭●‬ ‭Search and apply for‬‭internships and jobs‬‭.‬
‭●‬ ‭Share achievements, skills, and ideas.‬
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‭●‬ ‭Learn new skills through‬‭LinkedIn Learning‬‭courses.‬

‭Why LinkedIn is Important for Students:‬

‭●‬ ‭Helps in‬‭building a career identity‬‭early.‬
‭●‬ ‭Connects with industry professionals and college alumni.‬
‭●‬ ‭Shows your skills, certifications, and education to recruiters.‬
‭●‬ ‭Allows you to discover‬‭career paths and opportunities‬‭.‬
‭●‬ ‭Build your confidence and communication skills online.‬

‭How to Create a LinkedIn Profile:‬

‭1.‬ ‭Visit:‬‭www.linkedin.com‬
‭2.‬ ‭Sign Up‬‭with your email and create a password.‬
‭3.‬ ‭Upload a Professional Profile Picture.‬

‭○‬ ‭Clear background, formal dress, smiling face.‬

‭4.‬ ‭Write a Headline:‬‭(Example: “Class 12 Student | Aspiring‬‭Graphic Designer”)‬

‭5.‬ ‭Add About / Summary:‬

‭○‬ ‭2–3 lines about your interests and career goals.‬

‭○‬ ‭Example: “I am a motivated commerce student interested in‬
‭accounting and finance. I enjoy learning new tools and exploring‬
‭opportunities to grow.”‬

‭6.‬ ‭Add Education:‬

‭○‬ ‭Include your school/college name, class, and stream.‬

‭7.‬ ‭Add Skills:‬

‭○‬ ‭Example: MS Office, Communication, Teamwork, Graphic Design,‬
‭Problem Solving.‬

‭8.‬ ‭Add Certificates / Achievements:‬

‭○‬ ‭Include online courses, competitions, or volunteer work.‬

‭9.‬ ‭Follow Companies and Mentors:‬

‭○‬ ‭Helps you stay updated on jobs and career news.‬
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‭10.‬ ‭Keep Updating:‬

‭○‬ ‭Post when you complete a project or learn something new.‬

‭LinkedIn Do’s and Don’ts‬

‭Do’s‬ ‭Don’ts‬

‭Use a clear, professional photo.‬ ‭Don’t use selfies or funny pictures.‬

‭Keep your information accurate and‬
‭updated.‬

‭Don’t share personal or false‬
‭information.‬

‭Connect with known or professional‬
‭people.‬

‭Avoid random or unknown‬
‭connections.‬

‭Be polite and respectful online.‬ ‭Don’t post negative or unprofessional‬
‭content.‬

‭Photo Protection‬

‭Photo protection‬‭means keeping your personal or professional‬‭photos‬‭safe from‬
‭misuse, editing, or unauthorized sharing‬‭on the internet.‬
‭When you share a photo online, anyone can download, copy, or misuse it if proper‬
‭safety settings are not applied.‬

‭Why Photo Protection is Important:‬

‭●‬ ‭Prevents others from using your images without permission.‬
‭●‬ ‭Keep your‬‭identity and privacy‬‭safe.‬
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‭●‬ ‭Protects your creative work (like designs, artwork, or photography).‬
‭●‬ ‭Maintains a‬‭positive online reputation‬‭.‬

‭Tips for Protecting Photos Online:‬

‭Protection Tip‬ ‭Explanation‬

‭1. Use Privacy‬
‭Settings‬

‭On apps like Facebook, Instagram, or LinkedIn, set‬
‭photos to “Friends Only” or “Private.” Avoid “Public”‬
‭sharing.‬

‭2. Add Watermarks‬ ‭Add your name or logo on creative or professional‬
‭photos to prevent copying.‬

‭3. Avoid Personal‬
‭Photos‬

‭Do not upload private, family, or location-based photos‬
‭on public platforms.‬

‭4. Disable Download‬
‭Option‬

‭Some sites allow you to turn off the download or save‬
‭option for your photos.‬

‭5. Check Tagged‬
‭Photos‬

‭Review photos others tag you in and remove unwanted‬
‭ones.‬

‭6. Share Only on‬
‭Trusted Platforms‬

‭Use verified and secure platforms like Google Drive or‬
‭LinkedIn for professional use.‬

‭Photo & Data Protection:‬

‭●‬ ‭Use‬‭privacy settings‬‭to control who can see your posts.‬
‭●‬ ‭Avoid sharing private or family pictures publicly.‬
‭●‬ ‭Add‬‭watermarks‬‭to creative photos or artwork.‬
‭●‬ ‭Check app permissions before uploading content.‬
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‭●‬ ‭Activity:‬‭Create a LinkedIn profile highlighting career interests‬

‭Summary:‬

‭●‬ ‭Social‬‭media‬‭includes‬‭platforms‬‭like‬‭Facebook,‬‭Instagram,‬‭LinkedIn,‬‭YouTube,‬‭and‬
‭WhatsApp used for communication, learning, and sharing content.‬

‭●‬ ‭It‬ ‭helps‬ ‭build‬ ‭a‬ ‭professional‬ ‭online‬ ‭presence,‬ ‭develop‬ ‭personal‬ ‭branding,‬ ‭and‬
‭showcase skills, achievements, and career interests.‬

‭●‬ ‭Platforms‬ ‭like‬ ‭LinkedIn‬ ‭and‬ ‭job‬ ‭portals‬ ‭(Naukri,‬ ‭Indeed)‬ ‭support‬ ‭networking,‬
‭internships, and job opportunities for students and professionals.‬

‭●‬ ‭Using‬ ‭privacy‬ ‭settings,‬ ‭avoiding‬ ‭public‬ ‭sharing‬ ‭of‬ ‭personal‬ ‭photos,‬ ‭and‬ ‭adding‬
‭watermarks help protect photos and data online.‬

‭●‬ ‭Social‬ ‭media,‬ ‭when‬ ‭used‬ ‭responsibly,‬ ‭enhances‬ ‭career‬ ‭growth,‬ ‭creativity,‬ ‭and‬
‭professional connections.‬
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‭Unit 14: Career Readiness Skills‬

‭Introduction‬

‭Career‬ ‭Readiness‬ ‭Skills‬ ‭help‬ ‭students‬ ‭prepare‬ ‭for‬‭future‬‭job‬‭opportunities‬
‭and‬ ‭professional‬ ‭growth.‬ ‭These‬ ‭skills‬ ‭include‬ ‭creating‬ ‭a‬ ‭strong‬ ‭resume,‬
‭preparing‬ ‭for‬ ‭interviews,‬ ‭and‬ ‭developing‬ ‭confidence‬ ‭to‬ ‭present‬ ‭oneself‬
‭effectively.‬
‭They‬ ‭play‬ ‭a‬ ‭key‬ ‭role‬ ‭in‬ ‭helping‬ ‭students‬ ‭transition‬ ‭from‬ ‭school‬ ‭to‬ ‭higher‬
‭studies or employment.‬

‭Resume Writing‬

‭A‬ ‭resume‬ ‭is‬ ‭a‬ ‭short,‬ ‭written‬ ‭summary‬ ‭of‬ ‭a‬ ‭person’s‬ ‭education,‬ ‭skills,‬
‭achievements, and experience.‬
‭It‬‭is‬‭used‬‭to‬‭apply‬‭for‬‭jobs,‬‭internships,‬‭or‬‭higher‬‭education‬‭opportunities.‬‭A‬
‭well-made resume creates a positive first impression on employers.‬

‭Importance of a Resume‬

‭●‬ ‭It highlights your skills and qualifications.‬
‭●‬ ‭Helps the employer understand your suitability for a job.‬
‭●‬ ‭Creates a professional image of the candidate.‬
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‭●‬ ‭Acts as a marketing tool to present yourself effectively.‬

‭Parts of a Resume‬

‭1.‬ ‭Personal Information‬

‭○‬ ‭Name, address, contact number, and email ID.‬

‭2.‬ ‭Career Objective‬

‭○‬ ‭A short statement that describes your professional goal.‬
‭Example:‬‭“To‬‭build‬‭a‬‭successful‬‭career‬‭in‬‭the‬‭IT‬‭industry‬‭using‬

‭my technical and communication skills.”‬

‭3.‬ ‭Educational Qualifications‬

‭○‬ ‭List‬ ‭of‬ ‭schools/colleges‬ ‭attended‬ ‭with‬ ‭marks‬ ‭and‬ ‭year‬ ‭of‬
‭passing.‬

‭4.‬ ‭Skills‬

‭○‬ ‭Technical, communication, leadership, or computer skills.‬

‭5.‬ ‭Work Experience / Internships (if any)‬

‭○‬ ‭Details of previous jobs, projects, or internships.‬

‭6.‬ ‭Achievements / Extracurricular Activities‬

‭○‬ ‭Awards, certificates, or activities that show your strengths.‬

‭7.‬ ‭References (Optional)‬

‭○‬ ‭Names of teachers or mentors who can recommend you.‬

‭Tips for Writing an Effective Resume‬

‭●‬ ‭Keep it short (1 page) and easy to read.‬
‭●‬ ‭Use simple fonts and clear headings.‬
‭●‬ ‭Avoid spelling or grammar mistakes.‬
‭●‬ ‭Customize the resume according to the job or course applied for.‬
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‭Interview Preparation‬

‭An‬‭interview‬‭is‬‭a‬‭formal‬‭meeting‬‭between‬‭an‬‭employer‬‭and‬‭a‬‭candidate‬‭to‬
‭assess whether the candidate is suitable for a particular job or role.‬

‭Types of Interviews‬

‭●‬ ‭Personal Interview: One-on-one discussion.‬
‭●‬ ‭Panel Interview: Conducted by a group of interviewers.‬
‭●‬ ‭Telephonic‬ ‭or‬ ‭Online‬ ‭Interview:‬ ‭Conducted‬ ‭through‬ ‭phone‬ ‭or‬ ‭video‬

‭call.‬

‭Steps for Interview Preparation‬

‭1.‬ ‭Research the Company / Institution‬

‭○‬ ‭Know about its background, services, and values.‬

‭2.‬ ‭Understand the Job Role‬

‭○‬ ‭Read the job description carefully.‬

‭3.‬ ‭Prepare Common Questions‬

‭○‬ ‭Tell me about yourself.‬
‭○‬ ‭What are your strengths and weaknesses?‬
‭○‬ ‭Why do you want to work with us?‬
‭○‬ ‭Where do you see yourself in 5 years?‬

‭4.‬ ‭Dress Professionally‬

‭○‬ ‭Wear neat and formal clothes.‬

‭5.‬ ‭Body Language and Communication‬

‭○‬ ‭Maintain eye contact, smile, and sit confidently.‬

‭○‬ ‭Speak clearly and politely.‬

‭6.‬ ‭Follow-Up‬

‭○‬ ‭Thank the interviewer after the session.‬
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‭Interview Do’s and Don’ts‬

‭Do’s‬ ‭Don’ts‬

‭Be punctual‬ ‭Arrive late‬

‭Be polite and confident‬ ‭Argue or interrupt‬

‭Listen carefully‬ ‭Avoid looking distracted‬

‭Ask questions politely‬ ‭Don’t criticize past experiences‬

‭Activity‬‭:Mock interview & self-introduction session‬

‭Summary:‬

‭●‬ ‭Career readiness skills prepare students for jobs by improving resume writing,‬
‭interview performance, and professional confidence.‬

‭●‬ ‭A resume highlights a person’s education, skills, achievements, and goals, helping‬
‭employers understand suitability for a role.‬

‭●‬ ‭Effective interview preparation includes researching the company, understanding‬
‭the job role, practicing common questions, and maintaining proper body‬
‭language.‬

‭●‬ ‭Good communication, confidence, punctuality, and professional appearance are‬
‭essential during interviews.‬

‭●‬ ‭These skills help students transition smoothly from school to higher studies or‬
‭employment.‬
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‭Unit 15: Health & Wellness‬

‭What is health?‬

‭Health means the complete well-being of a person –‬‭physically, mentally,‬
‭and socially‬‭.‬
‭It is not only about being free from illness but also about living a balanced‬
‭and active life.‬
‭Good health allows us to work, study, and enjoy life happily.‬
‭It includes‬‭physical health‬‭(body fitness),‬‭mental‬‭health‬‭(positive‬
‭thinking), and‬‭social health‬‭(good relationships).‬
‭A healthy lifestyle with proper food, exercise, rest, and hygiene keeps us‬
‭healthy.‬

‭Types of Health:‬

‭1.‬ ‭Physical health.‬
‭2.‬ ‭Mental health.‬

‭Physical health‬

‭Physical‬ ‭health‬ ‭means‬ ‭the‬ ‭overall‬ ‭condition‬ ‭of‬ ‭your‬ ‭body‬ ‭—‬ ‭how‬ ‭well‬ ‭it‬
‭functions,‬ ‭how‬ ‭strong‬ ‭it‬ ‭is,‬ ‭and‬ ‭how‬ ‭well‬ ‭you‬ ‭can‬ ‭perform‬ ‭everyday‬
‭activities without getting tired or sick.‬
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‭Key Aspects of Physical Health:‬

‭1.‬ ‭Healthy Food‬
‭●‬ ‭Your body needs energy to grow and work properly.‬
‭●‬ ‭Eat‬ ‭a‬ ‭balanced‬ ‭diet‬ ‭that‬ ‭includes‬ ‭fruits,‬ ‭vegetables,‬ ‭milk,‬ ‭pulses,‬

‭cereals, etc.‬
‭●‬ ‭Avoid junk food and too much sugar or oily food.‬

‭2.‬ ‭Exercise and Physical Activity‬

‭●‬ ‭Regular movement helps muscles and bones stay strong.‬
‭●‬ ‭Activities‬ ‭like‬ ‭walking,‬ ‭yoga,‬ ‭running,‬ ‭cycling,‬ ‭and‬ ‭sports‬ ‭improve‬

‭blood flow and make your heart strong.‬

‭3.‬ ‭Hygiene and Cleanliness‬

‭●‬ ‭Keeping your body clean prevents infections and diseases.‬
‭●‬ ‭Brush‬ ‭your‬ ‭teeth‬ ‭twice‬ ‭a‬ ‭day,‬ ‭take‬ ‭a‬ ‭bath‬ ‭daily,‬ ‭wash‬ ‭your‬ ‭hands‬

‭before eating.‬

‭4.‬ ‭Rest and Sleep‬
‭●‬ ‭Sleep allows the body to repair itself and stay fresh.‬
‭●‬ ‭Students should get at least 7–9 hours of sleep every night.‬

‭5.‬ ‭Avoiding Harmful Habits‬
‭●‬ ‭Stay away from smoking, alcohol, and unhealthy eating habits.‬
‭●‬ ‭Limit screen time (TV/mobile) and avoid laziness.‬

‭Benefits of Good Physical Health:‬

‭●‬ ‭You stay strong and active all day‬
‭●‬ ‭Your body can fight diseases better (strong immunity)‬
‭●‬ ‭You can study, play, and focus more effectively‬
‭●‬ ‭You feel happy and confident‬
‭●‬ ‭It helps in growing properly — both height and strength‬
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‭What is Mental Health?‬

‭Mental‬ ‭health‬ ‭is‬ ‭the‬ ‭state‬ ‭of‬ ‭our‬‭mind‬‭and‬‭emotions‬‭.‬‭It‬‭includes‬‭how‬‭we‬
‭think‬‭,‬ ‭feel‬‭,‬ ‭and‬ ‭act‬‭.‬ ‭It‬ ‭also‬ ‭helps‬ ‭us‬ ‭cope‬ ‭with‬‭stress,‬‭relate‬‭to‬‭others,‬‭and‬
‭make healthy choices in life.‬

‭Key Points about Mental Health:‬

‭1.‬ ‭Good Mental Health Means:‬

‭●‬ ‭Feeling happy or content.‬
‭●‬ ‭Being able to handle daily stress.‬
‭●‬ ‭Having good relationships.‬
‭●‬ ‭Being productive in work or studies.‬

‭2.‬ ‭Poor Mental Health May Include:‬

‭●‬ ‭Feeling sad or low for a long time.‬
‭●‬ ‭Anxiety, fear, or worry.‬
‭●‬ ‭Trouble sleeping or eating.‬
‭●‬ ‭Difficulty in concentrating.‬

‭Common Mental Health Issues‬

‭●‬ ‭Depression:‬‭Persistent sadness and loss of interest‬‭.‬
‭●‬ ‭Anxiety:‬‭Constant worry or fear.‬
‭●‬ ‭Stress:‬‭Feeling overwhelmed due to pressure.‬
‭●‬ ‭Mood Swings‬
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‭Why is Mental Health Important?‬

‭●‬ ‭It improves quality of life.‬
‭●‬ ‭Helps in clear thinking and decision making.‬
‭●‬ ‭Build better relationships.‬
‭●‬ ‭Supports physical health.‬
‭●‬ ‭Increases confidence and focus.‬

‭Tips to Maintain Mental Health‬

‭1.‬ ‭Talk to someone –‬‭Share your feelings‬‭.‬
‭2.‬ ‭Exercise daily –‬‭Physical activity boosts mood.‬
‭3.‬ ‭Eat healthy –‬‭Good nutrition supports the brain‬‭.‬
‭4.‬ ‭Get enough sleep‬‭– Sleep repairs mind and body.‬
‭5.‬ ‭Practice mindfulness or meditation.‬
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‭What is‬‭Nutrition‬

‭Nutrition‬ ‭is‬ ‭the‬ ‭process‬ ‭of‬ ‭getting‬ ‭the‬ ‭right‬ ‭kind‬ ‭of‬ ‭food‬ ‭and‬ ‭nutrients‬
‭your‬ ‭body‬ ‭needs‬ ‭to‬ ‭grow,‬ ‭stay‬ ‭healthy,‬ ‭and‬ ‭work‬ ‭properly‬

‭Why is Nutrition Important?‬

‭●‬ ‭Gives energy to the body‬
‭●‬ ‭Helps in growth and development‬
‭●‬ ‭Keeps bones, muscles, and organs strong‬
‭●‬ ‭Increases immunity to fight diseases‬
‭●‬ ‭Keeps mind and body active‬

‭Essential Nutrients in Food:‬

‭Nutrient‬ ‭Use in Body‬ ‭Sources‬
‭Carbohydrates‬ ‭Gives energy‬ ‭Rice,‬ ‭chapati,‬

‭bread, potatoes‬
‭Proteins‬ ‭Builds muscles and body parts‬ ‭Milk,‬ ‭eggs,‬

‭pulses, meat‬
‭Fats‬ ‭Gives‬ ‭energy‬ ‭and‬ ‭helps‬ ‭store‬

‭vitamins‬
‭Ghee, oil, nuts‬

‭Vitamins‬ ‭Protect‬ ‭from‬ ‭diseases‬ ‭and‬‭keep‬
‭body healthy‬

‭Fruits,‬
‭vegetables‬

‭Minerals‬ ‭Help‬ ‭in‬ ‭bone,‬ ‭blood,‬ ‭and‬ ‭body‬
‭functions‬

‭Salt,‬ ‭milk,‬
‭spinach‬

‭Water‬ ‭Keeps body hydrated and cool‬ ‭Clean‬ ‭drinking‬
‭water, fruits‬

‭Fibre‬ ‭Helps in digestion‬ ‭Whole‬ ‭grains,‬
‭fruits, vegetables‬
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‭What is a Balanced Diet?‬

‭A‬ ‭balanced‬ ‭diet‬ ‭includes‬ ‭food‬ ‭from‬ ‭all‬ ‭major‬ ‭nutrient‬ ‭groups‬ ‭in‬ ‭the‬‭right‬
‭amount — not too much, not too little.‬

‭Poor Nutrition Can Cause:‬

‭●‬ ‭Weakness or tiredness‬
‭●‬ ‭Poor growth in children‬
‭●‬ ‭Frequent illness‬
‭●‬ ‭Obesity or being underweight‬
‭●‬ ‭Poor concentration in studies‬

‭Healthy Nutrition Habits:‬

‭●‬ ‭Eat fresh fruits and vegetables daily‬
‭●‬ ‭Drink plenty of water‬
‭●‬ ‭Avoid junk food, soft drinks, and too much sugar‬
‭●‬ ‭Have regular meals at the right time‬
‭●‬ ‭Include milk, grains, and protein-rich food in diet‬
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‭What is Yoga?‬

‭Yoga‬ ‭is‬ ‭a‬ ‭physical,‬ ‭mental,‬ ‭and‬‭spiritual‬‭practice‬‭that‬‭helps‬‭keep‬‭the‬‭body‬
‭strong and the mind calm.‬

‭Benefits of Yoga:‬

‭Benefit‬ ‭Explanation‬
‭Improves flexibility‬ ‭Makes the body more flexible and active‬
‭Builds strength‬ ‭Strengthens muscles and joints‬
‭Reduces stress‬ ‭Makes the mind calm and peaceful‬
‭Improves breathing‬ ‭Helps in better control of breath (Pranayama)‬
‭Boosts concentration‬ ‭Helps in focusing better on studies or work‬
‭Keeps you healthy‬ ‭Helps prevent many diseases and improves digestion‬

‭Shiv Nadar Institution of Eminence‬
‭Deemed to be University‬ ‭144‬‭। page‬



‭Examples of Simple Yoga Asanas (Poses):‬

‭Asana Name‬ ‭Use‬
‭Tadasana (Mountain)‬ ‭Improves posture and balance‬
‭Vrikshasana (Tree)‬ ‭Builds concentration and balance‬
‭Bhujangasana (Cobra)‬ ‭Strengthens back and improves posture‬
‭Vajrasana‬ ‭Good for digestion‬

‭What is Meditation?‬

‭Meditation‬‭is‬‭a‬‭way‬‭to‬‭relax‬‭your‬‭mind‬‭and‬‭focus‬‭on‬‭your‬‭breath,‬‭thoughts,‬
‭or a mantra.‬

‭Benefits of Meditation:‬

‭●‬ ‭Reduces anxiety and stress‬
‭●‬ ‭Improves focus and memory‬
‭●‬ ‭Increases self-awareness‬
‭●‬ ‭Helps with better sleep‬
‭●‬ ‭Makes the mind calm and peaceful‬

‭How to Practice Meditation‬
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‭1.‬ ‭Sit comfortably in a quiet place‬
‭2.‬ ‭Close your eyes‬
‭3.‬ ‭Breathe slowly and deeply‬
‭4.‬ ‭Focus on your breath or a calming word‬
‭5.‬ ‭Do it for 5–10 minutes daily‬

‭Activity:‬‭Create a daily Routine Chart‬

‭Summary:‬
‭●‬ ‭Health‬ ‭means‬ ‭complete‬ ‭physical,‬ ‭mental,‬ ‭and‬ ‭social‬ ‭well-being,‬ ‭not‬ ‭just‬ ‭the‬

‭absence of illness.‬
‭●‬ ‭Physical‬ ‭health‬ ‭improves‬ ‭through‬ ‭balanced‬ ‭nutrition,‬ ‭exercise,‬ ‭hygiene,‬ ‭proper‬

‭sleep, and avoiding harmful habits.‬
‭●‬ ‭Mental‬ ‭health‬ ‭focuses‬ ‭on‬ ‭emotions,‬ ‭thoughts,‬ ‭stress‬ ‭management,‬ ‭and‬‭healthy‬

‭relationships; good habits like talking, exercising, and sleeping well support it.‬
‭●‬ ‭Good‬ ‭nutrition‬ ‭provides‬ ‭essential‬ ‭nutrients‬ ‭that‬ ‭help‬‭the‬‭body‬‭grow,‬‭stay‬‭strong,‬

‭and fight diseases; a balanced diet is important for overall health.‬
‭●‬ ‭Yoga‬ ‭and‬ ‭meditation‬ ‭improve‬ ‭flexibility,‬ ‭strength,‬ ‭focus,‬ ‭calmness,‬ ‭and‬ ‭overall‬

‭wellness.‬
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‭Social Citizenship Skills‬

‭Unit 16: Civic Engagement & Social Responsibility‬

‭Volunteering‬
‭Volunteering‬ ‭means‬ ‭giving‬ ‭your‬ ‭time,‬ ‭energy,‬ ‭or‬ ‭skills‬ ‭to‬ ‭help‬ ‭others‬ ‭or‬
‭support a good cause without expecting payment.‬

‭Uses:‬

‭●‬ ‭Helps in personal growth and skill development.‬
‭●‬ ‭Builds a strong social network.‬
‭●‬ ‭Encourages teamwork and leadership.‬

‭Advantages:‬

‭●‬ ‭Improves confidence and communication skills.‬
‭●‬ ‭Enhances empathy and social awareness.‬
‭●‬ ‭Gives real-life experience and satisfaction of helping others.‬
‭●‬ ‭Makes a positive impact on the community.‬

‭Examples of Volunteer Opportunities:‬

‭●‬ ‭Teaching underprivileged children.‬
‭●‬ ‭Tree plantation or cleanliness drives.‬
‭●‬ ‭Helping in blood donation or health camps.‬
‭●‬ ‭Supporting NGOs and community programs.‬

‭147‬‭। page‬ ‭Shiv Nadar Institution of Eminence‬
‭Deemed to be University‬



‭Community Engagement‬

‭Community‬ ‭engagement‬ ‭means‬ ‭taking‬ ‭part‬ ‭in‬ ‭collective‬ ‭efforts‬ ‭to‬
‭improve your surroundings and help others in your area.‬

‭Uses:‬

‭●‬ ‭Builds a sense of belonging and cooperation.‬
‭●‬ ‭Encourages students to take social responsibility.‬
‭●‬ ‭Promotes collective problem-solving.‬

‭Advantages:‬

‭●‬ ‭Improves communication and teamwork skills.‬
‭●‬ ‭Build leadership qualities.‬
‭●‬ ‭Strengthens relationships between community members.‬
‭●‬ ‭Promotes unity and understanding among people.‬

‭Examples:‬

‭●‬ ‭Awareness campaigns (health, education, environment).‬
‭●‬ ‭Local cleanliness or development projects.‬
‭●‬ ‭Participating in disaster relief work.‬
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‭Conflict Management‬
‭Conflict‬‭management‬‭is‬‭the‬‭process‬‭of‬‭resolving‬‭disagreements‬‭peacefully‬
‭and respectfully.‬

‭Uses:‬

‭●‬ ‭Helps in maintaining harmony in personal and professional life.‬
‭●‬ ‭Builds negotiation and emotional control skills.‬
‭●‬ ‭Improves relationships and teamwork.‬

‭Advantages:‬

‭●‬ ‭Reduces stress and misunderstandings.‬
‭●‬ ‭Encourages cooperation and problem-solving.‬
‭●‬ ‭Promotes positive communication and empathy.‬

‭Methods of Conflict Resolution:‬

‭1.‬ ‭Stay calm and listen actively.‬
‭2.‬ ‭Respect others’ opinions.‬
‭3.‬ ‭Find a solution that benefits everyone.‬
‭4.‬ ‭Seek mediation if needed.‬
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‭Responsible Citizenship‬

‭Every‬‭person‬‭who‬‭lives‬‭in‬‭a‬‭country‬‭is‬‭its‬‭citizen.‬‭Citizenship‬‭gives‬‭us‬‭certain‬
‭rights‬ ‭such‬ ‭as‬ ‭the‬ ‭right‬ ‭to‬ ‭freedom,‬ ‭education,‬ ‭and‬ ‭equality‬ ‭—‬ ‭but‬‭it‬‭also‬
‭brings duties and responsibilities.‬
‭Being‬ ‭a‬ ‭responsible‬ ‭citizen‬‭means‬‭using‬‭our‬‭rights‬‭wisely‬‭and‬‭performing‬
‭our duties sincerely for the welfare of society and the nation.‬

‭A‬‭responsible‬‭citizen‬‭is‬‭not‬‭only‬‭concerned‬‭about‬‭personal‬‭benefit‬‭but‬‭also‬
‭works‬ ‭for‬ ‭the‬ ‭betterment‬ ‭of‬ ‭others.‬ ‭Such‬‭citizens‬‭make‬‭a‬‭nation‬‭peaceful,‬
‭strong, and progressive.‬

‭Responsible‬ ‭Citizenship‬ ‭means‬ ‭behaving‬ ‭in‬ ‭a‬ ‭manner‬ ‭that‬ ‭shows‬ ‭care,‬
‭respect, and concern for other people and for the community.‬
‭It‬‭involves‬‭following‬‭laws,‬‭respecting‬‭diversity,‬‭being‬‭honest,‬‭and‬‭helping‬‭to‬
‭maintain peace and harmony.‬

‭In‬ ‭simple‬ ‭terms,‬ ‭a‬ ‭responsible‬ ‭citizen‬ ‭is‬ ‭a‬ ‭person‬ ‭who‬ ‭contributes‬
‭positively‬ ‭to‬ ‭society‬ ‭by‬ ‭performing‬ ‭their‬ ‭duties‬ ‭and‬ ‭respecting‬ ‭the‬
‭rights of others.‬

‭Qualities of a Responsible Citizen‬

‭1.‬ ‭Obeys Laws:‬
‭A responsible citizen follows the rules and laws of the country and‬
‭helps maintain order.‬

‭2.‬ ‭Honest and Truthful:‬
‭They speak the truth, avoid corruption, and act ethically in daily life.‬

‭3.‬ ‭Respectful:‬
‭They respect other people’s opinions, religions, and backgrounds.‬

‭4.‬ ‭Environmentally Aware:‬
‭They protect natural resources, avoid pollution, and support‬
‭sustainability.‬

‭5.‬ ‭Helpful and Kind:‬
‭They help those in need and participate in community welfare.‬

‭6.‬ ‭National Pride:‬
‭They show respect for the national flag, anthem, and culture.‬

‭7.‬ ‭Active Participation:‬
‭They vote in elections, follow current issues, and work for social‬
‭change.‬
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‭Rights and Responsibilities of Citizens‬

‭Every‬ ‭citizen‬ ‭has‬ ‭certain‬ ‭rights‬ ‭that‬ ‭provide‬ ‭freedom‬ ‭and‬ ‭protection,‬ ‭but‬
‭these come with matching responsibilities.‬

‭Rights of Citizens‬ ‭Responsibilities of Citizens‬

‭Right to Freedom‬ ‭Use‬ ‭freedom‬ ‭without‬ ‭harming‬ ‭others‬ ‭or‬
‭breaking the law.‬

‭Right to Education‬ ‭Study‬‭sincerely‬‭and‬‭use‬‭knowledge‬‭to‬‭help‬
‭society.‬

‭Right to Equality‬ ‭Treat‬ ‭all‬ ‭people‬ ‭equally‬ ‭without‬
‭discrimination.‬

‭Right to Vote‬ ‭Vote‬ ‭wisely‬ ‭and‬ ‭participate‬ ‭in‬ ‭democratic‬
‭activities.‬

‭Right‬ ‭to‬ ‭Live‬ ‭in‬ ‭a‬ ‭Clean‬
‭Environment‬

‭Keep‬ ‭surroundings‬ ‭clean‬ ‭and‬ ‭protect‬ ‭the‬
‭environment.‬

‭Role of Responsible Citizens in Nation-Building‬

‭●‬ ‭Maintain Peace and Unity:‬‭Encourage harmony among‬‭people of‬
‭different cultures and religions.‬

‭●‬ ‭Follow the Law:‬‭Respect traffic rules, pay taxes,‬‭and avoid‬
‭corruption.‬

‭●‬ ‭Help Others:‬‭Volunteer for social work or community‬‭development.‬
‭●‬ ‭Protect Nature:‬‭Save water, plant trees, and avoid‬‭wastage.‬
‭●‬ ‭Promote Equality:‬‭Stand against discrimination and‬‭injustice.‬
‭●‬ ‭Be Informed:‬‭Stay updated about national issues and‬‭government‬

‭policies.‬

‭Importance of Responsible Citizenship‬

‭Responsible citizenship is the foundation of a strong and developed nation.‬
‭When‬ ‭people‬ ‭act‬ ‭responsibly,‬ ‭society‬ ‭becomes‬ ‭fair,‬ ‭peaceful,‬ ‭and‬
‭progressive.‬‭It‬‭creates‬‭trust‬‭between‬‭citizens‬‭and‬‭government‬‭and‬‭ensures‬
‭that everyone lives with dignity.‬

‭Such‬‭citizens‬‭make‬‭a‬‭country‬‭democratic‬‭not‬‭just‬‭by‬‭law,‬‭but‬‭also‬‭by‬‭action‬
‭and behavior.‬
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‭Activity:‬‭Share‬‭Their‬‭Ideas‬‭on‬‭How‬‭Young‬‭People‬‭can‬‭make‬‭a‬‭Difference‬‭in‬
‭Society‬

‭Summary:‬

‭●‬ ‭Volunteering‬ ‭and‬ ‭community‬ ‭engagement‬ ‭help‬ ‭students‬ ‭develop‬ ‭empathy,‬
‭teamwork, leadership, and a sense of responsibility toward society.‬

‭●‬ ‭Conflict‬ ‭management‬ ‭teaches‬ ‭calm‬ ‭communication,‬ ‭respectful‬ ‭listening,‬ ‭and‬
‭peaceful problem-solving to maintain harmony.‬

‭●‬ ‭Responsible‬ ‭citizenship‬ ‭means‬ ‭following‬ ‭laws,‬ ‭respecting‬ ‭others,‬ ‭protecting‬ ‭the‬
‭environment, and contributing positively to society.‬

‭●‬ ‭Citizens‬ ‭have‬ ‭rights‬ ‭like‬ ‭freedom,‬ ‭education,‬ ‭and‬ ‭equality,‬ ‭but‬ ‭also‬ ‭matching‬
‭duties‬ ‭such‬ ‭as‬ ‭voting‬ ‭wisely,‬ ‭keeping‬ ‭surroundings‬ ‭clean,‬‭and‬‭treating‬‭everyone‬
‭fairly.‬

‭●‬ ‭When‬ ‭people‬ ‭act‬ ‭responsibly,‬‭they‬‭help‬‭build‬‭a‬‭peaceful,‬‭united,‬‭and‬‭progressive‬
‭nation.‬
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